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Welcome to BMC Track-It! 11 Technician Client 
  
Notes:   
  

• For help with online help and printed documentation, see Online Help and Guides (PDFs). 
• The topics in the online help are also available in the printed versions (PDF) on the Product 

Documentation section of our Support Web page  
 

BMC Track-It! Technician Client is a fully-integrated help desk and asset management solution 
designed for small to medium-sized businesses.  BMC Track-It! enables specialized technicians to apply 
best practices and proactive management techniques for delivering advanced Help Desk and Asset 
Management services to the organization. BMC Track-It! delivers the automation and integrated tools 
necessary to cost-effectively manage IT assets and deliver superior end-user support. 
  
  

 
For more information, please see the BMC Track-It! Overview (PDF). 
  
  

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&lang=EN
http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&lang=EN
http://www.numarasoftware.com/track-it/help_desk_software.aspx
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BMC Track-It! 11 Technician's Guide 

Getting Help, Support, and Training 

User Assistance (Online Help and Guides) 
Note:  The topics in the online help are also available in the following printed versions (PDF) on the 
Product Documentation section of our Support Web page at 
http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11
&Offering=2&lang=EN 
  
Product Documentation (PDFs) 
  

• BMC Track-It! Administrator's Guide 
• BMC Track-It! Technician's Guide 
• BMC Track-It! Self Service Guide (for end users) 
• BMC Track-It! Web Technician's Guide 
• BMC Track-It! Mobile Web Technician's Guide 
• System Requirements 
• FAQs 
• BMC Track-It! Installation Guide 
• BMC Track-It! Bar Code Installation Guide 
• BMC Remote Control 9.5 User's Guide 
• Evaluation Guide 

  
Note:  If you are in a location where an internet connection is unavailable, you can install the BMC Track-
It! help files (FlashHelp) on a local IIS server.  See Installing Offline Help. 
  
Track-It's online help system uses WebHelp, a Web-based help format.  When you access a help topic in 
the BMC Track-It! application, either from the Help menu or from Help buttons, the help topics are 
delivered from the BMC Track-It! Web server to your Web browser (such as Internet Explorer).  BMC 
Track-It! Mobile Web uses a mobile WebHelp, specially formatted for mobile screens. 
To Use the BMC Track-It! Online Help: 

1. Press the F1 key, or select BMC Track-It! Help from the Help menu on Track-It's main menu 
bar. 
The Help dialog displays. 

2. Enter your search terms in the Search for:  text box, then click the Search button. 
 
Track-It's search engine searches not only the online help topics, but the KnowledgeBase on the 
BMC Track-It! Support Web page. 

  
Help topics are comprised of: 
  

• Overviews 
• Workflows 
• Getting up and running checklists 
• Procedural steps 

  
KnowledgeBase articles consist of: 
  

• Troubleshooting 
• Technical information 
• Specific how-to information based on customer requests 
• Online tutorials (videos) 

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&lang=EN
http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&lang=EN
http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&lang=EN
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The matching Help topics (indicated by a round, blue icon) and KnowledgeBase articles 
(displayed by a square white icon) display on the Search Results pane. 
  

3. Select a Help topic or KnowledgeBase article from the list. 
  

• To view the entire online help (FlashHelp), drag the Help dialog to the left or right until 
you can see the FlashHelp dialog (indicated by a blue toolbar). 

• KnowledgeBase articles from our Support page at 
www.numarasoftware.com/support.asp. 

  
  
  

Customer Support and Resources 
  
For information on BMC Software Maintenance and Support, please see our Web page at 
www.numarasoftware.com/support.asp. 
  
For customers who have purchased a maintenance and support plan, you can log in to your account at 
www.numarasoftware.com/support/MySupport.asp.  From there you can: 
  

• Submit a request (eSubmission) 
• Submit an incident against a known problem 
• Request an enhancement to the product 
• View enhancements previously submitted 
• View the status of your submitted incident numbers 
• Sign up for Webinars (live online training) to get up and running with BMC Track-It! 
• View your recent KnowledgeBase searches and recently-viewed articles 
• View new product documentation    
• Exchange files with the technical support department 

  
  
  

Accessing the BMC Software Support Web Page 
In order to access the KnowledgeBase articles, user guide PDFs, and other documents on our Support 
Web page, a Support profile is required.  Our Support Web site can only be accessed by customers who 
have created a support profile.  You will need at least one product serial number for a BMC Software 
product you own.  If you do not know your product serial number, you can find it in Help > About in BMC 
Track-It!. 
To set up your Support profile: 
1. Go to http://support.numarasoftware.com/support/login.asp. 
2. Enter your user name and password, or click the "Create a Support Profile" link to create a new 
profile. 
3. After logging in, select the Profile tab. 
4. Verify that the "Yes, remember my account information" option is enabled. 

Installing the BMC Track-It! Technician Client 
  
Your BMC Track-It! Administrator can send an e-mail to you and other BMC Track-It! technicians with a 
hyperlink  to install BMC Track-It! on your computers.   
To Install the BMC Track-It! Technician Client: 

http://www.numarasoftware.com/support.asp
http://www.numarasoftware.com/support.asp
http://www.numarasoftware.com/support.asp
http://www.numarasoftware.com/support/MySupport.asp
http://support.numarasoftware.com/support
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1. Click the link on the e-mail sent from your BMC Track-It! Administrator. 
(The link may look similar to this:  Click Once:   \Track-
It!ServerName\TechnicianClient\ClickOnce\publish.htm). 

2. Click the Install button when the Web page displays "BMC Software, Inc. Track-It! x". 
3. If you receive an internet security warning message to run or save the setup.exe file, click the 

Run button. 
4. If you receive a Web browser (e.g. Internet explorer) security warning that "the publisher could 

not be verified", click the Run button. 
5. If you receive an additional security warning that the publisher cannot be verified, click the Install 

button. 
 
The Launching Application dialog displays, then the Installing BMC Track-It! x Technician 
Client dialog displays with a status bar.  You can continue using your computer for other tasks 
during the installation. 
 
In a few minutes, BMC Track-It! is installed and displays the login screen. 
  

6. Enter your User name and Password, then click the Login button. 
  
  
  
  
  
  
  
  
  
  
  

Exploring and Customizing the BMC Track-It! Workspace 

Keyboard Shortcuts 
You can use keyboard shortcuts for commands (such as File, Edit, View, Window, and Print) so that you 
can move through the application without using your mouse. 
To Use Keyboard Shortcuts: 

1. To use a shortcut key, press and hold the ALT key while pressing the shortcut key (such as 
ALT+E for Edit). 

2. To view which keys have assigned shortcuts (access keys), press the ALT key while in any 
window.   The commands will display with underlined shortcut keys. 

  
See also: Using Keyboard Shortcuts for Work Orders,  Adding Descriptions and Technician Notes to 
Work Orders, and Documenting Work Order Resolutions. 
  
  

Searching for Information in BMC Track-It! 
  
The BMC Track-It! search engine supports full-text search capabilities.  You can search from the main 
toolbar of each module's window for text in database fields related to the following categories: 
  

• Assets 
• Departments 
• Library Items 
• Locations 
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• Purchases 
• Software Titles 
• Solutions 
• Technicians 
• Users 
• Work Orders 

  
Note:  The Search Requestor dialog accessed from the Requestor field on a Work Order automatically 
uses a wild card search to display all records.  See Searching for the Requestor's Name and Viewing 
User Information for a Work Order. 
  
To Search for Information in BMC Track-It! 

1. Enter any part of the search term in the Search field on Track-It's main toolbar, then click the 
Search (Department, Asset, etc.) button.    
 
(The Search button displays the category of the last search, such as Search Asset or Search 
User.  To select another search criteria, select an option from the Search button's drop-down list. 
  
 
The Search dialog opens and displays the search results.   To customize the grid view, see 
Showing and Hiding Columns in Creating User-defined Views. 

Boolean Searches 
You can use the following Boolean search criteria: 
  

Boolean Search 
Example 

Search Results 

password and reset Help topic or support article includes both 
words 

password or reset 
  

Help topic or support article includes 
either word 
  

password w/5 reset First word occurs within 5 words of 
second word in Help topic or support 
article 

password not w/5 
reset 
  

First word occurs, but not within 5 words 
of second word in Help topic or support 
article 

password and not 
reset 

First word, but not second word, occurs 
in Help topic or support article 

(password or reset) 
and open 

First word or second word and third word 
occur in Help topic or support article 

* or ? Returns all records 
  
  

Working with Multiple Modules at a Time 
  
You can work with multiple modules at a time in BMC Track-It!, such as the Help Desk and Inventory 
modules. 
  
Note:  You can open multiple windows (Help Desk, Inventory, Training), but you won't be able to open 
additional windows if a dialog is open in one of them.  This includes the Administration Console and the 
Configuration Wizard.   
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To Open Multiple Windows: 
1. Select New Window from the Window menu on the main menu bar. 
2. Select the module you would like to view. 
3. To toggle between windows, press the ALT Tab keys, or select the BMC Track-It! window from 

the Windows task bar at the bottom of the screen. 
4. To view multiple windows at a time, right click the BMC Track-It! window from the Windows task 

bar, then right click and select Tile Horizontally or Tile Vertically. 
5. To close individual windows, select  the BMC Track-It! window from the Windows task bar, then 

right click and select Close. 
 
  

Viewing and Printing Information in Grids 
Viewing Information in Grids 
Note:  You can create up to 30 custom views. 
  
BMC Track-It! displays records such as assets in the Inventory module and work orders in the Help Desk 
module in grids.  The grids consist of tables with columns and rows.  Each row represents a record and 
each column represents a field.  For example, when you view the Inventory grid, the default view displays 
a list of All Assets by Asset Type, with columns that include Asset ID, Asset Name, Asset Department, 
etc. 
  
You can manage the way information is displayed in grids by using system views, user-defined views, 
sorting, grouping, filtering, and customizing records in grids. 
  
Note:  BMC Track-It! will automatically refresh the grid to display current records.  However, you can 
manually refresh the grid.  Right click the grid and select Refresh, or press the F5 key. 

System Views 

BMC Track-It! provides several system views -- for example:  All Assets, All Computers, All Audited 
Assets, and All Network Assets.  System views cannot be modified or deleted, but you can use them to 
create and save custom views. 
To View Records Using System Views: 

1. Select System Views from the Current View menu at the top of the grid (or from the View menu 
in the Main Menu Bar), then select a System View (such as All Assets in the Inventory grid). 
The name of the Current View displays after you have selected the view, and the records display 
in the grid.    

Previewing Records in a Grid 

You can customize the grid view so that you can preview a record while viewing the remaining list of 
records in the grid. 
To Preview Records in a Grid: 

1. Right click any column header and select Preview. 
2. Select whether to view the preview pane on the bottom, top, left, or right of the grid.  Select None 

to hide the preview pane. 
To View Columns: 

1. Drag the horizontal scroll bar to view all the columns.  To show or hide columns, see Creating 
Custom Views. 

2. To adjust the width of a column, drag the edge of the column heading to the left or right.  To 
adjust the column width to fit the contents, select the column and double-click the right edge of 
the selected column heading. 

To Search for Records in a Grid: 
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1. Enter the search term in the Search field (main toolbar), then click the Search button.   
The Search button displays the name of the last search, such as Search Asset, or Search User. 
 To select another Search criteria, select an option from the Search button's drop-down list.  The 
Search dialog opens and displays the search results.  

To View Record Details: 
1. Select the record in the Results grid, then click the Open button. 

  
Next Topic:  Sorting, Filtering, and Grouping Records 
Sorting, Filtering, and Grouping Records 

Sorting Records 

You can sort records alphabetically in grids (such as by Asset Type in the Inventory module or by Work 
Order Number in the Help Desk module). 
To Sort Records 

1. Click the column header (the name at the top of the column) to sort by ascending or descending 
order. 

2. To return to the default sort order, right click the column header and select Clear Sorting. 

Filtering Records 

After you've selected a grid view from the Views menu, you can filter records based on your criteria so 
that you can select only the rows you'd like to display.  For example, in the Inventory grid, you might only 
want to view assets by Asset Type or User Name.   
  
When filtering records in a grid, the Auto Filter lists display the number of records equal to the maximum 
records allowed in the associated grid view.   
  
With the Auto Filter, rows can be filtered and displayed that meet conditions per column, by filter order. 
 For example: If you filter first on Location:  ”Tampa”, then on Department "Engineering”, then on Users, 
you will only see Users who have a Location ”Tampa” and Department ”Engineering”. 
  
Once you've filtered a view, you can save it as a user-defined View (see Creating Custom Views). 
To Filter Records: 

1. Enter the search term in the Auto Filter Row (blank row beneath the column header) and press 
Enter. 
The default search comparison type is "LIKE", so if you enter "phone" in the Summary column in 
the Help Desk grid, all records with the Summary containing the term "phone" will display. 
You can filter multiple columns. The filtered rows display. 
OR 
Select the drop-down arrow on the column header, then select a field from the list (such as a 
User Name in the User Name column).  The filtered rows display.  You can also select: 
 All 
 Custom:  see Custom Filters, below 
 Blanks 
 Non blanks 

To Remove a Filter: 
1. Select Abandon Changes to Current View from the View drop-down list. 

This returns the grid to the default system view, or to the last saved custom view. 
To Filter Records with the Custom Filter: 

1. Select Custom from the column header drop-down list. 
The Filter dialog displays with the column name (field name), such as User Name, beneath 
"Show records where". 

2. Select a comparison type from the top left drop-down list (such as "equals" or "like" -- see the 
table below for a complete list). 
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3. Enter or select a comparison value from the value (top middle) drop-down list (such as the user's 
first name). 

4. If you want to set additional conditions, repeat steps 2 and 3, then click the and/or button, and 
select "and" or "or" from the drop-down list. 
You can continue step 4 to filter on multiple conditions. 

5. Click the Accept button to save the custom filter. 
The grid displays only the records that meet the condition(s) of your filter. 

  
Custom Filter Operators 

Comparison Type Description Example 
equals Field value equals filter criteria [Summary] = 'printer keeps 

jamming' 
does not equal Field value does not equal filter 

criteria 
[Location] < > 'Tampa' 

is greater than Field value is greater than filter 
criteria 

[Hours] > '3' 

is greater than or equal 
to 
  

Field value is greater than or equal 
to filter criteria 

[Charge] >= '10' 

is less than Field value is less than filter 
criteria 

[Due Date] < Today 

is less than or equal to Field value less than or equal to 
filter criteria 

[Hours] <= '5' 

blanks Field value is blank [Expected Completion Date] Is 
Null 

non blanks Field value is not blank [Priority] Is Not Null 
like (see below for 
more options) 

Field value is like [Summary] Like 'employee%' 
  

not like Field value is not like Not [Requestor] Like 'Mike" 
  
Note:  You can also narrow the filter using wildcards with the "like" comparison type.  For example: 
  

Comparison Type:  Like 
Wildcard Character Description Example 
_ (underscore) Any single character ending 

with... 
[Computer Name] Like '_05' 

[ ] Any single character within the 
specified range 

[Priority] Like '{1-2]' 

  
To Clear the Custom Filter:   

1. From the grid, click the Close button (X) at the bottom of the grid next to the filter criteria. 
OR 

2. Right click the column header for the specific column, and select Clear Filter.  
OR  

3. From the Filter dialog, click the Delete button(s) for the filter row. 

Grouping Records 

You can group records in a grid by column. 
To Group Records: 
In this example, we'll open the All Printers system view in the Inventory module and group the printers by 
Location. 
  

1. Drag the column header (in this example -- Printer Location) into the blank area above the 
column headers. 
The records display grouped by the field name. 
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2. Click the + button next to the field name (such as Printer Name) to expand the list.  Click the -- 
 button to collapse the list. 

3. To group by more columns, repeat step 1 (for example, you could add the field "Color" to find 
color printers). 

4. To remove the groups, drag the column name back to the grid, or right click the column header 
and select Clear Grouping. 
  

Printing Grid Contents 
You can print the contents of a grid.  The printed data will display the current grid view (as grouped, 
sorted, filtered, etc.).    
To Print Grid Contents: 

1. Right click the grid and select Print Grid Contents. 
2. Click the Print Direct icon, which will print the grid directly to your printer, OR 
3. Click the Print icon on the Preview dialog toolbar. 
4. Select options from the Windows Print dialog, then click the Print button.   

  
To Customize the Printed Grid: 

1. Click the various icons on the Preview dialog toolbar, such as Background and Watermark, and 
select settings, OR 

2. Click the Customize icon on the  Preview dialog toolbar. 
3. On the Printable Component Editor, select your settings, then click the OK button. 

  
See Also:  Exporting Grid Contents 
  
  
  
  
  
  
Exporting Grid Contents 
You can export data from a grid to three file formats:  text (.txt), Microsoft™ Excel (.xls), and Web (.html) 
so that you can share the information, use it in reports, etc.  The exported data will display in the current 
grid view (as grouped, sorted, filtered, etc.).    
To Export Grid Contents: 

1. Right click the grid and select Export Grid Contents, OR 
With the grid displayed, Export Grid Contents from the Current View menu at the top of the 
grid. 

2. In the Export Grid Contents...dialog, navigate to the drive or folder where you want to create the 
file. 

3. Enter a name for the file in the File Name text box. 
4. Select the file format from the Save as Type drop-down list, then click the Save button. 

The exported grid in Excel or Web format will display as a table with a shaded header row. 
  
  
  
  

Customizing and Managing Grid Views 
Managing Grid Views (Renaming, Deleting, and Copying) 
  
From the Manage Views dialog, you can view and manage grid views (System, Public, and User-defined 
Views). 
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You can rename, delete, copy, publish User-defined Views as Public Views, and export and import views 
from other Technicians. 
  
Notes:   

 Your BMC Track-It! Administrator grants permissions to Technicians to add, edit, and delete 
Public grid views.  See Restricting Privileges by Module in the Administrator's Guide. 

 You can create up to 30 user-defined views. 
Viewing the List of Grid Views: 

1. At the topic of a grid (such as in the Help Desk or Inventory modules), select Manage Views from 
the Current View menu. 
 
The Manage Views dialog displays the view names and types.  System Views are indicated by a 
globe/lock icon (since they cannot be modified), and Public Views are indicated by a globe icon. 
 You can sort the views by clicking the column headers. 

Renaming Views 

Note:  You cannot rename a system view. 
To Rename a User-defined View: 

1. In the Manage Views dialog, select the user-defined view you want to rename, and click the 
Rename button. 

2. Enter the new name for the view in the View Name textbox (in the Save Current View 
As...dialog), then click the Save button. 

3. Click the Close button to return to the grid. 

Deleting Views 

Note:  You cannot delete a system view.  
To Delete a View: 

1. In the Manage Views dialog, select the view you want to delete, and click the Delete button. 
2. Click Yes when the confirmation dialog displays. 

Copying Views 

You can copy system views and user-defined views as a basis for a new user-defined view. 
To Copy a View: 

1. In the Manage Views dialog, select the view you want to copy, and click the Copy button. 
2. Click Yes when the confirmation dialog displays. 

  
See also: 
  
Creating User-defined Grid Views 
Creating Public Grid Views 
Exporting and Importing Views 
Creating User-defined Grid Views 
You can create user-defined views of information in grids with the Customize Grid feature.  Once you 
customize the grid, you can save it as a User-defined (Private View) and a Public View. 
  
Note:  You can create up to 30 user-defined views. 
  
To Create a User-defined View: 
  
The following shows how to create a user-defined view from a System View.  Once you create a user-
defined view, you can create additional user-defined views from it, as well as from System Views.  In this 
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example, we will create a user-defined view of All Computers grouped by Department.  Then we'll save 
the custom view so that we can access it later. 

Showing and Hiding Columns 

1. Select System Views from the Current View menu at the top of the grid, then select a System 
View (such as All Computers). 
The name of the Current View (All Computers) displays after you have selected the view, and the 
records display in the grid.    

2. Sort, filter, and/or group the information in the grid.  In this example, since we used the All 
Computers System View, the grid view is grouped by Asset Type and Asset Department.  (See 
also Sorting, Filtering, and Grouping Records). 

3. To customize which columns to display, right click anywhere on the grid, then select Customize. 
4. In the Customize Grid dialog (Columns pane), select the columns you want to display from the 

left pane, then click the Add button. 
You can select several columns at once.  Press and hold the Ctrl key while you select the 
columns.  To select columns in a continuous list, press and hold the Shift key while selecting 
them.   

5. Select any columns you want to remove, and click the Remove button. 
This only removes the columns from the view -- it does not delete them from the database. 

6. To arrange the columns, select the column from the right pane, then click the Move Up or Move 
Down buttons. 
You can also move columns by selecting the column header in the grid, and dragging them from 
left to right. 

Saving Custom Views 

1. Once you've created your custom view, select Save Current View As from the Current View 
menu. 

2. Enter the custom view name in the View Name text box on the Save Current View As...dialog. 
3. Select Private- View is available only to me from the View Type drop-down list. 
4. Click the Save button. 

The user-defined view name displays on the Current View menu.   
To view or make changes to grid views, see  Managing Grid Views (Renaming, Deleting, and 
Copying) 

  

Highlighting Records with Conditional Formatting 

You can set up conditional formatting so that column values are highlighted when they meet your criteria. 
 In this example, we'll highlight all work orders with a Priority of "Critical". 
  
To Create a Format Rule: 
  

1. Right click anywhere on the grid (such as the Work Order grid in the Help Desk module),  then 
select Customize. 

2. From the Customize Grid dialog, select the Format tab. 
3. Click the Add button to set up a conditional formatting Rule. 
4. On the Format Rule dialog, enter a name for the Rule in the Rule Name field (required). 

In this example, we'll enter "Critical Work Orders". 
5. Select a field from the Column drop-down list (required). 

We'll select "Priority". 
6. Select a comparison type from the drop-down list beneath Criteria (such as "Equal, or 

GreaterOrEqual). 
We'll select "Equal". 
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Note:  You can also use the comparison "Between" or "Not Between", such as in "Between Last 
Week and Today" (with Date Entered or other fields). 
  

7. Enter or select a comparison value from the value (top middle) drop down list (such as "Critical" 
for the "Priority" field). 

8. Beneath Cell Display, select a color for the highlighted value from the Text Color drop-down list. 
You can select colors from the Custom, Web, or System tabs.  A sample of the formatting 
displays in the Sample Cell field. 

9. If you want to format the font style (such as "Bold"), select a style from the Text Style drop-down 
list 

10. If you want to format the cell background, select a color from the Cell Color drop-down list. 
11. To apply the same formatting to the entire row, select the Apply to Row checkbox. 
12. Click the OK button to save the Format Rule. 

Grid Preferences 

On the Preferences tab of the Customize Grid dialog, you can show or hide the Group By box, Auto 
Filter row, and Indicator column.  You can also specify the number of records (rows) to display, and set 
the grid to automatically refresh. 
  

1. To show or hide the Group By box, check the designated check box beneath Visual, OR right 
click the column header and select Group By Box. 
This displays or hides the area above the column headers where you can drag the column names 
in order to group them.   

2. To show or hide the Auto Filter row, check the designated check box, OR right click the column 
header and select Auto Filter Row. 
(See also Sorting, Filtering, and Grouping Records). 

3. To show or hide the Indicator column,  check the designated check box. 
This adds a column to the left of the grid with an arrow indicating the selected row. 

4. By default, up to 5,000 records are displayed in a grid.  To specify the number of rows (records) 
to display, select an option from the Max. Row Mode: drop-down list below Data (such as 
Custom).  Then enter or select the number of rows to display from the Max. Rows: drop-down 
list. 

5. To set the grid to automatically refresh, click the Automatically Refresh Grid checkbox, then 
select or enter the time interval to refresh the grid in the Minutes field. 

6. Click the OK button to save the settings. 
  
See also:  Creating Public Grid Views 
  
Creating Public Grid Views 
You can customize grid views and make them available to all technicians by saving or publishing them as 
Public Views. 
  
Notes:   

 Your BMC Track-It! Administrator grants permissions to Technicians to add, edit, and delete 
Public grid views.  See Restricting Privileges by Module in the Administrator's Guide. 

 You can create up to 99 Public Grid Views. 
To Create Public Grid Views: 

1. Create a view as described in the previous topic Creating User-defined Grid Views. 
2. Once you've created your view, select Save Current View As from the Current View menu. 
3. Enter the view name in the View Name text box on the Save Current View As...dialog. 
4. Select Public - View is available to all Technicians from the View Type drop-down list. 
5. Click the Save button. 

The Public View name displays in the Public Views drop-down list on the Current View menu. 
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You can also publish your user-defined views as Public Views from the Manage Views dialog. 
  
To Publish User-defined views as Public Views 

1. Select Manage Views from the Current View menu , then select a user-defined view. 
2. Click the Publish button. 

  
  
See also:  Renaming, Deleting, and Copying Views 
  
   
  
Exporting and Importing Views 

Exporting Views 

You can export User-defined Views so that you can share them with other BMC Track-It! users.   When 
you export a view, the view is saved as an .xml file to the directory you specify (such as your hard drive or 
a network drive).  The .xml file name will display the name of your file (such as My Work Orders by 
Priority.xml.  Then other users can import your User-defined View into BMC Track-It!. 
  
Important:  When other users import the views, they will only be able to see  the information available 
based on their security privileges.   
  
Note:  You can also create Public Grid Views that all technicians can view without having to export and 
import.  See Creating Public Grid Views 
To Export a User-defined View: 

1. In the Manage Views dialog, select the view you want to export, and click the Export button. 
2. In the Export View dialog, navigate to the drive or folder where you want to save the view. 

The File Name defaults to the name of your view, and the Save as Type defaults to "View Files". 
3. Click the Save button on the Export View dialog. 

The grid view file will display in your selected drive or folder. 
Now other users can import the file into BMC Track-It!  (See below). 

Importing Views 

To Import a User-defined View: 
1. In the Manage Views dialog, select the view you want to export, and click the Import button. 
2. In the Import View... dialog, navigate to the drive or folder of the view file, then click the Open 

button. 
3. If the view name already exists, a message will display asking you if you want to import the view 

under a new name. 
To change the name, click the Yes button.  On the Save Current View As dialog, enter the new 
name, then click the Save button. 

4. The imported view name displays in the Current View drop-down list.   
  
  
  

Customizing the BMC Track-It! Workspace 
Customizing Your Home Page (Dashboard Graphs, Asset Summary, and Announcements) 
  
The BMC Track-It! Home Page displays: 
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• Two Help Desk graphs (If your BMC Track-It! Administrator has given you permission to access 
the Dashboard module) 

• Asset Summary counts, such as the number of New Discovered Assets (with links to the Asset 
Reconciliation - Discovery and Asset Reconciliation - Bar Code windows 

• Announcements (for Technicians or Technicians/Users) 
To View Your Home Page: 

1. Select Home Page from the Navigation Pane. 
To View Different Dashboard Charts: 

1. Click the Change View link at the top of the chart, then select a graph or pivot grid from the list.   
(You must have access to the Dashboard module to view the charts). 

To Set Asset Summary Preferences: 
1. Click the Edit Preferences link in the Asset Summary panel. 
2. On the Asset Summary Preferences dialog, click the check box next to the information you want 

to display: 
  

• Discovered Assets - New 
• Discovered Assets - Missing 

• Those that have not been found in a scan during the selected period (the past 
Day, Week, or Month) 

• Bar Coded Assets - New 
• Bar Coded Assets - Missing 

• Those that have not been found in a scan during the selected period (the past 
Day, Week, or Month) 

• Audited Assets 
• Assets Audited for the first time 

  
3. Click the Save button. 

  
See Also:  Creating Announcements 
Customizing Your Home Page (Dashboard Graphs, Asset Summary, and Announcements) 
  
The BMC Track-It! Home Page displays: 
  

• Two Help Desk graphs (If your BMC Track-It! Administrator has given you permission to access 
the Dashboard module) 

• Asset Summary counts, such as the number of New Discovered Assets (with links to the Asset 
Reconciliation - Discovery and Asset Reconciliation - Bar Code windows 

• Announcements (for Technicians or Technicians/Users) 
To View Your Home Page: 

1. Select Home Page from the Navigation Pane. 
To View Different Dashboard Charts: 

1. Click the Change View link at the top of the chart, then select a graph or pivot grid from the list.   
(You must have access to the Dashboard module to view the charts). 

To Set Asset Summary Preferences: 
1. Click the Edit Preferences link in the Asset Summary panel. 
2. On the Asset Summary Preferences dialog, click the check box next to the information you want 

to display: 
  

• Discovered Assets - New 
• Discovered Assets - Missing 

• Those that have not been found in a scan during the selected period (the past 
Day, Week, or Month) 

• Bar Coded Assets - New 
• Bar Coded Assets - Missing 
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• Those that have not been found in a scan during the selected period (the past 
Day, Week, or Month) 

• Audited Assets 
• Assets Audited for the first time 

  
3. Click the Save button. 

  
See Also:  Creating Announcements 
Setting User Preferences (Language, Start-up Module, and Password) 
You can select the language displayed in BMC Track-It!.  The application  is available in several different 
languages (English, French, German, Portuguese, and Spanish).  You can also set the module that will 
display each time you start BMC Track-It! (such as Home Page, Dashboard, Help Desk, or Inventory). 
 Finally, you can set a user password which will be required when BMC Track-It! is used on your 
computer. 
  
To Set User Preferences: 

1. Click Tools/ Preferences from the main menu. 
2. To run BMC Track-It! in a different language, select it from the Language drop-down list. 

You can click the Use Default button to run BMC Track-It! in English. 
3. To display a specific module when BMC Track-It! is started, select a module from the Start-up 

Module drop-down list. 
4. To require a Password when BMC Track-It! run, enter the password in the Password field, then 

enter it again in the Confirm Password field. 
5. Click the Save button. 

  
See also:  Setting the Default Language in the Administrator's Guide. 
  
  

  
  
  
  
Customizing Toolbars and Creating Toolbar Buttons 
  
Technicians can customize toolbars and create toolbar buttons for BMC Track-It! modules and detail 
windows (such as the Work Order and Asset detail windows).  Administrators can also globally customize 
the Help Desk module and Work Order detail toolbars so that all Technicians can use specific toolbar 
buttons.  Toolbar buttons can be associated with batch or executable files, as well as URLs.  For 
example, you can link the button to the BMC Track-It! Technician's Guide (PDF) on our Support Web 
page. 
To Show or Hide a Toolbar: 

1. Select the module for the toolbar you want to customize. 
2. Right click anywhere on the toolbar and select or deselect the toolbar's name (such as Standard, 

Search, or Global). 
To Customize a Toolbar: 

1. Select the toolbar you want to customize. 
2. Right click anywhere on the toolbar and select Customize. 
3. On the Customize Toolbar dialog, select an item from the Available Toolbar Items list, then 

click the Add button to place it in the Current Toolbar Items list. 
4. Click the Move Up or Move Down buttons to move the toolbar buttons to the left or right on the 

toolbar. 
5. To remove a toolbar item from the toolbar, select the item from the Current Toolbar Items list, 

then click the Remove button. 
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6. When you're finished customizing the toolbar, click the Accept button. 
  
Note:  You can only edit customized buttons (see below). 
To Create a Toolbar Button: 

1. Select the module for the toolbar you want to customize. 
2. Right click anywhere on the toolbar and select Customize. 
3. On the Customize Toolbar dialog, select a toolbar (Standard or Global), then click the New 

button. 
Notes:  Only Technicians with BMC Track-It! Administrator rights can customize global 
toolbars.  Also, the Help Desk and Work Order global toolbars are independent of each other. 
 If you want to add the same customized button, you will need to add it separately for both 
toolbars. 

4. On the Customize Toolbar Button dialog, enter a name for the toolbar button in the Name field. 
5. Enter descriptive text for the toolbar button in the Tooltip field. 

This will be displayed when Technicians mouse over the button. 
6. Click the checkbox below the Tooltip textbox to display the Tooltip text with the tooltip's icon. 
7. Click the Select button under Display Icon to define the button's icon. 

Note:   If you select an application in the next step, the associated icon will automatically 
display.  If you don't select an application, select a file type of .ico (16 x 16 pixels) for best 
results. 

8. Click the Ellipses (...) button next to the Path text box to enter a URL, file path, or to select an 
executable or batch file. 

9. Optional:  You can enter parameters in the Parameters text box, or click the Add Parameter 
button to select them. 

The list of parameters are BMC Track-It! database fields, and are available for the Inventory 
and Help Desk toolbars so that you can use them with batch or executable files. 

10. Click the Save button on the Customize Toolbar Button dialog. 
11. To edit the button, select it, then click the Edit button.  When finished, click the Accept button on 

the Customize Toolbar dialog. 
The new buttons now display on the toolbar. 
  

  
  
  
  
Customizing a Module's Tab Displays 

Customizing Tab Displays 

  
Many of the windows in BMC Track-It! display information using tabs, such as the Asset, Software Title, 
and Work Order* windows.  The header pane at the top of the window displays basic information and the 
tabs display the details.  The tab area of the window can display two full tabs at a time, like an open book. 
You can customize which tabs display and in what order. 
  
For example, the Work Order window displays basic information in the header pane, such as the 
Requestor and Summary.  The additional tabs display detailed information: 
  

 Notes 
 Resolution 
 Additional Custom Fields 
 Classification and Schedule 
 Requestor 
 Asset 
 Assignments 
 Change Management 
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 Attachments 
 Audit Trail 

  
You can arrange the tabs so that only certain tabs are displayed, as in the example below.  You can 
rearrange the tab order by dragging and dropping the tabs. 
  
Notes Resolution Notes   Requestor Asset Assignments 

        

  
Work Order Window:  Tabs 

  
*Note:  In addition to customizing tabs, you can save tab layouts for Work Orders.  See Saving Tab 
Layouts for Work Orders 
To Customize the Tab Display: 

1. Right click on any of the tabs (such as Classification and Schedule) on either the left or right tab 
pane. 

2. Select the tabs you want to display from the list in the context menu. 
3. To view all of the selected tabs, click the left and right arrow buttons at the top right of the tabs 

(these buttons display if more tabs are selected than can fit on the pane). 
4. To rearrange the tab order, drag and drop the tabs. 

 
(The order can be changed per panel.) 
  

5. Save and close the window. 
 
The new tab layout will persist when the window is reopened, except for Work Order tabs, which 
have specific functionality (see Saving Tab Layouts for Work Orders). 
  

Saving Tab Layouts for Work Orders 

  
In addition to customizing tab displays, you can arrange and save tab layouts for new and existing Work 
Orders and Assignments.  Once you save the tab layouts, when you create a new Work Order or 
Assignment, the tabs will display according to your settings. 
  
For example, you might want to arrange the tabs for new Work Orders with the following tabs: 
  
Classification 
and 
Schedule 

Requestor Notes   Attachments     
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Example:  Tab Layout for New Work Orders 
  
You could arrange existing Work Orders to include the Assignments, Resolution, and Audit Trail tabs on 
the right pane. 
  
Classification 
and 
Schedule 

Requestor Notes   Assignments Audit Trail Resolution 

        

Example:  Tab Layout for Existing Work Orders 
To Save Tab Layouts for Work Orders: 

1. Arrange the tabs on the left and right pane (see the previous topic Customizing Tab Displays). 
2. From the Tab Layout button on the menu bar, select any of the following options: 

  
 Save as New Work Order 
 Save as New Assignment 
 Save as Edit Work Order 
 Save as Edit Assignment 

  
Depending on the layout you saved above, the new tab layout will persist when the window is 
reopened. 

Inventory: Managing IT Assets 

Managing IT Assets Overview 
With the BMC Track-It! Inventory module, you can manage your company's assets, which includes 
discovering assets by scanning the network, placing the assets in inventory, and auditing the network for 
changes.  (These processes are explained in detail in related multimedia tutorials on Managing IT 
Assets.)  You can also manage non-networked assets by manually adding assets, or by scanning them 
with the Bar Code solution.  The Inventory process is comprised of: 
  

• Asset Discovery 
When the Asset Discovery process runs, Track-It scans the network and captures information 
about workstations and devices.   

  
• Managing Discovered Assets 

Once the assets are discovered, you can manage them, such as deciding whether or not to 
track them in inventory. 

  
• Auditing Assets 

If you decide to track the discovered assets, Track-It continually audits the network and 
updates inventory information regarding those assets.   

  
• Bar Code Solution 

The Bar Code solution is an add-on module enabling you to track your company's IT assets 
using bar codes.  This facilitates increased productivity by expediting data entry and reducing 
errors during physical audits. 

  
• Inventory Reports 
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Using the BMC Track-It! Reports module, you can generate reports that list all of your 
organization's assets, including Assets by Serial Number, Installed Network Printers, and 
many more. 

  
• Integration with Purchasing and Help Desk Modules 

The Inventory module is integrated with the Purchasing and Help Desk modules. 
  
Next Topic:  Managing IT Assets Workflow 

Managing IT Assets Workflow 
  
The flowchart below represents the tasks in the following topics.   
  

 
  
  
Next Topic 
  
Adding Assets to Inventory (Overview) 

  
  
  
  
  

Adding Assets to Inventory 
Adding Assets to Inventory (Overview) 
There are several ways to add assets to Inventory in BMC Track-It!: 
  
 The easiest method is the Asset Discovery process which automatically scans your network and 

discovers computers and other networked devices.  Then you can select which assets to add to 
inventory. 

 With the Bar Code solution (an add-on module) you can scan bar coded assets and add them to 
inventory. 

 You can audit your network using logon scripts which finds computers added to the network. 
 You can manually add assets (which might be useful for non-networked assets such as DVD 

players). 
  
Next Topic 
  
Adding Assets to Inventory (Workflow) 
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Adding Assets to Inventory (Workflow) 
  
The flowchart below represents the tasks in the following topics.   
  

 
Next Topic:  Discovering Assets on Your Network (Overview) 
  
  

  
Discovering Assets 

Discovering Assets on Your Network 

  
The Asset Discovery process discovers devices on the network by conducting a network scan.  This 
includes workstations, switches, routers, printers and other networked devices.    Typically your BMC 
Track-It! Administrator will set up BMC Track-It! to automatically discover assets at specified time 
intervals.  However, you can also manually discover your assets.   
  
Note:  Your BMC Track-It! Administrator will need to initially set up the scan criteria to discover assets 
(see Specifying Scan Criteria to Discover Assets). 
  
Next topic:  Discovering Assets Workflow 

Discovering Assets Workflow 

  
The flowchart below represents the tasks in the following topics.   
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Next Topic:  Manually Discovering Assets 

Manually Discovering Assets 

  
Typically most organizations will set up BMC Track-It! to automatically scan your network at specific time 
intervals to discover new assets.  However you can manually scan for new assets at any time. 
  
 Note:  Your BMC Track-It! Administrator schedules asset discoveries and can set up BMC Track-It! to 

automatically notify you when new assets are discovered.  (See Scheduling Asset Discoveries and 

Notifying Technicians in the Administrator's Guide.) 

 To Manually Discover Assets: 
1. From the Inventory module, select Manage Discovered Assets from the Tools menu on the 

main menu bar, OR 
 
Select Discover Assets Now from the Options button on the Asset Reconciliation - Discovery 
window. 
 
The dialog can also be accessed from the Configuration Wizard (Step 3 of 3:  Discover Network 
Assets). 
  

2. The Asset Discovery Progress dialog displays and the discovery process begins.   When the 
network scan is complete, the number of new assets are displayed at the bottom of the dialog. 
 
The discovered assets are displayed on the New tab of the Asset Reconciliation - Discovery 
window. 
  

3. Click the Expand (+) button to view the assets. 
  
Once you discover your assets, you can manage and reconcile them.   
  
Next Topic:  Managing and Reconciling Discovered Assets 
  
  
  
  
  
  
  

  
  

Managing Discovered Assets 

Managing and Reconciling Discovered Assets 

After BMC Track-It! discovers your assets, you can reconcile any differences between your current 
inventory and discovered assets on the Asset Reconciliation - Discovery window.   
  
On the Manage Discovered Assets window, accessed from the Tools menu in the Inventory module, 
new assets that have not been previously discovered by BMC Track-It! are listed on the New tab. 
 Discovered assets that match your current inventory (based on the MAC address) are displayed on the 
Matched tab,  and any changes (such as computer name) are displayed.  If any assets have been 
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removed from your network, they will display on the Missing tab.  If you decide not to track specific 
assets, you can move them to the "Ignored" list.  Assets that do not have a MAC Address or Name are 
listed on the Unidentified tab. 
  
The following table describes the discovered assets listed on each tab on the Manage Discovered 
Assets window.  See the related topics in this chapter for detailed instructions. 
  
Click the links below for detailed information. 
  

Discovered Assets 
Tab 

Description 

New New assets that do not match those already in inventory.  You 
can add them to inventory, match them to an existing asset, skip, 
or ignore the asset in future scans. 

Matched Assets that match those in Inventory based on the MAC address 
or other criteria.  You can accept the designation, skip, match 
each asset to another asset, or unlink the scan and asset. 

Missing Assets that have not been found in a scan during a specific 
period.  You can skip them, ignore them, or remove them from 
inventory. 

Ignored Assets that have been manually moved to the list from new or 
missing assets.  You can skip them or resume discovery updates. 

Unidentified Assets that do not have a MAC Address or Name (view only) 
  
  
  
  
  
Next Topic:  Managing New Assets (Discovery) 

Managing New Assets (Discovery) 

  
Assets that do not match those already in inventory are placed in the New list (on the New tab of the 
 Asset Reconciliation - Discovery window).  You can add them to inventory, match them to an existing 
asset, skip them, or ignore the assets in future scans. 
  
The Options button on the window enables you to discover assets, configure discovery, and print a 
report. 
To Manage New Assets: 

1. To access the Asset Reconciliation - Discovery window, select Manage Discovered Assets 
from the Tools menu on the main menu bar (while in the Inventory module). 

  
You can also access the window by the following: 

 Select Manage Discovered Assets from the Tasks pane in the Inventory 
module, OR 

 Select the Manage Discovered Assets icon from the Tools menu in the 
Inventory module. 

  
2. Select the New tab on the Asset Reconciliation - Discovery window. 
3. Click the Expand (+) button to view all the assets. 
4. The list of assets is grouped by domain; however, you can click the Group reconciliation by: 

 drop-down list to view the assets by IP address, or None to remove grouping. 
5. To view the assets by Asset Type, click the checkbox Show asset types in groups. 
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6. To add the new assets to Inventory, click the Save button, and the assets will automatically be 
added to Inventory and removed from the New tab.. 
 
A confirmation dialog displays to notify you of the number of assets that will be added to 
Inventory. 
  

You can select several assets at once.  Press and hold the Ctrl key while you select the 
assets.   If you're selecting assets in a continuous list, press and hold the Shift key while 
selecting them.  Then right click the assets and select Add to Inventory. 

  
7. If you're not sure how you want to manage a particular asset, right click the asset (or assets) and 

select Skip. 
When you return to the Asset Reconciliation - Discovery window once it has been saved and 
closed, the designation will be reset to their previous state (such as Add to Inventory). 

8. If you don't want to track the asset, right click the asset (or assets) and select Ignore future 
scans. 
The discovery process will ignore the asset in the next scan. 

9. If you want to match the new asset with one already in inventory, right click the asset (or assets) 
and select Match to Existing Asset. 

10. If you want to change the asset type (in order to easily identify the asset, such as desktop, laptop, 
etc.), see Changing Asset Types (Asset Types are created in the Administration Console). 

11. When you are finished managing the new assets, click the Save button. 
  
Next topic:  Managing Matched Assets (Discovery) 

Managing Matched Assets (Discovery) 

  
Assets that match those already audited in Inventory (based on the MAC address or other criteria) are 
placed in the Matched list (on the Matched tab of the Asset Reconciliation - Discovery window).  You 
can save the list to accept the designation, skip, match each asset to another asset, or unlink the scan 
and asset. 
To Manage Matched Assets: 

1. To access the Asset Reconciliation - Discovery window, select Manage Discovered Assets 
from the Tools menu on the main menu bar (while in the Inventory module). 
  

You can also access the window by the following: 
 Select Manage Discovered Assets from the Tasks pane in the Inventory 

module, OR 
 Select the Manage Discovered Assets icon from the Tools menu in the 

Inventory module. 
  

2. Select the Matched tab on the Asset Reconciliation - Discovery window. 
3. Click the Expand (+) button to view all the assets. 

The assets are grouped by the following designations: 
  

Probable Matches Discovered assets that match those in inventory (by 
MAC address or other criteria) 

No Changes Discovered assets with no changes since the last 
discovery scan 

Changes Discovered assets that have changed since the last 
discovery scan 
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4. The list of assets is grouped by domain; however, you can click the Group reconciliation by: 
 drop-down list to view the assets by IP address, or None to remove grouping. 

5. To view the assets by Asset Type, click the checkbox Show asset types in groups. 
6. By default all of the matched assets are designated Accept (see the Action column).  If you want 

to clear the Matched list (since the assets are already matched to inventory, click the Save 
button. 
The Matched list will be cleared until the next discovery scan, and the assets display in the 
Inventory module. 

7. If you're not sure how you want to manage a particular asset, right click the asset (or assets) and 
select Skip. 
When you return to the Asset Reconciliation - Discovery window once it has been saved and 
closed, the designation will be reset to their previous state (such as Add to Inventory). 
  

You can select several assets at once.  Press and hold the Ctrl key while you 
select the assets.   If you're selecting assets in a continuous list, press and hold 
the Shift key while selecting them. 

8. To match the asset to another asset in inventory, right click and select Match to another asset. 
a. The Search dialog displays.  Enter the first four characters of the Asset Name or Asset 

ID in the Search for: field, then click the Search button. 
b. Click the asset from the search results, then click the Select button. 

9. If you want to remove the link between the discovered asset and the match found by BMC Track-
It! in inventory, right click and select Unlink scan and asset. 

10. When you are finished managing the matched assets, click the Save button. 
  
Next Topic:  Managing Missing Assets (Discovery) 

Managing Missing Assets (Discovery) 

  
The discovery process compares assets found on the network with those in inventory.  If the assets were 
listed in inventory, but not found during the current scan, they are listed on the Missing tab of the Asset 
Reconciliation - Discovery window.  You can skip them, ignore them, or remove them from inventory. 
To Manage Missing Assets: 

1. To access the Asset Reconciliation - Discovery window, select Manage Discovered Assets 
from the Tools menu on the main menu bar (while in the Inventory module). 
  

You can also access the window by the following: 
 Select Manage Discovered Assets from the Tasks pane in the Inventory 

module, OR 
 Select the Manage Discovered Assets icon from the Tools menu in the 

Inventory module. 

  
  
  
  
  

2. Select the Missing tab on the Asset Reconciliation - Discovery window. 
3. Click the Expand (+) button to view all the assets. 

The assets are grouped by Previously Scanned and Never Scanned. 
4. The list of assets is grouped by domain; however, you can click the Group reconciliation by: 

 drop-down list to view the assets by IP address, or None to remove grouping. 
5. To view the assets by Asset Type, click the checkbox Show asset types in groups. 
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6. To view the missing assets that have not been found since a day, week, or month, click the 
designated drop-down list. 

7. If you're not sure how you want to manage a particular asset, right click the asset (or assets) and 
select Skip. 
When you return to the Asset Reconciliation - Discovery window once it has been saved and 
closed, the designation will be reset to their previous state (such as Add to Inventory). 
  

You can select several assets at once.  Press and hold the Ctrl key while you 
select the assets.   If you're selecting assets in a continuous list, press and hold 
the Shift key while selecting them. 

8. If you don't want to track the asset, right click the asset (or assets) and select Always ignore 
asset. 

9. To remove an asset legitimately missing from inventory, right click and select Remove from 
inventory. 

a. Click the Save button. 
b. The Delete Asset dialog displays.  Select the checkbox of any associated Tracked Items 

you want to transfer to Unassigned Equipment, then click the OK button. 
c. Click the Yes button when the Delete Assets confirmation message displays. 

The asset is removed from inventory. 
10. When you are finished managing the matched assets, click the Save button. 

  
Next Topic:  Viewing Unidentified Assets (Discovery) 

Viewing Unidentified Assets (Discovery) 

  
Discovered assets that only have an IP address (and neither a MAC Address nor a Name) are placed on 
the Unidentified tab of the Asset Reconciliation - Discovery window.  These assets are listed for 
information only, and you won't be able to move them to Inventory, since at a minimum, an asset must 
have a MAC Address or Name.  For more information on unidentified assets, see our KnowledgeBase 
article "Unidentified Assets Found by Discovery"  
  
To View Unidentified Assets: 

1. To access the Asset Reconciliation - Discovery window, select Manage Discovered Assets 
from the Tools menu on the main menu bar (while in the Inventory module). 

  
You can also access the window by selecting Manage Discovered Assets from the 
Tasks pane in the Inventory module. 

  
2. Select the Unidentified tab on the Asset Reconciliation - Discovery window. 

  
3. Click the Cancel button to close the Asset Reconciliation - Discovery window. 

  
The assets will remain on the Unidentified tab until the next time the discovery process is run. 

  
Manually Adding Assets 
The best way to add IT assets is to let BMC Track-It! discover them using the Asset Discovery feature 
(see Discovering Network Assets).  If necessary, however, you can manually add assets in the Inventory 
module.  This may be useful for non-IT assets (such as DVD players or projectors).   
  
If you have a license for the Bar Code Solution, you can scan the asset with your bar code device, then 
add it to inventory through the Manage Bar Code Assets window.  (See Getting Started with the BMC 
Track-It! Bar Code Solution).  
To Manually Add an Asset: 

http://support.numarasoftware.com/support/view_article.asp?ArticleID=3813
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1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the Tasks pane, click New Asset (or from the Menu Bar, select New/Asset from the File 

menu). 
3. Select the asset type (such as Computer or Printer) from the Select Asset Type dialog, then click 

the OK button. 
The Asset window displays.    

To Add Asset Details: 
The top pane of the Asset window displays the most commonly-used fields to describe an asset:  Type, 
ID, User, Department, Department Number, and Location. 
  

1. The Asset Type displays by default, as previously selected.   
2. Enter the asset's ID number in the Asset ID field (typically, this is the company asset tag or serial 

number). 
3. Select or enter the user's name associated with the asset from the User drop-down list. 

To add a user name if it is not listed, click the Add button next to the User drop-down arrow. 
To change a user name associated with the asset, either select another name from the drop-down list, OR click the 
Ellipses (...) button.  Enter the first few letters of the first or last name, and click the Search button.  Select the user, then 
click the Select button. 

4. Select or enter the department from the Department drop-down list. 
5. Select or enter a department number from the Department Number drop-down list. 
6. Select or enter a location from the Location drop-down list. 
7. Click the Save button. 

  
Additional information about the asset is automatically displayed on specific tabs when during the audit 
process, and some are user-defined.  See each topic below for details: 
  
Entering User-defined Asset Information (Manage/User-defined Fields, Description, and Graphic tabs) 
Viewing Audit Results (Software, File Information, Tracked Items, and Hardware tabs) 
  
  

Working with Assets and Items 
Working with Assets (Overview) 
Once you add Assets to Inventory, you can view, edit, copy, delete, and audit  them.  You can also 
promote Items to Assets to track them individually. 
  
Next Topic: 
  
Viewing and Editing Assets 
  
See also:  Working with Items 
Working with Assets and Items (Workflow) 
  
The flowchart below represents the tasks in the following topics.   
  



BMC Track-It! 11 Web 

 © Copyright 1989 - 2012 Numara Software, Inc.  BMC Software, the BMC logos, and other BMC marks are trademarks or registered trademarks of BMC Software, Inc. in the 
U.S. and/or certain other countries. Track-It! is the property of Numara Software, Inc. and is registered with the U.S. Patent and Trademark Office, and may be registered or 

pending registration in other countries. Numara Software and BMC Software Confidential. 

27 

 
Next Topic: 
Viewing and Editing Assets 
Viewing and Editing Assets 
The list of assets is displayed in the Inventory grid (Inventory module).  For detailed information on 
working with grid views, see Viewing Information in Grids). If you have a license for the BMC Track-It! 
Bar Code solution, you'll see additional screen elements noted below. (See Getting Started with the 
BMC Track-It! Bar Code Solution for more information). 
To View Asset Information: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
The Inventory window displays and assets are listed in the grid.  You can specify which 
columns to view (See Creating User-defined Views). The number of records display at the 
bottom of the grid.   If you have a license for the Track-It Bar Code solution, you will also see 
a link in the Tasks pane to Asset Reconciliation - Bar Code.   

2. In the Inventory grid, double-click the Asset you want to view, or select the asset, then select 
Open Asset in the Tasks pane. 
The Asset record opens.  If you have a license for the Bar Coding Solution, you will also see the 
Company Asset Tag associated to the asset, if applied.   

The top pane of the Asset window displays the most commonly-used fields to describe an 
asset:  Type, ID, User, Department, Department Number, and Location. 
 
Additional information about the asset is automatically displayed on specific tabs when during 
the audit process, and some are user-defined.  See each topic below for details: 

  
Entering User-defined Asset Information (Manage/User-defined Fields, Description, and 
Graphic tabs) 
Viewing Audit Results (Software, File Information, Tracked Items, and Hardware tabs) 

  
Editing Assets 
  
It is best to allow the auditing process to update assets; however, you can manually edit certain fields in 
the Asset record.  See Entering User-defined Asset Information. 
  
Customizing the Tabs Display 
  
You can select which tabs to display, and which two to display at a time. 
To Customize the Tabs Display: 

1. Right click any tab name, and select the check boxes of the tabs you want to display. 
2. To display two tabs at once, right click the right pane (appears blank until a tab has been 

selected), then select a tab name. 
  

See Also:  Viewing Information in Grids 
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Viewing an Asset's Audit Trail 
  
BMC Track-It! automatically tracks certain Technician and system activity related to an asset and displays 
this information on the Audit Trail tab of the Asset detail window.   The Audit Trail displays what was 
changed, at what date and time, and who made the change for the following attributes: 
  

 Asset ID 
 Department 
 Department Number 
 Location 
 User 

  
Audit Trail information can also be used to generate reports.   
  
You can also view the Audit Trail for all Assets in the Administration Console (see Viewing the Inventory 
Audit trail for Asset Changes in the Administrator's Guide). 
To View an Asset's Audit Trail: 

1. Click the Audit Trail tab of the Asset detail window. 
Activities display in reverse chronological order. 

Selecting and Changing Asset Types 
  
This dialog is accessed from the Inventory module when creating new assets or changing Asset Types. 
 See Manually Adding Assets and Promoting Items to Assets. 
  
Note:   You can change the system type (Computer, Hub, Printer, Router, Switch, or Other) of the asset 
type.  However, if the asset is a Computer, and it has already been audited, you cannot change its 
system asset type.   
  

1. From the Select Asset Type dialog, select the type of asset to create for the Item (such as Hub, 
Router, or Other), then click the OK button. 

If your BMC Track-It! Administrator has created Asset Types, these will also display under the 
system asset types, such as Laptop under Computer. 

2. If you are changing an asset's type: 
  

 A Change Asset Type warning will display if you attempt to change a system type, 
saying that this may cause a loss of data that is specific to the asset's current type.   

 The Results dialog will display the Item, Outcome (Successful or Failed), Reason, and 
Description (such as the System Type for the Asset cannot be changed because it has 
already been audited (only Computers can be audited). 
  

3. If you've created a new asset and selected the asset type, click the OK button on the Select 
Asset Type dialog to return to the Inventory grid. 
  

  
Entering User-defined Asset Information 
Your BMC Track-It! Administrator can set up company-specific (user-defined) fields to describe assets. 
 This is useful if you want to add information about an asset that is not captured automatically by BMC 
Track-It! during the discovery and auditing processes.   
This information is entered on the Manage tab of the Asset window in the Inventory module.  You can 
also add an image of the asset. 
To Access the Asset Window: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. Double click the asset in the Inventory grid.  The Asset window displays. 
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To Enter User-defined Information: 
1. On the Manage tab of the Asset window, enter the information in the text boxes.  (The six user-

defined field labels display as Custom Text #1 through #6 until your Administrator changes the 
names). 

2. On the Description tab, enter the information in the text box. 
3. On the Graphics tab, click the Browse button, open the graphics file that you want to display, 

then click the Save button on the Asset window. 
   
Next Topic: 
Copying and Deleting Assets 
  
Associating an Asset with a User 
  
You can associate multiple assets with a user to keep track of all of the assets assigned to a user, and to 
narrow the list of assets displayed when work orders are created.  (See Selecting the Requestor's Asset 
and Viewing Asset Details for a Work Order). 
  
If you want to save time, you can configure the audit process so that when assets are audited, users are 
prompted to enter their user name and other information.  You can also prompt the user to provide 
information during the audit process (See Configuring User Interaction for Audits in the Administrator's 
Guide). 
To Associate an Asset with a User: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the Inventory grid, right click the Asset, then select Change Associated User. 

(You can also double-click the Asset and select a user from the User drop-down list on the Asset 
window. 

3. On the Change Associated User dialog, enter the first few characters of the user's name in the 
Search for text box, then click the Search button. 

4. Select the user to associate with the Asset, then click the Select button. 
  
  
Associating an Asset with a Department 
The audit process can be configured so that when assets are audited, users are prompted to enter their 
user name and other information.  However, you can manually associate an asset with a department on 
the Asset window. 
To Associate an Asset with a Department: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the Inventory grid, right click the Asset, then select Change Associated Department. 

(You can also double-click the Asset and select a department from the Department drop-down 
list on the Asset window. 

3. On the Change Associated Department dialog, enter the first few characters of the user's name 
in the Search for text box, then click the Search button. 

4. Select the Department to associate with the Asset, then click the Select button. 
  
  
  
Associating a Location with an Asset 
The audit process can be configured so that when assets are audited, users are prompted to enter their 
user name and other information.  However, you can manually associate an asset with a Location on the 
Asset window. 
To Associate an Asset with a Location: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
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2. In the Inventory grid, right click the Asset, then select Change Associated Location. 
(You can also double-click the Asset and select a department from the Location drop-down list 
on the Asset window. 

3. On the Change Associated Location dialog, enter the first few characters of the user's name in 
the Search for text box, then click the Search button. 

4. Select the Location to associate with the Asset, then click the Select button. 
  
Attaching Files to Assets 
  
You can add files to Assets, such as text files, documents, or images.  You can also rename and delete 
file attachments. 
To View Asset Attachments: 

1. In the Inventory grid, double-click the Asset you want to view, or select the asset, then select 
Open Asset in the Tasks pane. 

2. Right click the file on the Attachments tab, then select Open. 
  
Tip:  You can customize the grid view and add the # of Attachments column to quickly view which 
records have attachments.  See Showing and Hiding Columns in the Creating User-defined Views topic. 
To Attach a File to an Asset: 

1. Select the Attachments tab on the Asset window. 
2. Click the Add button. 
3. In the Open Attachment dialog, navigate to the location of the file, then double click it, or select it 

and click the Open button. 
The file displays on the Attachments tab on the Asset window. 

4. Click the Save button. 
To Rename a File Attachment: 

1. Right click the file on the Attachments tab, then select Rename. 
To Delete a File Attachment from an Asset: 

1. Select the file on the Attachments tab, then press the Delete key.  Click Yes on the Delete 
Attachment(s) confirmation dialog. 
You can also right click the file and select Delete. 

2. Click the Save button on the Asset window. 
To Sort the List of Attachments: 

1. Click the column header (e.g. "Name"). 
To Change the Grid View of the List of Attachments: 

1. Right click anywhere on the Attachments tab, then select View. 
2. Select an option from the View menu (Text Only, Wrap Text, Auto Arrange). 

Copying and Deleting Assets 

Copying an Asset 

You can copy assets in the Inventory module to save time when you need to manually add them. 
Important:  If you have a license for the BMC Track-It! Bar Code solution and you copy an asset, an 
additional bar code license will not be automatically associated with the copied asset. 
To Copy an Asset: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. Right click the asset from the Inventory grid and select Copy. 

You can also select the asset and press CTRL+C, OR 
Click the Copy icon on the main toolbar, OR 
Click Copy Asset from the Tasks pane. 

3. On the Copy Asset dialog, select or enter the number of copies to make. 
4. To also copy the tracked items associated with the asset, click the Copy Tracked Items check 

box. 
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5. Click the OK button. 
The copied asset(s) display in the Inventory grid, and are automatically assigned an Asset ID (a 
system-generated consecutive number).  You can edit the copied asset as necessary.   

Deleting Assets 

When necessary, assets can be deleted from Inventory.  You can also decide whether or not to delete 
tracked items associated with the asset, or transfer them to Unassigned Equipment. 
  
Notes: 

• If you have a license for the BMC Track-It! Bar Code solution, when you delete an asset, all of the 
asset's associated bar code information is also deleted.  See Unlinking a Bar Code Scan from an 
Asset. 

• You can also retire assets until you're ready to delete them.  See Retiring Assets. 
To Delete an Asset: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. Right click the asset (or multiple assets at a time) from the Inventory grid and select Delete. 
3. On the Delete Asset dialog, select the checkbox of any associated Tracked Items you want to 

transfer to Unassigned Equipment, then click the OK button. 
4. Click the Yes button when the confirmation message displays. 

  
Next Topic: 
Printing Asset Records  
   
See also:   Storing Items in the Unassigned Equipment List, Manually Adding Assets and Viewing and 
Editing Assets 
  
Printing Asset Records 
To Print an Asset Record: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. Right click the asset from the Inventory grid and select Print, OR 

Select the asset and press CTRL+P, OR 
Click the Print icon on the main toolbar, OR 
Click Print Asset from the Tasks pane. 
  

  
Working with Items 

Working with Items (Overview) 

  
In BMC Track-It! you can create a catalog of common Items you'll be purchasing and/or adding to 
inventory to save time with data entry, you can store items in the Unassigned Equipment list, transfer 
Items to and from the Unassigned Equipment list and other Assets, and promote Items to Assets. 
  

Creating the Master Items Catalog for Purchasing, Inventory, and Library 

Master Item List 
  
The Master Items list is a "catalog" of Items you can create to list items you may be purchasing and/or 
adding to inventory.  This list saves time with data entry.  The list is similar to a catalog or product list. 
 The items in the list are not actual purchases or inventory until you choose to add them to purchase 
orders or as Tracked Items in the Inventory module.  The list can include virtually any type of Item -- from 



BMC Track-It! 11 Web 

 © Copyright 1989 - 2012 Numara Software, Inc.  BMC Software, the BMC logos, and other BMC marks are trademarks or registered trademarks of BMC Software, Inc. in the 
U.S. and/or certain other countries. Track-It! is the property of Numara Software, Inc. and is registered with the U.S. Patent and Trademark Office, and may be registered or 

pending registration in other countries. Numara Software and BMC Software Confidential. 

32 

hardware to software or any other type of asset.   In BMC Track-It!, an Item is the smallest increment of 
anything you would want to purchase and/or track in inventory.  Examples of Items are:  hardware such 
as CPUs, monitors, and keyboards; software, and non-PC assets such as DVD players. When you create 
an Item, you can include such information as Product, Manufacturer, Type (such as Desktop, Laptop, or 
Software), Vendor, Price, Warranty and Maintenance information, and more. 
  
Items 
  
There are several types of Items in BMC Track-It!:   

 Items in the Master Item List 
 Not yet part of inventory -- similar to a catalog of Items to be purchased or placed into 

inventory 
 Manually added to the Master Item List by the BMC Track-It! Administrator 

 Items purchased (Purchasing Module) 
 Items placed into inventory (Inventory Module) by 

 being automatically detected along with its associated asset via the audit process 
 receiving purchase order Items 
 associating them to an Asset 
 storing them in the Unassigned Equipment list 

 Unassigned Equipment is an Asset used as a container to hold Items in inventory 
not yet associated to a particular asset 

Assets and Items 
  
Items are typically associated with an Asset, such as a computer or workstation, so that they can be 
tracked in the system.  During the auditing process, BMC Track-It! places the Items in the Tracked Items 
list for the associated Asset (such as a computer and its peripherals).  You can transfer items between 
assets and the Unassigned Equipment list.  You can also promote an item to an asset so that it can be 
tracked (for items that wouldn't ordinarily be found during the audit process, such as those not connected 
to a network. 
  
Creating Items in the Master Item List 
   
You can access the Master Item list from: 
  

 the Administration Console 
 an individual asset in the Inventory module 
 a purchase order in the Purchasing module (and from the See Also link in the Tasks pane) 
 a library item in the Library module (and from the See Also link in the Tasks pane) 
 a software title in the Software module (and from the See Also link in the Tasks pane) 

  
To Create an Item in the Master Item List from the Administration Console: 

1. Select Administration Console from the Tools menu on the main menu bar. 
2. In the Administration Console, select Lookup Tables/ Inventory/Master Items. 
3. On the Master Items panel, click the Add button. 

The Master Item dialog displays. 
4. Enter a description for the Item in the Product Description field (required). 
5. Select or enter a category for the Item from the Product Type drop-down list (required). 

To add a Product Type if it is not listed, click the Add button next to the Product Type drop-down 
arrow. 
 
The following are optional:   

 Manufacturer 
 Part Number 
 Vendor 
 Warranty 
 Support 
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 Price 
 Maintenance Vendor 
 Contact Person 
 Comments 

6. If you have a license for the Software License Management module, you can associate a 
Software Item with an item in the Master Items list on the Software tab.  (See Associating 
Software Titles with Master Items in the Technician's Guide.) 

7. Click the Apply button to save your changes, and the OK button to close the window. 
  
To Create an Item in the Master Item List from an Asset in the Inventory Module: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the Inventory grid, double-click any Asset. 
3. Select the Tracked Items tab on the left pane, then click the Add button. 
4. Click the New button on the Master Item Listing dialog. 

The Master Item dialog displays. 
5. Enter a description for the Item in the Product Description field (required). 
6. Follow steps 4-5 above. 
7. Click the Save button. 

  
Deleting Items from the Master Item List 
  
You can delete items from the Master Item list via the Administration Console. 
To Delete an Item from the Master Item List (Administration Console): 

1. Follow the steps above to access the Master Item List from the Administration Console. 
2. Select the item and click the Delete button. 
3. Click Yes when the confirmation message displays. 

   
See also:  Viewing Information in Grids in the Technician's Guide. 
  
Next topic:  Storing Items in the Unassigned Equipment Asset 

Storing Items in the Unassigned Equipment List 

You can store inventory items in a specially-designated asset in BMC Track-It! (called Unassigned 
Equipment) which serves as a container until you're ready to associate them with an asset or assets. 
  This can include hardware, software, or any type of item.  You can also transfer items and promote them 
to assets. 
  
Notes:   
  

• The Unassigned Equipment asset record cannot be deleted.  (However, items associated with 
Unassigned Equipment can be deleted from the Tracked Items tab associated with the particular 
asset). 

  
• Supplies is a special Product Type that is handled different from all other product types.  If you 

receive an item of the Supplies type, that item will not be sent to Unassigned Equipment in the 
Inventory module.  The reason for this is to avoid a scenario such as ordering 500 boxes of 
staples, and having each box of staples appear as a separate entry in Unassigned Equipment. 
 See also Receiving Purchased Items into Inventory and Transferring Items to and from the 
Unassigned Equipment List. 

To View the Unassigned Equipment List: 
1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. Select All Assets from the Current View/System Views menu. 
3. Expand the Type: Storage list in the Inventory grid. 
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4. Double click the Unassigned Equipment asset. 
 
The list of inventoried items that are not currently assigned to any asset displays on the Tracked 
Items tab. 

  
See Also:  Transferring Items to and from Unassigned Equipment 
  
  
  
  

Transferring Items to and from the Unassigned Equipment List 

You can transfer inventoried Items to and from the Unassigned Equipment  list so that you can keep 
Items all in one location until you're ready to associate them with a particular asset (such as a computer). 
 When you receive an Item in the Purchase Order module, you can select to  transfer the Item to the 
Unassigned Equipment list.  Then you can transfer the Item to the particular asset for which it was 
purchased (such as a monitor or other equipment). 
  
Notes:   
  

• You cannot delete the asset designated as Unassigned Equipment. 
  

• Supplies is a special Product Type that is handled different from all other product types.  If you 
receive an item of the Supplies type, that item will not be sent to Unassigned Equipment in the 
Inventory module.  The reason for this is to avoid a scenario such as ordering 500 boxes of 
staples, and having each box of staples appear as a separate entry in Unassigned Equipment. 
 See also Receiving Purchased Items into Inventory and Storing Items in the Unassigned 
Equipment List. 

  
To View the Unassigned Equipment List: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. Select All Assets from the Current View/System Views menu. 
3. Expand the Type: Other list in the Inventory grid (this is beneath the Type: Computer list). 
4. Double click the Unassigned Equipment asset. 
5. Select the Tracked Items tab on the Other Unassigned Equipment window. 

 
The list of inventoried items that are not currently assigned to any asset displays on the Tracked 
Items tab. 

To Transfer an Item to the Unassigned Equipment List: 
Normally when Items are received with Purchase Orders, they are transferred to the Unassigned 
Equipment list (this option can be selected by the person receiving the items.  So you'll only need to 
manually transfer an Item if you want to associate it with a different asset. 
  

1. Select the Item associated to the asset in the asset's Tracked Items list (Tracked Items tab). 
 (See also Viewing and Editing Assets). 

2. Click the Transfer button on the Tracked Items tab. 
3. Select Transfer to Unassigned Equipment. 
4. Click the Save button. 

The Item displays on the Tracked Items tab of in the Unassigned Equipment list. 
  
To Transfer an Item from the Unassigned Equipment List to an Asset: 

1. Open the Item in the Unassigned Equipment asset (on the Tracked Items tab). 
2. Select the Item, then click the Transfer button on the Tracked Items tab. 

The Transfer Tracked Item dialog displays. 
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3. Enter a search term in the Search for text box (the first four characters of any value) for the 
following Asset fields: 

 Asset ID 
 Asset Type 
 User Department 
 User Department Number 
 User Location 
 User Name 

4. Click the Search button. 
The search results display the assets with your search criteria.  You can customize the grid to 
view more columns.  (See also Creating User-defined Views). 

5. Select the asset to receive the Item on the Transfer Tracked Item dialog, then click the Transfer 
button. 
The Transfer Tracked Item dialog closes.   

6. Click the Save button on the Asset window. 
The Item is transferred and displays on the Tracked Items tab of the Asset. 

  
Next Topic 
Transferring Items Between Assets 

Transferring Items Between Assets 

You can transfer Items between Assets.  This is useful, for example, when hardware or software is 
uninstalled on one computer and installed on another. 
To Transfer Items Between Assets: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the Inventory grid, double-click the Asset with the Item you want to transfer. 
3. Select the Tracked Items tab on the left pane. 
4. Select the Item to transfer to another asset, then click the Transfer button. 
5. From the Transfer Tracked Item dialog, locate the asset that will receive the Item by entering a 

search term in the Search for text box (the first four characters of any value) for the following 
Asset fields: 

 Asset ID 
 Asset Type 
 User Department 
 User Department Number 
 User Location 
 User Name 

6. Click the Search button. 
The search results display the assets with your search criteria.  You can customize the grid to 
view more columns.  (See also Creating User-defined Views). 

7. Select the asset to receive the Item, then click the Transfer button. 
The Transfer Tracked Item dialog closes.   

8. Click the Save button on the Asset window (this is the Asset from which the Item will be 
transferred). 
The Item is transferred and displays on the Tracked Items tab of the Asset receiving the Item. 

  
See also:  Transferring Items to and from the Unassigned Equipment List 
  
Next Topic: 
  
Promoting Items to Assets 

Manually Associating an Asset's Software with a Software Title 
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If you are using the Software License Management module, you can manually associate an asset's 
software with a software title.  This may useful if a certain software has add-on components that you want 
to track. 
  
To Manually Associate an Asset's Software with a Software Title: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the Inventory grid, double-click the Asset with the Item software you want to associate with a 

software title. 
3. On the Software tab of the Asset window, select the Programs or Files tab. 
4. Select the program or file, then click the Associate button. 
5. On the Title Listing dialog, select the title to associate with the software, then click the Select 

button. 
6. Click the Save button on the Asset window. 

The Installed Program window now displays the associated Software Title with the Program 
Name.  (To view the Installed Program window, double click the software from the Program tab 
on the Software tab of the Asset window). 

  
  
  
  
  

Promoting Items to Assets 

You can promote an Item to an Asset so that you can track it on the Inventory grid and so that it is 
included in reports as a separate asset.  This is useful for tracking Items that you don't want to associate 
with an Asset, such as a projector in a conference room.  You can promote Items to assets from the 
Unassigned Equipment list, or from Items associated with an asset. 
To Promote an Item to an Asset: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the Inventory grid, double-click the Asset (or the Unassigned Equipment asset). 
3. Select the Tracked Items tab on the left pane. 
4. Select the Item to promote to an asset, then click the Promote button. 
5. From the Select Asset Type dialog, select the type of asset to create from the Item (such as 

Hub, Router, or Other), then click the OK button.  (See Selecting and Changing Asset Types). 
6. You can add details to the new asset on the Asset window that displays. 

If the Item was associated with an Asset, it is removed from the Asset's Tracked Items list, and 
displays on the Inventory grid. 

7. From the Asset dialog, select Save and Close from the Save button's drop-down list. 
The promoted Item now displays as an Asset on the Inventory grid.  (You may need to search or 
filter the list to locate it). 

   
   
   

Auditing Assets 
Auditing Assets (Overview) 
  
After discovering and managing your IT assets, BMC Track-It! can continually audit the network and 
update inventory information.   
  
There are three ways to audit your network: 
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• Scheduled Audits 
• Audit on Demand 
• Separately running the audit.exe application and the Merge Now feature 

  
BMC Track-It! automatically merges audit results when you set up scheduled audits or audit workstations 
on demand.  (The merge process adds new workstations to the Inventory module and updates 
workstations with the most recent audit data).   
  
 If you run the audit.exe program separately, you'll have to merge audit results with the Merge Now 
feature. 
  
Caution:  Before performing any audits on computers created from a Ghost image (cloned), be sure to 
remove the Trackitaudit.id file from the root of the C:, if it exists. (The file is hidden on the root of C: by 
default).  If the file is not removed and multiple machines have the same Trackitaudit.id file, the audits will 
continuously merge into a single record in Inventory.  For details, see our KnowledgeBase article "Track-
It! 6.x, 7, 8.x, and 9 Audit Merge Process" 
  
Note:  Your BMC Track-It! Administrator configures asset auditing in the Administration Console and can 
customize the auditing process, including what, when and how BMC Track-It! will audit.    
  
Next Topic:  Auditing Assets (Workflow) 
Auditing Assets (Workflow) 
The flowchart below represents the tasks in the following topics.   
  
Caution:  Before performing any audits on computers created from a Ghost image (cloned), be sure to 
remove the Trackitaudit.id file from the root of the C:, if it exists. (The file is hidden on the root of C: by 
default).  If the file is not removed and multiple machines have the same Trackitaudit.id file, the audits will 
continuously merge into a single record in Inventory.  For details, see our KnowledgeBase article "Track-
It! 6.x, 7, 8.x, and 9 Audit Merge Process" 
  
  

 
Getting up and Running with Auditing Assets 
Caution:  Before performing any audits on computers created from a Ghost image (cloned), be sure to 
remove the Trackitaudit.id file from the root of the C:, if it exists. (The file is hidden on the root of C: by 
default).  If the file is not removed and multiple machines have the same Trackitaudit.id file, the audits will 

http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
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continuously merge into a single record in Inventory.  For details, see our KnowledgeBase article "Track-
It! 6.x, 7, 8.x, and 9 Audit Merge Process" 
  

TASK MODULE/WINDOW HELP TOPIC 
1. Audit networked computers on 

demand, OR 
Tools/Audit Workstations 
(from the Inventory module) 

Auditing Assets on 
Demand 
  
  

2. Audit standalone computers with 
the  audit.exe application and 
audit merge 

  

\\Program Files\BMC 
Software\Track-It!\Track-
It! Server) where BMC 
Track-It! is installed and 
double click audit.exe 
  

Running the audit.exe 
application and merging 
audit results 

3. View audit results 
  

    

a. View software audit results Tools/Administration 
Console/ 
Lookup Tables/ Installed 
Programs or Installed 
Files 

Viewing Software Audit 
Results 
  

• View all assets with a 
specific program or file 

Inventory module/grid 
view/select 
computer/Software 
tab/Programs or Files 
tab. 
Right click the Program 
or File, then select Show 
Assets with Program or 
Show Assets with File. 

Viewing All Assets with a 
Specific Program or File 

• Change the audited 
software approval status 

Inventory module/grid 
view/select 
computer/Software 
tab/Programs or Files 
tab. 
Right click the Program 
or File, then select 
Change State to... 

Changing the Audited 
Software Approval Status 

• View captured file 
information 

Inventory module/grid 
view/select computer/File 
Information tab/Captured 
File drop-down 
  

Viewing Captured File 
Information 

b. View hardware audit results Inventory module/grid 
view/select 
computer/Hardware tab/ 

Viewing Hardware Audit 
Results 
  

  
Next Topic:  Auditing Assets on Demand 
Auditing Assets on Demand 
After discovering and managing your assets, you can audit your computers for detailed information such 
as hardware, software and files.   
  

http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
http://support.numarasoftware.com/support/view_article.asp?ArticleID=849


BMC Track-It! 11 Web 

 © Copyright 1989 - 2012 Numara Software, Inc.  BMC Software, the BMC logos, and other BMC marks are trademarks or registered trademarks of BMC Software, Inc. in the 
U.S. and/or certain other countries. Track-It! is the property of Numara Software, Inc. and is registered with the U.S. Patent and Trademark Office, and may be registered or 

pending registration in other countries. Numara Software and BMC Software Confidential. 

39 

The audit process automatically updates inventory information for each computer on the Hardware and 
Software tabs on the Asset window.  The process also automatically updates  the Tracked Items list for 
the computer with basic hardware and software information. 
  
See also:   Viewing Software Audit Results, Viewing Hardware Audit Results, and Viewing Tracked Items 
for an Asset. 
  
Audit Results for all computers are displayed on the Installed Programs and Installed Files lists in the 
Administration Console  (see Viewing Software Audit Results). 
  
Caution:  Before performing any audits on computers created from a Ghost image (cloned), be sure to 
remove the Trackitaudit.id file from the root of the C:, if it exists. (The file is hidden on the root of C: by 
default).  If the file is not removed and multiple machines have the same Trackitaudit.id file, the audits will 
continuously merge into a single record in Inventory.  For details, see our KnowledgeBase article "Track-
It! 6.x, 7, 8.x, and 9 Audit Merge Process" 
  
Note:  Your BMC Track-It! Administrator configures asset auditing in the Administration Console and can 
customize the auditing process, including what, when and how BMC Track-It! will audit, including 
scheduled audits (see Configuring Scheduled Audits in the Administrator's Guide).    
To Audit Assets on Demand: 

1. Select the  Inventory module from the Navigation Pane. 
2. Select the assets you want to audit from the Inventory grid. 

 
You can select multiple assets by holding the Ctrl key while selecting them.  Hold the Shift key to 
select multiple assets in sequential order. 

  
3. Select Audit Workstations from the Tasks pane, the Audit Workstations icon on the Toolbar, 

or the Tools menu.  You can also right click and select Audit Now. 
 
When you run an audit, either on demand or through scheduled audits, BMC Track-It! Agent is 
installed on the client's computer.  Depending on Administration settings, the Agent icon displays 
on the end user's task bar. 
 
The Audit Workstation dialog displays the audit status for each asset (such as Waiting, 
Requested, or Succeeded). 

  
The audit process will run in the background, so you can minimize or close the Audit 
Workstation dialog if you choose.   The audit process is completed when  the Status column 
displays a check mark and "Succeeded"  displays next to the asset in there Audit Queue 
Status Name column. 
  

4. Click the Close button to return to the Inventory grid. 
  
To help on viewing audit results, click the links above. 
  
See also:  Configuring Scheduled Audits 
  
  
Including and Excluding Computers from Scheduled Audits 
  
You can exclude specific computers from scheduled audits (such as servers, for example).  Computers 
must be selected in the Inventory grid before the scheduled audit is run. 
Scheduled Audits are configured by your BMC Track-It! Administrator (see Configuring Scheduled Audits 
in the Administrator's Guide). 
  

http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
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Caution:  Before performing any audits on computers created from a Ghost image (cloned), be sure to 
remove the Trackitaudit.id file from the root of the C:, if it exists. (The file is hidden on the root of C: by 
default).  If the file is not removed and multiple machines have the same Trackitaudit.id file, the audits will 
continuously merge into a single record in Inventory.  For details, see our KnowledgeBase article "Track-
It! 6.x, 7, 8.x, and 9 Audit Merge Process" 
To Exclude Computers from Scheduled Audits: 
By default, computers are included in Scheduled Audits.  Only computers can be excluded from 
Scheduled Audits (not printers or other assets). 
  

1. Right click to select the computer(s) in the Inventory grid (you can select multiple computers). 
2. If you've selected a single computer, select Include in Scheduled Operations from the context 

menu.  For multiple selections, select Exclude from Scheduled Audit Operations in the context 
menu. 

  
Note:  If you select an asset that is not a computer, the Results dialog will display with an 
Outcome of "Failed".  Close the dialog, then deselect the asset. 
  
The Included in Scheduled Audits column in the Inventory grid displays an icon for all 
computers with scheduled audits (and no icon for excluded computers).  The Hardware tab of 
the Asset detail window displays a checkbox:  Include this Asset in Scheduled Audit 
Operations, which is checked by default unless the computers has been excluded. 
  

Related Topics:  Configuring Scheduled Audits in the Administrator's Guide. 
  
  
Running the Audit.exe Application and Merging Audit Results 
  
If necessary, you can run Track-It's audit.exe application separately.  (You may want to run this instead of 
scheduled audits or auditing workstations on demand through the Technician Client for auditing 
standalone computers).  If you run audit.exe, the BMC Track-It! Audit wizard will guide you through the 
process.  However, you'll also have to merge audit results with the Merge Now feature.  (The merge 
process adds new workstations to the Inventory module and updates workstations with the most recent 
audit data). 
  
Caution:  Before performing any audits on computers created from a Ghost image (cloned), be sure to 
remove the Trackitaudit.id file from the root of the C:, if it exists. (The file is hidden on the root of C: by 
default).  If the file is not removed and multiple machines have the same Trackitaudit.id file, the audits will 
continuously merge into a single record in Inventory.  For details, see our KnowledgeBase article "Track-
It! 6.x, 7, 8.x, and 9 Audit Merge Process" 
  
Notes:   
  

 BMC Track-It! automatically merges audit results when you set up scheduled audits or audit 
workstations on demand.    

 Your BMC Track-It! Administrator configures asset auditing in the Administration Console and can 
customize the auditing process, including what, when and how BMC Track-It! will audit.  Audit 
results are dependent upon this configuration. 

To Run the audit.exe Application: 
1. Navigate to the BMC Track-It! Server (\\Program Files\BMC Software\Track-It!\Track-It! Server) 

where BMC Track-It! is installed. 
2. Double click audit.exe. 
3. Click Next when the "Welcome to BMC Track-It! Audit" dialog displays. 

 
The Audit in Progress dialog displays, along with a progress bar as software, hardware, and files 

http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
http://support.numarasoftware.com/support/view_article.asp?ArticleID=849
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are audited, and results are saved 
  

4. Click the Next button on the Audit in Progress dialog. 
 
The computer name is displayed for the computer being audited. 
  

5. Click the Next button when the hardware audit results are shown. 
6. Click the Next button when the software audit results are shown. 
7. Click the Finish button when the last dialog displays notifying you that the audit is successfully 

completed. 
  
To Merge Audit Data: 
You can merge audit data from either the Inventory module or the Administration Console. 
  
Note:  BMC Track-It! automatically merges audit results when you set up scheduled audits or audit 
workstations on demand.    
  

1. From the Inventory module, click Merge Audit Data from the Tools menu, or from the Tasks pane. 
2. From the Administration Console: 

a. From the main menu bar, select Tools/Administration 
Console/Configuration/Inventory/ Merging/Schedule. 

3. On the Schedule panel, click the Merge Now button. 
  

The Merge Status  dialog displays.   When the merge is complete, the dialog displays the 
number of merged files per computer. 

  
4. To view merge details, click the View Log button.   

  
See also:  Viewing Software Audit Results and Viewing Hardware Audit Results. 
  
  
  
Viewing Audit Results 

Software 

Viewing Software Audit Results 

  
The lists of audited software and related executable files (such as .exe) are displayed in the following 
locations: 
  

 the Software tab of a particular computer's record (in the Inventory module), and the 
 the Administration Console (Lookup Tables/(Administration) 

  
Note:  BMC Track-It! Administrators can configure how auditing results are displayed  in the 
Administration Console.  See the Inventory/Auditing chapter of the Administrator's Guide. 
Audit Results for All Computers 
Note:  You can also view a list of assets with a specific program or file from an individual asset record. 
 See Audit results for Individual Computers, below. 
To View All Audited Software on All Computers: 

1. Select Tools/Administration Console/Lookup Tables. 
2. Select Installed Programs or Installed Files. 
3. You can filter the audit results by selecting one of the following options from the View drop-down 

list: 
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 Unidentified 
 Approved - Supported 
 Permitted - Unsupported 
 Alerts - Prohibited 

  
See Also:  Changing the Audited Software Approval Status 
  
Audit Results for Individual Computers 
  
The Software  tab on the Computer window allows you to view the software audit results for a particular 
computer. 
To View an Individual Computer's Audited Software: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the grid view, double-click the computer to view the audit results. 

You can also open a computer record by selecting it and clicking Open Asset in the Tasks pane. 
 The Asset window displays (the window's title bar displays the asset type, such as Computer or 
Server). 

3. Select  the Software tab. 
4. Select the Programs or Files tabs to view the audited software and files. 
5. You can filter the audit results by selecting one of the following options from the View drop-down 

list: 
  

 Unidentified 
 Approved - Supported 
 Permitted - Unsupported 
 Alerts - Prohibited 

  
For more information on the categories above, see Changing the Audited Software Approval 
Status. 
  

6. Double click a Program or File to view details. 
The Installed Program or Installed File dialog displays information about the Publisher, Version, 
Software Title, and Number of Installations.  A list of all assets with the specific program or file is 
displayed. 

7. To view the assets, double click the asset in the grid. 

Viewing All Assets with a Specific Program or File 

While viewing software audit results for a specific computer, you can view all other computers with the 
same programs or files installed. 
To View All Assets with a Specific Program or File: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the grid view, double-click the computer to view the audit results. 

You can also open a computer record by selecting it and clicking Open Asset in the Tasks pane. 
 The Asset window displays (the window's title bar displays the asset type, such as Computer or 
Server). 

3. Select  the Software tab. 
4. Select the Programs or Files tab. 
5. Right click the Program or File, then select Show Assets with Program or Show Assets with 

File. 
The Assets with Program or Assets with File dialog displays the list of computers with the 
specific installed program or file. 
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Changing the Audited Software Approval Status 

  
The lists of audited software and related executable files (such as .exe) are displayed in the following locations: 
  

 the Software tab of a particular computer's record (in the Inventory module), and the 
 the Administration Console (Lookup Tables) 

  
By default, all new software and executable files found during an audit display in the Unidentified 
software list.  You can then review the new software and categorize each application into one of the 
following approval states: 
  

Audited Software 
Status 

Description 

Unidentified New software found during an audit 
and not yet categorized by a 
Technician or Administrator 

Approved - Supported Software found during an audit that has 
been designated as approved by a 
Technician or Administrator and is 
supported by the Help Desk staff. 

Permitted - 
Unsupported 

Software found during an audit that has 
been designated as permitted by a 
Technician or Administrator, but is not 
supported by the Help Desk staff. 

Alerts - Prohibited Software found during an audit that has 
been designated as prohibited by a 
Technician or Administrator, and 
should be uninstalled from the 
computer. 

  
The advantage of categorizing the Unidentified software is so that you can immediately identify new 
software found during audits, since it will automatically display in the Unidentified list.   
To Change the Audited Software's Status: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the grid view, double-click the computer to view the audit results. 

You can also open a computer record by selecting it and clicking Open Asset in the Tasks pane. 
 The Asset window displays (the window's title bar displays the asset type, such as Computer or 
Server). 

3. Select  the Software tab. 
4. Select the Programs or Files tabs to view the audited software and files. 
5. Select an option from the View drop-down list (such as Unidentified). 
6. Select the software application or applications, then select an option (such as Change State to 

Approved - Supported) from the Change button. 
You can also right click to change the states.  The software is moved to the new status list. 

7. Click the Save button. 
  
When the next audit is performed, new software will display in the Unidentified list.   

Viewing Captured File Information 
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Your BMC Track-It! Administrator can configure the audit process to automatically capture file Information 
(such as the computer's start-up files -- autoexec.bat, win.ini, etc.).  It can also run executable commands 
and capture the output.  (See Configuring Auditing to Capture Specific Files and Run Commands in the 
Administrator's Guide.) 
To View Captured File Information: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the grid view, double-click the computer to view the audit results. 

You can also open a computer record by selecting it and clicking Open Asset in the Tasks pane. 
 The Asset window displays (the window's title bar displays the asset type, such as Computer or 
Server). 

3. Select  the File Information tab. 
4. Select the file from the Captured File drop-down list. 

The captured files details display. 
  
  

Hardware 

  

Viewing Hardware Audit Results 

The Hardware tab on the Asset window enables you to view the hardware audit results for a computer 
and its peripherals by audit date and time.  The list of audited hardware is provided along with specific 
details and audit status, as shown below.  You can view filtered lists (System Views) and create your own 
customized views (private or shared). 
  
You can edit hardware attributes (in order to provide more details or change information).   However, if 
you edit an attribute, it will not be updated during future audits (you can then select to resume updates). 
  
  

Components Details 
(Partial 
Listing) 
  

Audit Date Audit 
Status 
  

Views 

Computer Name, 
model 
number, 
service 
tag 
number, 
etc. 

Snapshot 
of 
hardware 
Information 
is 
displayed 
per audit 
date and 
time 

 C 
(Change
d) 

 A 
(Added), 
or 

 R 
(Remove
d since 
previous 
audit) 

 M 
(Manuall
y 
changed 
- not 
updated 
during 

  
 System Views 

 Computer 
Configuration 

 Computer 
Availability 

 Computer 
Information 

 Networking 
Information 

  
 Customized Views 

 Private 
 Shared 

  
  
  
  

CPU Serial 
number, 
processor, 
 etc. 
  

Operating 
System 

Version, 
service 
pack #, 
product 
ID, etc. 
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Memory   audits)   

Memory 
Devices 

Used and 
unused 
memory 
modules: 
 device 
locator, 
e.g., 
DIMM_1, 
quantity, 
e.g. 2.00 
GB, serial 
number, 
part 
number, 
etc. 

Drive   
Network NIC, IP 

address, 
MAC 
address, 
etc. 
  

Monitor   

Keyboard   

Printer Local and 
networked 
printers 

Video Card   

Physical Drive   

Audited Hardware Information by Computer 
  
 To View Hardware Audit Results: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the grid view, double-click the computer. 

You can also open a computer record by selecting it and clicking Open Asset in the Tasks pane. 
 The Asset window displays (the window's title bar displays the asset type, such as Computer or 
Server). 

3. Select  the Hardware tab. 
4. Click the + button next to the component (such as Network) to view details.  Click the --  button to 

collapse the list. 
5. To view audit results by date, select the date and time from the Audit Date drop-down list. 
6. Select a view from the View list:  click the Ellipses button (...), then select a view from System 

Views or Shared Views. 
  

See also:  Customizing Hardware Audit Result Views 
To Edit Hardware Attributes: 
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1. Enter your changes in the desired field. 
2. The Change Attribute confirmation message displays.  Click Yes to accept the changes. 

The audit status displays as described in the table above. 
To Resume Updating Attributes If They Have Been Manually Entered: 

1. Select the attribute, then select Resume Updates. 
The audit process will overwrite the manually entered values. 

  
See also:  Purging Audit History 
  
  
  

Purging Audit History 

If you perform audits of your computer systems on a regular basis or have owned Track-It! for many 
years, you may accumulate hardware data that eventually becomes outdated and of little use. This results 
in a larger database size and larger backups. This hardware audit data can be purged from the system to 
clear out old outdated information about your computer assets. When purging the audit history from a 
computer, Track-It! will remove all audit history results from the system and leave only the most recent 
audit entry for that system. 
To Purge Audit History 

1. On the Inventory grid, select the computer or computers for which you want to purge the audit 
history. 

2. Select the Purge Audit History option from the Tasks pane. 
3. On the Purge Audit History dialog, select one of the following: 

a. Purge audit history for the currently selected assets 
b. Purge audit history for all assets in the current grid view 
c. Purge audit history for all assets in the Inventory 

4. Click OK. 
5. The Purge Audit History Confirmation dialog describes the specific audit history that will be 

purged.   
 
Caution:  Audit history data will be purged based on your selection.  
 
Click Yes to accept or No to cancel. 

6. If you selected Yes to purge the audit data, the Purge Audit History message informs you that 
the data will be purged and will run in the background.   
In the meantime, you can continue to use the system. 

a. (Optional) To view the Purge Audit History status, click View Log.   
This opens the Configuration > Inventory > Asset Monitor > Automated Schedule 
panel in the Administration Console.  
Click OK to return to the Inventory grid 
OR 

b. Click OK to return to the Inventory grid. 

Customizing Hardware Audit Result Views 

  
You can create your own customized views (private or shared) of hardware audit results. 
To Customize Hardware Audit Results Views: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the grid view, double-click the computer. 

You can also open a computer record by selecting it and clicking Open Asset in the Tasks pane. 
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 The Asset window displays (the window's title bar displays the asset type, such as Computer or 
Server). 

3. Select  the Hardware tab. 
4. Click the Ellipses button (...) next to the View drop-down list. 
5. Right click and select Edit current view. 
6. On the Hardware Attribute View Configuration dialog, enter a name for the customized view. 
7. Select an option from the View Type drop-down list (Public or Private). 
8. Click the + button next to the component (such as Network) to view details.   
9. Click the checkbox next to the attribute you want to view. 

You can also click the Select All or Clear All buttons. 
10. Click the OK button. 
11. The customized view displays on the Hardware tab. 

Tracking Items 
Tracking Items for an Asset (Overview) 
  
Track-It enables you to maintain a customizable Tracked Items list of items that are installed on, 
purchased for, or located with a specific asset.  (The list is displayed on the Tracked Items tab of the 
Asset window in the Inventory module).  This list is useful because you can create your own list on the 
Tracked Items tab separate from the items on the Hardware and Software tabs, which might contain 
hundreds of items, as a result of the auditing process. 
  
See the related topics in this chapter accessed from the workflow diagram (see Tracking Items Workflow). 
  
Next Topic:  Tracking Items for an Asset (Workflow) 
  
Tracking Items for an Asset (Workflow) 
  
The flowchart below represents the tasks in the following topics.   
  

 
  
Next Topic:  How Items Get to an Asset's Tracked Items List 
How Items Get to an Asset's Tracked Items List 
  
The Tracked Items list for each asset, e.g., computer, is populated by the following processes: 
  

 Auditing 
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 In addition to displaying audit results on the Hardware and Software tabs on the Asset 
window, the audit process automatically updates the Tracked Items list for the computer 
with the following hardware and software information: 

 Hardware 
 Computer's make, model, service tag and manufacturer 

 Software 
 Operating system's version, serial number, and service pack level 
 Registered software (from the ProductID and DisplayName keys in the 

Uninstall key in the registry) 
 Purchasing 

 An item on a  purchase order is received in Unassigned Equipment, then transferred to a 
computer 

 Transferred from another computer 
 Manually added (hardware items only) 

  
Viewing Tracked Items for an Asset 
  
The Tracked Items list is a customizable list of items that are installed on, purchased for, or located with a 
specific asset.  (The list is displayed on the Tracked Items tab of the Asset window in the Inventory 
module).  See also How Items Get to the Tracked Items List and other topics in the Tracking Items 
chapter. 
 To View Tracked Items: 

1. Select Inventory from the Navigation Pane. 
2. In the grid view, double-click the asset. 
3. On the Asset window (usually Computer or Server), select the Tracked Items tab. 

  
 The following information automatically displays from the auditing process: 
 Hardware 

 Computer's make, model, service tag and manufacturer 
 Software 

 Operating system's version, serial number, and service pack level 
 Registered software (from the ProductID and DisplayName keys in the Uninstall 

key in the registry) 
  
See also:  Showing and Hiding Columns in Creating User-defined Views. 
  
Next Topic:  Transferring an Asset's Hardware Items to the Tracked Items List 
  
  
  
  
Transferring an Asset's Hardware Items to the Tracked Items List 
  
Certain installed hardware items automatically display on a computer's Tracked Items list from the 
auditing process, specifically the computer's make, model, service tag and manufacturer. 
  
Once you add the items to the Tracked Items list, you can also add details on the Tracked Item dialog 
(see the table below).  Some of this information is pre-populated from the auditing process, purchase 
orders, and information manually entered if the tracked item was transferred from another computer. 
  
To Transfer an Asset's Hardware Items to the Tracked Items List: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the grid view, double-click the computer. 
3. To add hardware, select  the Hardware tab. 

(To view all items, click the + button next to the component, such as Computer). 
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4. Right click the item you want to add, then select Transfer to Tracked Items. 
5. On the Tracked Item dialog, you can add information in the fields below (if they are not already 

populated). 
6. When you are finished entering information, click the Save button. 

The item displays on the Tracked Item dialog. 
  

General 
  Product Description 
  Product Type 
  Serial Number 
  Manufacturer 
  Part number 
  Installed by 
  Date Installed 
  Comments 
Purchase and Lease 
  P.O. Number 
  Date Purchased 
  Vendor 
  Price 
  Lease Number 
  Lease Expiration Date 
  Lease Vendor 
  Lease Price 
Maintenance and Warranty 
  Maintenance Expiration date 
  Maintenance Vendor 
  Reference Number 
  Maintenance Cost 
  Warranty Expiration Date 
User Defined Fields 
  Custom Decimal #1 (decimals can be entered) 
  Custom Integer #1 (only whole numbers can be 

entered) 
  Custom Date #1 
  Custom Date #2 
  Custom Text #1 
  Custom Text #2 

Tracked Item Dialog -- Item Details 
  
Next Topic:  Manually Adding an item to an Asset's Tracked Items List 
Manually Adding Non-networked Items to an Asset's Tracked Items List 
  
You may have items in physical inventory that are not connected to a network, but you'd like to track them 
along with a specific asset.  Once the items are created on the Master Items list, you can manually add 
them from the Asset window in the Inventory module. 
To Manually Add an Item to an Asset's Tracked Items List: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the Inventory grid, double-click any Asset. 
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3. Select the Tracked Items tab on the left pane, then click the Add button. 
4. Double click the item from the Master Item Listing dialog (or select it, then click the Select 

button). 
The item displays on the asset's Tracked Items tab. 

5. On the Tracked Item dialog, you can add information in the fields below (if they are not already 
populated). 

6. When you are finished entering information, click the Save button. 
The item displays on the Tracked Item dialog. 

  
Next Topic: Deleting Items from an Asset's Tracked Items List 
  
Deleting Items from an Asset's Tracked Items List 
  
Deleting an item from the Tracked Items list does not delete it from Inventory -- it only deletes it from the 
Tracked Items tab of the asset (computer).  If the item is installed on the specific computer, upon 
subsequent audits it might re-display in the Tracked Items list, especially if you permanently delete it from 
the list.  (This depends on the type of item -- see How Items Get to the Tracked Items List).  See step 7 
below to permanently deleted the item from Inventory. 
  
If you want to continue tracking the item, but not on the selected computer, before you delete the item 
from the Tracked Items list, you might want to consider transferring it to another computer or to 
Unassigned Equipment (see Storing Items in the Unassigned Equipment List.) 
  
To Delete an Item from the Tracked Items List: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. In the grid view, double-click the computer. 
3. On the Asset window (usually Computer or Server), select the Tracked Items tab. 
4. On the Tracked Item dialog, select the item to delete, then press the Delete key (or right click 

and select Delete). 
5. Click Yes on the Delete Tracked Item confirmation dialog. 

The item is removed from the Tracked Item list. 
6. Click the Save button on the Asset window. 

To Restore an Item to the Tracked Items List: 
1. Right click anywhere in the Tracked Items list, then select View deleted tracked items. 
2. On the Deleted Tracked Items dialog, select the item to restore, then click the Restore button. 

The item is restored to the Tracked Item list. 
3. Click the Close button. 
4. Click the Save button on the Asset window. 

To Permanently Delete an Item from Inventory: 
1. Follow the steps above in "To Delete the Tracked Item from the Tracked Items List". 
2. Right click anywhere in the Tracked Items list, then select View deleted tracked items. 
3. On the Deleted Tracked Items dialog, select the item to delete, then click the Delete button. 
4. Click Yes on the Delete Tracked Item confirmation dialog. 

The item is permanently removed from Inventory. 
5. Click the Close button. 
6. Click the Save button on the Asset window. 

  
  
  

Taking Control of a User's Computer 
You can diagnose and resolve a user's problem from a remote location from the Take Control button on 
the Inventory module Tasks pane or from a Work Order with an assigned computer in the Help Desk 
module.  During a remote control session, a technician can do anything (in real-time) at the remote 
computer that the user can do.   
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Important Notes: 

 In order for the Remote Control components to install when taking control of the host computers: 
 File and Printer sharing must be enabled on the host computers 
 Credentials of a user that is a local administrator on all remote machines (usually a 

domain administrator) must be entered in the Administration Console under Configuration 
>Inventory > Auditing > Setup Credentials. 

 By default, the BMC Remote solution does not have access security policies enabled preventing 
an unauthorized BMC Track-It! technician from remote controlling a PC running the Host module. 
  Please see the security guide in the BMC Remote Control 9.5 User's Guide, available in PDF 
format on our Support Web page, for a complete and comprehensive list of options when 
configuring the appropriate level of end- to- end access. 

  
Notes:   

• BMC  Remote is available as an add-on to BMC Track-It!. 
• For detailed instructions, please see the BMC Remote Control 9.5 User's Guide, available in PDF 

format on our Support Web page. 
  
Using BMC Track-It! Remote, technicians can: 
  

• Control Windows client computers 
• Reboot client computers 
• Execute programs 
• Chat with users 
• Transfer files to and from remote computers 
• View remote control status histories 
• Configure the remote control window 
• Set remote control security on remote computers 
• Troubleshoot problems via a remote control session 

To Take Control of a User's Computer: 
From the Inventory Module 
  

1. Select the user's computer on the Inventory grid of the Inventory module. 
2. Click the Take Control link on the Tasks pane. 

The BMC Remote Host application is installed on the user's computer.  The user's screen 
displays on your monitor. 

3. For help with remote control, right click the remote control icon on your Windows system tray. 
 Select Help from the menu bar of the remote control application. 

  
From the Help Desk Module 
  

1. From a Work Order in the Help Desk module, make sure the computer displays in the Asset 
field. 

2. From the Actions menu on the Work Order, select Take Control (or click the Take Control icon 
on the toolbar). 

3. See step 3, above. 

Retiring Assets 
Retiring Assets 
If you no longer need to audit an asset, but still want it to remain in Inventory, you can retire it.  Retiring 
an asset frees up a BMC Track-It! licenses for audits, remote control, and software license management. 
 If you're using the Bar Code add-on, it also removes the asset from any barcode scans.  Retiring an 
asset also disassociates any assets with users.  Retired Assets can be viewed from the Retired Assets 
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from on the Inventory grid, and on the Retired Assets report.  (They no longer appear in any other lists or 
reports.) 
  
When you retire an asset, you can also decide whether to transfer any of its tracked items to Unassigned 
Equipment.  You may want to do this if you are tracking a particular item, such as a printer or software, so 
you can reassign it to another asset from the Unassigned Equipment list. 
  
Note:  Retired an asset is irreversible.  Once an asset is retired, in order to audit it, you would have to add 
it back to inventory via asset discovery or manually adding the asset. (See Adding Assets to Inventory - 
Overview). 
  
Retired Assets will remain in the BMC Track-It! database until you're ready to delete them. 
To Retire an Asset: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
2. Right click the asset (or multiple assets at a time) from the Inventory grid and select Retire. 

(You can also retire an asset after opening the asset record.) 
If the asset has any tracked items, they display on the Retire Asset(s) dialog. 

3. If you want to transfer any of the tracked items to Unassigned Equipment when the asset is 
retired, select the checkbox for each Tracked Item.  (You can also click the Select All button to 
select all tracked items, or the Clear All button to deselect them.) 
 
Transferring the tracked items to "Unassigned Equipment" enables you to reassign them to 
another asset. 
Tracked items not transferred to "Unassigned Equipment" will be read-only. 
  

4. Verify the date and time you want to use to retire the asset from the Select Retire Date drop-down 
(this displays a calendar).   
 
By default, the current date and time are selected.  However, you can select a past or future date. 
 This information will display on the Retired Assets report. 
  

5. Click the OK button to retire the assets. 
 
A Retire Assets confirmation dialog displays confirming that you want to retire the asset or assets, 
and that this is not a reversible action. 
  

6. Click the Yes button when the confirmation message displays. 
 
The asset is removed from Inventory.   

7. To view a list of Retired Assets and the Retired Assets report, see Viewing Retired Assets. 
  
Next topic:  Viewing Retired Assets 
  
See also:  Tracking Items for an Asset (Overview), Storing Items in the Unassigned Equipment List, and 
Deleting Assets. 
  
  
Viewing Retired Assets 
  
You can view a list of Retired Assets and details from the Inventory module.  You can also view a Retired 
Asset report.  The list of Retire Assets is displayed in the Inventory grid (Inventory module) from the All 
Retired Assets view.  For detailed information on working with grid views, see Viewing Information in 
Grids). 
To View Retired Assets: 

1. If the Inventory module is not already open, select Inventory from the Navigation Pane. 
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2. Select System Views from the Current View menu at the top of the grid (or from the View menu 
in the Main Menu Bar), then select All Retired Assets. 
The Retired Assets display in the grid.    

3. To view read-only details, select the Retired Asset, then press the Enter key (or double-click the 
Asset). 
 
The Asset record opens. The retired date and time display on the window title (e.g., "Retired on 
7/31/2011 3:57:04 PM"). 
 
The Tracked Items tab displays any tracked items associated to the asset that were not 
transferred to Unassigned Equipment.  The Audit Trail tab displays the asset's history. 

Viewing the Retired Assets Report 

To View the Retired Assets Report: 
1. Select Reports from the Navigation Pane. 
2. Select the Inventory module from the Reports by Module drop-down list. 
3. Select the report: All Retired Assets by Date Retired. 
4. Select the All Retired Assets by Date Retired report, then press the Enter key (or double click 

the report). 
 
The report displays in the Crystal Reports XI viewer. 
The following information is displayed on the report: 

• Asset ID 
• Asset Name 
• Asset Type Name 
• Retired Date (the date selected by the Technician who retired the asset) 
• Retired by (Technician's name) 

  
For more information on viewing and printing reports, see Viewing Reports. 
  
  

  
  

Viewing and Printing Inventory Reports 
Note:   Technicians will only be able to view the report details for those they are privileged to view (based 
on Module, Location, Department, and Assigned Technician as set up by the BMC Track-It! 
Administrator).    
  
You can view and print the following Inventory Reports: 
  

• All Retired Assets by Date Retired 
• Asset Configurations by Department 
• Assets by Asset ID 
• Assets by Domain 
• Assets by IP Address 
• Assets by Operating System Build 
• Assets by Serial Number 
• Audit Changes 
• Audited Asset Configurations by Asset ID 
• Audited Assets 
• Audited Assets Ranked by CPU Speed 
• Audited Assets Ranked by CPU Speed 
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• Audited Assets Ranked by Installed RAM 
• Audited Assets Ranked by Installed RAM 
• Audited Components Listing 
• Audited Software by Asset ID 
• Audited Software by Manufacturer 
• Audited Software by Product 
• Company Bar Coded Assets by Location 
• Discovered Assets 
• Free Disk Space Warning 
• Installed Files Listing 
• Installed Network Printers 
• Listing of Equipment by Lease Expiration 
• Listing of Equipment by Maintenance Expiration 
• Listing of Equipment by Warranty Expiration 
• Listing of Equipment not Under Warranty/Maintenance 
• Software Counts by Application File Name 
• Tracked Combined Inventory Components 
• Tracked Inventory by Asset ID 
• Tracked Software by Product 
• Unassigned Equipment 
• Unidentified Software List by Asset ID 
• Workstations by Department 
• Workstations Not Ready for Windows Vista 
• Workstations Not Recommended for Windows Vista    

  
To View Inventory Reports: 

1. Select the Reports module from the Navigation pane. 
2. Select Inventory from the Reports by Module drop-down list above the Reports grid. 
3. Double click the report you want to view. 

  
See Also:   Reports Overview 

Managing Software Licenses 
Software License Management Module Overview 
The Software License Management module enables you to manage software license usage and 
compliance within your organization.   
  
Note:  The Software  license Management module integrates with the Inventory, Help Desk, and 
Purchasing modules, and requires initial configuration. 

Integration with the Inventory Module 

During the audit process, the Inventory and Software license Management modules are automatically 
updated with any software and files found on networked computers.    
  
Once computers are audited, the following information, as well as additional detailed information, is 
displayed in the Software License Management module: 
  

 Software Title 
 Description 
 Versions 
 Publisher 
 licenses 
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 Number of 
 Licenses Owned 
 Licenses Used 
 Active or Retired Licenses 
 Fully or Partially Assigned Licenses 

 Details on 
 Licensed or Unlicensed Usage (software title installed per Computer) 
 Upgraded and Renewed Licenses 

 Individual License Details 
 e.g. serial numbers, activation keys, and expiration dates 

  
Note:  Lookup Tables must be set up in the Administration Console for the above information to display. 

Integration with the Help Desk Module 

BMC Track-It! can also automatically create Work Orders when software license conditions change.  This 
includes unauthorized installations, license expiration, pending expirations, over-utilizations licenses, and 
other conditions.  Track-It Administrators can set up the work order generation in the Administration 
Console (see Generating Work Orders When Software License Conditions Change in the Administrator's 
Guide). 

Integration with the Purchasing Module 

When purchase orders for software are created and entered in the Purchasing module, BMC Track-It! 
automatically populates the Software License Management module with the names and number of 
licenses purchased.   
  
Next Topic:  Software License Management Workflow (Administrator's Guide) or Software License 
Management Workflow (Technician's Guide) 
Software License Management Workflow (Technician) 
  
The flowchart below represents the tasks in the following topics.   
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Follow the steps below to manage your software licenses: 
  
1.  Create the Software Title 

 Create the software title in the Software License Management module. 
  

2.  Associate the Software Title with an Item on the Master Items List 
 The association automatically creates licenses for the software title when you purchase and 

receive the software item and record the details in the Purchasing module.   
  

3.  Discover Your IT Assets 
 We recommend that you first discover your assets using Track-It's Asset Discovery process. 

 Once the assets are discovered, you can transfer the computers to Inventory.   
  

4.  Audit Your Network 
After discovering your assets, you'll need to audit the workstations to update and view 
software programs and files installed on the networked computers.  You can audit the 
computers via Audit on Demand, Scheduled Audits and Auditing Standalone Workstations.   
1.  
 Audit on Demand and Scheduled Audits automatically merge and update the inventory 

information.  If you audit standalone workstations, you'll need to manually merge the 
information so that your inventory information is updated.   

 If you are not using Scheduled Audits, you should audit your workstations on a regular 
basis to ensure that you have the most updated information.   
  

5.  Associate Audited Software (Programs and Files) with Software Titles 
Associate the audited programs or files with a software title (such as Microsoft Word with 
Microsoft Office Professional).  
  

6.  Assign Licenses to a Computer 
 The Assets tab of the Software Title window displays a list of all of the computers with the 

installed software.  You can select the appropriate software license from the list (from information 
entered when the software title was created, such as the serial number). 
  

7.  Other Licensing Tasks 
Once a software title is licensed, you can perform the following licensing tasks: 

 Revoke licenses (remove the license from the computer) 
 Retire licenses 
 Upgrade licenses 
 Renew licenses 

  
8.  View Software License Reports 

You can view and print the following Software reports: 
1.  
 Expiring License Details 
 License History for Title 
 Software Title Details 
 Software Title Summary 
 Unauthorized Titles by Asset ID 

  
Next Topic:  Creating Software Titles 
Creating Software Titles and Maintaining Licensing Information 

Creating Software Titles 
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A software title uniquely identifies software owned by your organization -- for example, Microsoft Office 
2003 and Microsoft Office 2007.  Once you discover and audit your IT assets, the list of audited software 
per computer will display in the Software License Management module, as well the Inventory module. 
  
Note:   After you create the Software Title, you should associate it with an item in the Master Items list. 
 This  automates the process of purchasing and tracking software licenses.  The association automatically 
creates licenses for the software title when you purchase and receive the software item and record the 
details in the Purchasing module.  See Associating Software Titles with Master Items. 
To Create a Software Title: 

1. Select the Software Licensing Management module from the left pane of the BMC Track-It! 
Technician Client window. 

2. Select New Title from the Tasks pane. 
3. On the Software Title window, enter the Title Name (such as BMC Track-It!) and select or enter 

the Publisher (such as BMC Software, Inc.) in the designated fields. 
The following fields display values once the Licenses tab (next topic) is completed: 

 Licenses Owned 
 Licenses Assigned 
 Assets without a License 
 Status 

Once you have saved the software title record and audited your network, the Programs and 
Files tab will display the software associated with the software title that was found on your 
network. 

4. Click the Save button. 
  
Next Topic:  Entering Licensing Information for Software Titles 
  
  
  
  

Entering Licensing Information for Software Titles 

To Enter Licensing Information for Software Titles: 
1. Select the Software Licensing Management module from the left pane of the BMC Track-It! 

Technician Client window. 
2. Open the software title from the Software Titles list. 
3. Click the Add button on the Licenses tab. 
4. On the Software License dialog, enter the following information in the designated fields ( in the 

header section): 
  

 License Description 
 Serial Number 
 Activation Key 
 Licenses Owned 
 Expiration Date 
 The Status field automatically displays Active until it is changed. 

5. On the General tab, select the License Type from the Classification section. 
Examples of License Types are Single, Site, or OEM. 

6. Select or enter the License Source from the drop-down list. 
This may be OEM or Publisher, for example. 

7. In the Additional Information section, select or enter the Department that owns the software 
license and department's Location in the appropriate fields. 
The License Origination field automatically displays Original, Upgrade, or Renew (see 
Upgrading and Renewing licenses). 

8. If you use the Purchasing module to track your purchase orders, 
a.  Select the P.O. number, Date Purchased, and Vendor from the designated fields in the 
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Purchasing Information section.   
If you do not use the Purchasing module, you can manually enter this information. 

9. Click the Save button. 
  

Next Topic:  Assigning Licenses to a Computer 
  
  

Assigning Licenses to a Computer 

  
The Assets tab of the Software Title window displays a list of all of the computers with the installed 
software associated to a software title.  You can select the appropriate software license from the list (from 
information entered when the software title was created, such as the serial number). 
To Access the Computers with the Software Licenses Installed: 

1. Select the Software Licensing Management module from the left pane of the BMC Track-It! 
Technician Client window. 

2. Open the software title from the Software Titles list. 
3. Select the Assets tab. 

  
To View Assets (computers) with and without licenses: 

1. Select one of the following options from the Asset View drop-down list: 
 All Assets 
 Assets without a License 
 Licensed Assets 

To Assign a License to a Computer: 
1. On the Asset tab of the Software Title window, select the Asset, then click the Assign License 

button. 
2. Select the License from the License Listing dialog. 
3. Click the Save button on the Software Title window. 

  
To Revoke a License from a Computer: 

1. Select the Asset, then click the Revoke License button. 
2. Select Yes on the confirmation dialog. 
3. Click the Save button. 

  

Spell Checking Software Titles and Licenses 

You can spell check software titles and licenses when they are entered on the Software Title window. 
 You can check spelling as you enter text, or wait until you click the Save button, then the Spelling dialog 
will display. 
To Spell Check Software Titles and Licenses: 
  

1. After entering the Title Name or License Name place the cursor in either text box,  then press the 
F7 key. 

2. The Spelling dialog displays and works like any word processing application spell check tools. 
3. After you've made any necessary changes, click OK on the confirmation dialog indicating that the 

spell check is complete. 
4. Click the Save button on the Software Title window. 

  
  
  
  
Associating Software Titles with Master Items 
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If you want to track software licenses with Purchase Orders, when you are setting up the Software 
License Management module, you'll need to associate the software titles in the Software License 
Management module with items in the Master Items list.  (The Master Items list is a customized catalog 
of common items you'll be purchasing and/or adding to inventory).  Associating a software title with an 
item in the Master Items list automates the process of purchasing and tracking software licenses.  The 
association automatically creates licenses for the software title when you purchase and receive the 
software item and record the details in the Purchasing module.    
To Associate a Software Title with a Master Item: 

1. Select Administration Console from the Tools menu on the main menu bar. 
2. In the Administration Console, select Lookup Tables/ Inventory/Master Items. 
3. On the Master Items panel, double click the item to edit it (or select it and click the Select 

button). 
The Master Item dialog displays. 

4. Click the Add button on the Software tab.   
5. Select the software title you want to associate with the item from the Title Listing dialog. 
6. The software title displays on the Master Item dialog.  Click the Save button. 
7. Click Yes on the Confirm Update Related Records dialog. 
8. Click the Apply button to save your changes, and the OK button to close the window. 

  
Now when you receive the software item in the Purchasing module, you can choose to create a single 
license for each item received or a bundled license (each item received will create a new license 
containing your specified number of licenses in the bundle).  For detailed information, see Receiving 
Purchased Items into Inventory.  The licenses will display on the Software title dialog in the Software 
License Management module and on the license tab of the Purchase Order window. 
Associating Audited Software with Software Titles 
Once you have created the software title, you'll need to associate it with the related audited programs or 
files for which you want to track licenses.  For example, you would associate Microsoft Word with 
Microsoft Office Professional. 
  
You can add audited programs or files to a software title either from the Software Licensing Module, or 
from the Administration Console.   
  
Note:  Only audited programs and files that have not been associated to a software title will display on 
the Installed Programs list accessed from the  Software Licensing Module. 
  
To Associate an Audited Program with a Software Title  (in the Software License Management module): 
  

1. Select the Software Licensing Management module from the left pane of the BMC Track-It! 
Technician Client window. 

2. Select the Software Title. 
If you don't see the Software title, change the filtered list (View drop-down list) to another 
approval status (for example, to Unidentified). 

3. On the Programs tab or Files tab of the Software Title window, click the Add button. 
4. On the Installed Programs dialog or Installed Files dialog, double click to select the program or 

file to associate with the software title, OR 
Select the program or file and click the Select button. 
The program displays on the Programs tab of the Software Title window. 

5. Click the Save button. 
To Associate an Audited Program with a Software Title (in the Administration Console): 

1. In the Administration Console, select Administration from the Lookup Tables section. 
2. Select Installed Programs or Installed Files from the Administration section. 
3. On the Installed Programs or Installed Files dialog, double click to select the program to 

associate with the software title, OR 
Select the program and click the Associate button. 
Note:  You may have to enlarge the Administration Console window to see the Associate button. 
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4. Select the Software Title from the Title Listing dialog. 
5. The program displays on the Programs tab or Files tab of the Software Title window. 
6. Click the Save button. 

  
To Change the Audited Software's Status (from Unidentified to Approved, Permitted, or Alerts): 
 See Changing the Audited Software Approval Status 
  
To Remove an Audited Program or File from a Software Title: 

1. Select the Software Licensing Management module from the left pane of the BMC Track-It! 
Technician Client window. 

2. Select the Software Title. 
3. On the Programs tab or Files tab of the Software Title window, select the program to remove 

and click the Remove button. 
The program is removed from the Programs tab or Files tab. 

4. Click the Save button. 
  

Upgrading, Renewing, and Retiring Software Titles 

Upgrading Software licenses 

You can track software license upgrades and view details, by software title, of licenses owned and 
assigned of original and upgraded software.  When you upgrade a software license (for example, from 
Crystal Reports 9 to "XI"), BMC Track-It! creates a new license record with the updated license details 
that you specify.  The previous license is retired.  You can view the both records from the All licenses 
view (see below). 
  

1. Select the Software Licensing Management module from the left pane of the BMC Track-It! 
Technician Client window. 

2. Open the software title from the Software Titles list. 
3. Select the Licenses tab. 
4. Select the license you want to upgrade, then select Upgrade License from the Actions button. 
5. On the Upgrade License dialog, enter a new license description for the portion of the current 

license you want to upgrade. 
Enter enough information so that the upgraded license description can be differentiated from the 
original license.  An example of the upgraded license is:  "Crystal Reports XI Upgrade for J. Smith 
and R. Jones". 

6. Select or enter the number of licenses to upgrade from the Upgrade Count field. 
7. If you are upgrading only some of the licenses, click the Select Assets button. 
8. On the Asset Listing dialog, select the assets that will be assigned to the licenses, then click the 

Save button. 
9. Click the Save button on the Upgrade License dialog. 

  
The License tab of the Software License dialog displays the number of Licenses Owned, Licenses 
Assigned, and Assets without a License for the software license. 
Example (Upgrading Crystal Reports 9 to Version XI) 
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The following is an example of changes that occur when a software license is upgraded: 
  

If You Upgrade: Licenses Owned 
  

Licenses Assigned 

  
Less than Total # of Licenses Owned 

Version 9 is decreased and 
Version XI is increased by the 
number of upgraded licenses 

Version 9 Licenses 
are removed from 
the selected 
computers and 
Version XI licenses 
are assigned to them 

  
Example 
  

23 licenses owned of current 
version.  Only two users need 
new version's functionality. 

Version 9:    21 
(2 licenses are retired) 
Version XI:    2 
  

Computer 1 and 2: 
 Version XI 
Computers 3 - 23: 
 Version 9 

  
More than Total # of Licenses 
  

Version 9 is decreased to 0 and 
Version XI is increased by  the 
number of upgraded licenses 

Assets are assigned 
to the new license 
automatically. 

Example 25 users need new version's 
functionality 

Version 9:      0 
(23 licenses are retired) 
Version XI:  25 

Computers 1-25: 
 Version XI 

  
Same # of Licenses 

Version 9 is decreased to 0 and 
Version XI is increased by  the 
number of upgraded licenses 

Assets are assigned 
to the new license 
automatically. 
  

Example 
  

23 users need new version's 
functionality. 

Version 9:     0 
(23 licenses are retired) 
Version XI:  23 

Computers 1-23: 
 Version XI 

  

Renewing Software Licenses 

  
If an expiration date has been added for a license and the license has expired, you can renew the license. 
  
  
When you renew a license, the following changes occur: 
  

• The old license record is retired 
• A new license record is created with the updated license details 

To Renew a Software License: 
1. Select the Software Licensing Management module from Navigation Pane. 
2. Open the software title from the Software Titles grid. 
3. Select the Licenses tab. 
4. Select the license you want to upgrade, then select Renew License from the Actions button. 
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5. On the Renew License dialog, enter a  new license description for the portion of the current 
license you want to renew (in the Renew License field). 

6. Enter the number of licenses you want to renew in the Renew Count field. 
7. If you are only renewing some of the licenses: 

a. Enter the number of licenses, then click the Select Assets button. 
b. On the Asset Listing dialog, select the asset or assets, then click the Select button. 

8. Click  the Save button on the  Renew License dialog. 
  
  
  
  
  

Retiring a Software Title 

  
A software title may become obsolete and you may not want to track it any longer.  You can then retire 
the title. 
  
Note:  Retiring a software title also deletes any associated software licenses for that title. 
To Retire a Software Title: 

1. Select the Software Licensing Management module from the left pane of the BMC Track-It! 
Technician Client window. 

2. Select the software title, then select Retire Title from the Tasks pane. 
3. Click Yes on the confirmation dialog indicating that the associated licenses will be deleted. 

  
  

BMC Track-It! Bar Code Solution 
Getting Started with the Track-It! Bar Code Solution 
  
How Bar Coding Can Help You Track Assets 
  
The BMC Track-It! Bar Code solution complements the Discovery and Inventory features of Track-It!, 
providing the added benefit of enabling you to track your company's IT assets using bar codes, increasing 
productivity by expediting data entry and reducing errors during physical audits. 
  
While BMC Track-It! can automatically discover your networked IT assets, the Bar Code Solution solves 
managing inventory that is not connected to a network.  By scanning bar codes, you can quickly add 
other assets to Inventory in BMC Track-It! such as newly received assets, non-networked assets, or 
anything else you want to track.    
  
If you have already been using BMC Track-It! to audit your computers, for example, you can scan the 
computers' Company Asset Tags as well as other bar code labels such as serial numbers.  Then you can 
use the Asset Reconciliation - Bar Code window to match the scanned computers with those already 
inventoried in BMC Track-It! 
   
BMC Track-It! Bar Code Workflow   
  
Click the link above for details on how to add bar code records to BMC Track-It! with a bar code device. 
  
Reports 
  
Administrators can view and print the Company Bar Coded Assets by Location report (see Viewing Bar 
Code Reports). 
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Next Topic: 
  
Navigating the Track-It! Bar Code Device Application 
BMC Track-It! Bar Code Workflow 
Adding Bar Code Records to BMC Track-It! with a Bar Code Device 
  
Follow the steps below to add bar code records to BMC Track-It! using your bar code device (click each 
step for detailed instructions): 
  

1. Update your bar code device with BMC Track-It! lookup tables (synchronizing with BMC Track-
It!*). 

2. Scan your bar coded assets and select attributes. 
3. View and/or edit scanned bar code assets on the device. 
4. Update BMC Track-It! with scanned bar code records (Synchronizing with BMC Track-It!*) 
5. Manage bar coded assets in BMC Track-It! 

a. Transfer bar coded assets to Inventory 
b. Compare bar coded assets to existing Inventory (optional) 
c. Manually Matching Bar Coded Assets with Unmatched Inventoried Assets (optional) 

  
* Synchronizing your bar code device with BMC Track-It! simultaneously updates the device with BMC 
Track-It! Lookup Tables and updates BMC Track-It! with scanned bar code records. 
  
Please see the BMC Track-It! Bar Code solution chapter for additional topics (under Inventory in the 
table of contents of the BMC Track-It! Technician's Guide). 
  
Remote Technicians 
  
If you are a remote technician with a bar code device but no access to BMC Track-It!, you can use the 
import/export feature.  See Importing/Exporting Bar Code Data. 
  
Next Topic: 
Navigating the BMC Track-It! Bar Code Device Application 
  
Using the Bar Code Device 

Navigating the BMC Track-It! Bar Code Device Application 

  
 To Start the BMC Track-It! Bar Code Application: 

1. On your bar code device, select Start > All Programs > BMC Track-It!. 
  

The BMC Track-It! Bar Code device application has three main screens: 
  

 Main Menu 
 From here you can start scanning bar codes, view scanned bar codes, or view the About 

screen. 
 The About screen displays: 

 BMC Track-It! Bar Code version number 
 Build number 
 Device ID 
 BMC Software's Web site:  www.numarasoftware.com 
 Sales telephone number:  (800) 557-6970 

 Scan Asset Screen 
 From here you can scan bar codes. 
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 Scanned Asset List Screen 
 From here you can find, view, edit, and delete scanned bar code records. 
 You can also import and export bar code records with a BMC Track-It! technician if you 

are at a remote location without the BMC Track-It! application. 
  
Next Topic: 
Synchronizing Your Bar Code Device with BMC Track-It! 
  

Synchronizing Your Bar Code Device with BMC Track-It! 

Synchronizing your bar code device with BMC Track-It! simultaneously updates the device with BMC 
Track-It! lookup tables and updates BMC Track-It! with scanned bar code records. 
  
When you synchronize your bar code device with BMC Track-It! before you begin a scanning session, the 
following lookup table values for the four fields on the device are updated: 
  

 Departments 
 Locations 
 Users 
 Asset Types 

  
When you're finished scanning bar coded assets, synchronizing also retrieves the scanned bar code data 
from the device and updates the Manage Bar Coded Assets window in BMC Track-It!. 
To Synchronize Your Bar Code Device with BMC Track-It!: 

1. Connect your bar code device to the computer where BMC Track-It! is installed. 
2. Select Manage Bar Coded Assets from the Tools menu on BMC Track-It!’s main menu bar. 

  
 You can also access the window from the Manage Bar Coded Assets link on the Assets 

window of the Inventory module, or from the Bar Coded Assets link on the Assets Summary 
section of BMC Track-It!'s home page. 
  

3. Click Synchronize my device from the Bar Code section of the task pane on the right of the 
window. 

4. The Transfer Progress dialog displays while lookup table data from BMC Track-It! is transferred 
to the device and scanned bar code records are transferred to BMC Track-It!. 

5. Click OK when the dialog displays that synchronization is complete. 
  
When the bar code synchronization is complete, the bar code records on the bar code device are 
removed. 
Canceling Synchronization 
If you click the Cancel button before synchronization is complete, the bar code records are removed from 
BMC Track-It! and restored to the bar code device. 
  
Next Topic: 
Scanning Bar Codes and Selecting Attributes or Managing Bar Coded Assets 

Scanning Bar Codes and Selecting Attributes 

You can scan up to two bar code labels for each asset (the Company Asset Tag and the manufacturer's 
Serial Number).  You can also manually enter the Company Asset Tag and Serial 
Number using the soft keyboard on your bar code device.  After you scan the bar codes, then you can 
select attributes for the asset (Department, Location, User, and Asset 
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Type). 
  
After you've scanned the bar codes, you can view the scanned bar code records on the Scanned Asset 
List screen. 
  
 To Scan Bar Codes: 

1. Start BMC Track-It! Bar Code on your bar code device by selecting Start > All Programs > 
BMC Track-It!. 

2. Selected the Scan Asset icon from the Main Menu. 
3. Scan or enter the Company Asset Tag (bar code label) on the asset.  The Asset Tag field in 

BMC Track-It! Bar Code displays the scanned value, and is a required field. 
4. Scan or enter the Serial Number (bar code label) on the asset (if available).  The value is 

displayed in the Serial number field. 
5. Select values from any of the following drop-down lists to associate the asset with an attribute: 

 Dept (Department) 
 Location 
 User 
 Asset Type 

  
   

If the value is not listed (e.g. User Name) even though you've synchronized the device, ask 
your BMC Track-It! administrator to update the lookup tables in BMC Track-It!. 
  
If you make a mistake, you can edit individual fields, or select the Clear All button.  This will 
clear all of the fields on the screen so that you can re-scan the bar 
codes. 

  
6. When you are finished entering data for an asset, select the Submit button.   

  
This increases the Records count at the top of the screen and clears the screen to enable a 
new scan.  The lookup table fields are retained so that you can quickly scan and enter assets 
with similar attributes. 
  

7. When you are finished scanning bar codes for this session, press the Done button. 
  

 The screen closes and the scanned bar code assets display on the Scanned Asset List 
screen. 

  
Next Step:  Viewing and Editing Scanned Bar Code Assets on the Device 
  

Viewing and Editing Scanned Bar Code Assets on the Device 

The Scanned Asset List Screen displays a list of the scanned assets currently on the device.  From this 
list, you can find, delete, edit, or enter new bar code assets.   
To View Scanned Bar Code Records: 

1. Start BMC Track-It! Bar Code on your bar code device by selecting Start > All Programs > 
BMC Track-It!. 

2. Select the Scanned Asset List icon from the Main Menu (the screen automatically displays once 
you've selected the Done button after scanning bar codes). 

  
To Find Bar Code Records: 

  
3. Select one of the attributes (e.g. from the drop-down list next to the Find button. 

To Edit Bar Code Records: 
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1. Select the bar code record, then select the Edit button.  The Scan Asset screen displays opens 
and displays the selected record. 

2. Edit the records by selecting the appropriate field and entering the new information. 
3. When you are finished editing the record, select the Submit button, then select the Done button. 

 The screen closes and the edited records display on the Scanned Asset List screen. 
  
To Delete Bar Code Records: 

1. Select the bar code record, then select the Delete button. 
2. Select Yes when the Delete selected item message displays. 

  
To return to the Scan Asset screen and scan new bar codes: 

1. Select the New button. 
  
Next Step: 
  
If you are ready to update BMC Track-It! with the scanned bar code records, see Synchronizing Your Bar 
Code Device with BMC Track-It!. 
  
Related Topic: 
  
Importing/Exporting Bar Code Data 
  
Importing/Exporting Bar Code Data 
Remote technicians who do not have access to BMC Track-It! can import and export bar code data 
through their bar code devices so that the BMC Track-It! technician can manage bar coded assets, even 
from remote locations.   
  

Important Note:  There is a separate installer for the remote BMC Track-It! Bar Code application.  See 

page 4 of the Track-It! Bar Code Installation Guide (PDF format). 

  

Steps to Import and Export Bar Code Data 
  
Click each step to view detailed instructions. 
  
BMC Track-It! Technician 
  

Remote Technician 
  

1. E-mail the Track-It! Bar Code device application to 
the remote technician. 

a. Navigate to the following folder 
on your computer:  \\Program 
Files\BMC Software\Track-It! 
Bar Code. 
b. Copy the file 
TIBarCode_ToPDA.exe and attach it 
to an e-mail to the remote technician. 
  
c. Send the remote technician the 
installation instructions on page 6 
located in the Track-It! Bar Code 
Installation Guide (PDF format). 

  

2. Export the lookup table values from BMC Track-It! to 
send to the device. 

  

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&lang=EN
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You'll need to initially export the files to your remote 
technician and export them whenever lookup table 
values are updated in Track-It! 
  

a. Navigate to C:\Program Files\BMC 
Software\Track-It!\Track-It! 
Server\Support\. 

b. Double click the file BarCodeIO.hta to run the Bar 
Code Importer/Exporter. 

c. Click the Export button on the BMC Bar Code 
Importer/Exporter dialog. 

d. Click the Open Results Folder button to view the 
exported files. 

e. The lookup table files are exported to the 
To_Devices folder:  C:\Documents and 
Settings\Administrator.ServerName\MyDocuments\
BMCBarcode\To_Devices. 

f.  Click the Close button (X) to exit the BMC Bar 
Code Importer/Exporter dialog. 
  

There are four files that contain the values for the 
lookup tables: 
  

1.  
 S01F03.txt  (Departments) 
 S01F04.txt  (Locations) 
 S01F05.txt  (Users) 
 S01F06.txt  (Asset Types) 

  
Each time the files are exported, the To_Devices 
folder is updated automatically. 

3. E-mail the exported lookup table files to the remote 
technician. 

a. Navigate to the following folder 
on your 
computer:C:\DocumentsandSettings\
Administrator.ServerName\MyDocum
ents\BMCBarcode\To_Devices. 
b. Copy the four files in the 
To_Devices folder and attach them to 
an e-mail to the remote technician.   

  
The text files contain values for the 
following attributes: 

  
 S01F03.txt  (Departments) 
 S01F04.txt  (Locations) 
 S01F05.txt  (Users) 
 S01F06.txt  (Asset Types) 

  
c. Send the remote 
technician the instructions on 
importing the files (in Step 5 
under Remote technician, 
below). 
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  4. Install Track-It! Bar Code on the bar code 

device. 
See the installation instructions on page 
6 located in the Track-It! Bar Code 
Installation Guide (PDF format). 

  5. Synchronize the device by importing the 
lookup table values. 

a. Copy the four 
lookup table values 
received from the BMC 
Track-It! Technician 
(e.g.S01F03.txt) to the 
For_Import folder in the 
following directory:   
Windows Explorer: 
 [Computer 
Name]\Mobile 
Device\My 
Documents\Track-
It\Data.   
b. Start Track-It! Bar 
Code by selecting Start 
Programs Track-It!. 
c. Selected the 
Scanned Asset List icon 
from the Main Menu. 
d. Select File Import 
Data from the Scanned 
Asset List screen. 

  
A message displays that the four data 
files were imported.   
  
If a message displays that no files were 
found for the import, make sure that the 
files were copied to the For_Import folder 
in step 1, above. 
  
After importing, Track-It! Bar Code 
renames the imported files to 
old_[file_name], e.g. old_S01F03.txt, to 
indicate that they have already been 
imported. 

  6. After scanning the assets, e xport the bar 
code data from the device. 

a. Make sure the bar 
code device is connected 
to the computer, and start 
Track-It! Bar Code by 
selecting Start Programs 
Track-It!. 
b. Select the 
Scanned Asset List icon 
from the Main Menu. 

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=105&Offering=2&lang=EN
http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=105&Offering=2&lang=EN
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c. Select File Export 
Data from the Scanned 
Asset List screen. 

  
A message displays indicating that the 
file was exported to the Mobile Device 
folder:  \\My Documents\Track-
It\Data\Exported. 

  7. E-mail the exported bar code data files to 
the BMC Track-It! technician. 

a. Navigate to the 
following folder on your 
computer: Windows 
Explorer:[Computer 
Name]\Mobile 
Device\My 
Documents\Track-
It\Data\Exported. 
b. Move the file in the 
Exported folder (e.g., 
S01_data.txt) and attach 
it to an e-mail to the BMC 
Track-It! Technician.   

8. Import the bar code data into BMC Track-It! 
 Important Note: 

  

If you have received bar code data files from multiple 
remote devices, you will need to rename the files 
(e.g. S02_data.txt) for each device. 

 

a. Copy the file (e.g., S01_data.txt) received 
from the remote technician to the following 
folder: C:\Documents and 
Settings\Administrator.ServerName\MyDocu
ments\BMCBarcode\From_Devices. 

b. Navigate to: \\Program Files\BMC 
Software\Track-It!\Track-It! 
Server\Support\. 

c. Double click the file BarCodeIO.hta to run 
the Bar Code Importer/Exporter. 

d. Click the Import button. 
e. Click Yes when the message displays asking 

you to confirm merging the file from the 
From_Devices folder.  (If you click Cancel, 
the text file remains in the From_Devices 
folder). 

f. Click the Close button to exit the 
Importer/Exporter. 

  
The bar code data in the text file is 
imported.  The data consists of the 
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following attributes for each scanned bar 
code asset: 

7.  
 Company Asset Tag 
 Serial Number 
 Department   
 Location 
 User 
 Asset Type 
 Timestamp 
 Batch ID 
 Device ID 
 Item ID 

  
Once you import the files, Track-It! 
renames them and moves them into the 
Previously_Imported folder (e.g. 
09062006161710141.S01_data.txt).  (The 
file name represents the date/time stamp 
when the file was imported into Track-It!). 
  
The bar code assets will now display on 
the Manage Bar Coded Assets window in 
Track-It! after refreshing the screen 
(clicking Apply or closing and opening the 
window). 

  
Next Topic: 
  
Managing Bar Coded Assets   
Managing Bar Coded Assets in BMC Track-It! 

Managing Bar Coded Assets in Track-It! (Overview) 

After bar coded assets have been scanned and the bar code device has been synchronized with BMC 
Track-It!, the system compares the scanned assets with those already existing in Inventory.  The list of 
scanned assets displays on the tabs on the Asset Reconciliation - Bar Code window as New, Matched, 
Missing, and Ignored.   
  
 Note: 

 In order to manage bar coded assets, technicians and other users must have full access rights 
to the Inventory module (see Restricting Privileges by Module in the Administrator's Guide). 

 Only one user at a time may access the Asset Reconciliation - Bar Code window.    
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The Bar Code assets' scan results are described below: 
  

Tabs Bar Code Assets Scan Results Management Options 

New Assets that do not have an 
associated Inventory record (the 
Company Asset Tag and Serial 
Number cannot be found in any 
of the existing inventoried 
assets). 

• Add to Inventory 
• The bar coded asset is 

merged with the inventoried 
asset and displays in the 
Inventory module. 

• Skip 
• Since there may be a large 

amounts of new assets to 
work with, Skip enables you to 
differentiate the asset while 
you manage others.  When 
you finish working with the bar 
code assets and return to the 
Asset Reconciliation - Bar 
Code window, bar code 
assets with the Skip 
designation will be reset to 
their previous state (such as 
Add to Inventory). 

• Delete scan 
• Removes the asset from the 

New tab.  You might want to 
remove an asset from the list, 
for example, if the wrong 
attributes (user, location, or 
department) were selected on 
the bar code device when the 
asset was scanned. 

• Match to existing asset 
• Enables you to manually 

match a bar coded asset with 
an unmatched inventoried 
asset. 

Matched Assets with a matching Inventory 
record (based on Company 
Asset Tag and/or Serial Number. 
  
Displayed by: 

• Probable Matches 
• Changes 
• No Changes 

• Accept 
• Skip 
• Match to another asset 
• Unlink scan and asset 
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Missing Assets that  have not been found 

in a scan during a specified 
period. 
  
Displayed by: 

• Previously Scanned 
• Assets that Have Never Been 

Scanned 

• Skip 
• Always ignore asset 
• Remove from inventory 

   
  

Ignored Assets that have been 
designated by a Technician as 
Ignored because they don't need 
to be tracked at this time. 

Can display: 
  
Ignored Assets 
Ignored Scanned Devices 

• Skip 
• Resume Updates 

  
  
Next Topic:  Viewing Bar Code Assets 
  
  

Viewing Bar Code Assets 

  
The list of scanned assets displays on the tabs on the Asset Reconciliation - Bar Code window as New, 
Matched, Missing, and Ignored.   
To Access the Asset Reconciliation - Bar Code Window: 

1. Select Asset Reconciliation - Bar Code from the Tools menu on the main menu bar. 
  

You can also access the window from the Tasks pane of the Inventory module, or from the 
Asset Summary section of the home page. 

Tabs 

  
1. The New tab displays.  To view the list of New Assets by groups (Department, Location, or Batch 

ID), select an option from the Group reconciliation by: drop-down list. 

Groups 

1. To show asset types in groups, click the designated checkbox.  The assets will be grouped by 
asset type, such as computer, printer, or router. 

Grid and Columns 

The New tab grid is split into two panes (Discovered Assets and Inventory), separated by a gray 
vertical border, with columns displaying for each pane. 

  
1. To view the columns for each pane, drag the gray vertical border between Discovered Assets 

and Inventory to the right or left (you may need to expand the window horizontally to see more 
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columns). 
  

2. To display or hide columns, right click in the Discovered Assets or Inventory grid, then select 
Customize.  For detailed instructions on viewing columns, see Creating User-defined Views. 

  
Next Topic: Adding Bar Coded Assets to Inventory 

Adding Bar Coded Assets to Inventory 

Typically, when you install BMC Track-It!, the Discovery process finds networked assets, such as 
computers, and automatically adds them to Inventory.  With the BMC Track-It! Bar Code solution, you can 
also add scanned bar coded assets into Inventory (which merges with an inventoried asset or creates a 
new asset). 
  
After the bar codes have been scanned, BMC Track-It! displays the scanned bar coded records on the 
Asset Reconciliation - Bar Code window.  From here you can add the assets to Inventory.   

What Happens in Inventory When you Add a Bar Coded Asset? 

Once you add bar coded assets, the following changes are applied, depending on the match type: 
  

Bar Code 
Assets 
Scan 
Results 
  

Inventory Module Result 

New Assets 
   When you select Add to Inventory for an asset, the bar coded asset is 

removed from New tab of  the Bar Coded Assets list and an inventory record is 
created, which displays in the Inventory module (see Viewing Asset 
Information). 

 See also  Manually Matching Bar Coded Assets to Existing Inventory). 

  

Matched 
Assets Note:  When you add a matched asset to existing inventory, the inventoried 

asset's values will be replaced with those from the matched asset.  However, if 
any of the matched asset's values are blank, the existing asset's values will be 
retained. 

 When you select Accept for an asset, the bar coded asset is removed from the 
Bar Coded Assets list on the Matched tab of the  Asset Reconciliation - Bar 
Code window. 

 The bar coded asset is merged with the inventoried asset and displays in the 
Inventory module (see Viewing Asset Information). 

  
To Add Bar Coded Assets to Inventory: 

1. Select Asset Reconciliation - Bar Code from the Tools menu on the main menu bar. 
2. Select an asset from the New tab on the Asset Reconciliation - Bar Code window, then select 

Add to Inventory from the Actions column. 
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You can also right click the asset and select Add to Inventory. 
  
To view bar coded assets added to Inventory, see Viewing and Editing Assets. 
  
Next Topic:  Manually Matching Bar Coded Assets with Unmatched Inventoried Assets 

Manually Matching Bar Coded Assets with Unmatched Inventoried Assets 

BMC Track-It! automatically displays scanned bar coded assets with matching Company Asset Tags 
and/or Serial Numbers with inventoried assets on the Asset Reconciliation - Bar Code window, which 
you can then add to Inventory).  BMC Track-It! also allows you to manually match a bar coded asset with 
an unmatched inventoried asset. 
  
For example, an asset exists in Inventory that originated from the Purchasing module.  The Serial 
Number and Company Asset Tag were not previously entered.  Now you've scanned the bar code on the 
asset, and you want to match it to it's inventory record. 
  

Note: 
  
When you match an asset to existing inventory, the existing asset's values will be replaced with those 
from the bar coded asset.  However, if any of the bar coded asset's values are blank, the existing asset's 
values will be retained. 
To Manually Match Bar Coded Assets to Unmatched Existing Inventory Records: 

1. Select Asset Reconciliation - Bar Code from the Tools menu on the main menu bar. 
2. Select an asset from the New tab on the Asset Reconciliation - Bar Code window, then select 

Match to existing asset from the Actions column. 
You can also right click the asset and select Match to existing asset. 

3. The Search dialog displays.  Enter the first four characters of the Asset Name or Asset ID in the 
Search for: field, then click the Search button. 

4. Click the inventoried asset to be matched from the search results, then click the Select button. 
  

The asset is removed from the New tab and matched with the inventory record. 
  
 If you want to unlink a bar code scan from an asset, see Unlinking a Bar Code Scan from an Asset. 
  
To view bar coded assets matched with Inventory, see Viewing and Editing Assets. 
  
Next Topic:  Unlinking a Bar Code Scan from an Asset 

Unlinking a Bar Code Scan from an Asset 

If you find that an incorrect Company Asset Tag has been applied to an inventoried asset, you can unlink 
the bar code scan from the asset.  You may need to unlink them, for example, if a bar coded asset has 
been incorrectly matched to an inventoried asset (see Manually Matching Bar Coded Assets to Existing 
Inventory). 
To Unlink a Bar Code Scan from an Asset: 

1. Select Asset Reconciliation - Bar Code from the Tools menu on the main menu bar. 
2. Select an asset from the Matched tab on the Asset Reconciliation - Bar Code window, then 

select Unlink scan and asset from the Actions column. 
3. You can also right click the asset and select Unlink scan and asset. 

  
The inventoried asset remains on the Assets window in Inventory, and the Company Asset Tag is 
removed. 
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See also:  Deleting Assets and Copying an Asset. 
  
Next Topic:  Viewing Bar Code Reports 
Viewing Bar Code Reports 
  
The Company Bar Coded Assets by Location report displays assets scanned vs. not scanned bar 
coded assets per location (based on scanned assets associated with an inventory record).  See Creating 
and Editing Reports for more information, including report customization.  An example of report details is 
displayed below: 
  

 

5/11/06    3:25:00PM 
Location 
  

Co. 
Asset 
Tag 

Asset 
Type 

Name Serial No. Department User Last 
Scan  
Date 

Receiving 

  Computer Computer1 C12345B6789 Engineering John 
Smith 

5/10/  
  

  P23456 Printer Printer1 P2345678901 Finance Anne 
Brown 

5/10/  

Total Scanned:  1 Total Not Scanned:  1 
Engineering 

  Computer Computer1 C12345B6789 Engineering John 
Smith 

5/11/  
  

  Computer Printer1 
  

P2345678901 
  

Finance 
  

Anne 
Brown 

5/11/  
  

Total Not Scanned:  1 Total Not Scanned:  1 

  
Company Bar Coded Assets by Location Report (Example) 

  
To View a Bar Code Report: 

1. Select Reports from the Navigation Pane. 
2. Select Inventory from the Reports by Module drop-down list. 
3. Select the Company Bar Coded Assets by Location report. 

  
See also Printing Inventory Reports. 
  
Next Topic: 
Managing Bar Code Licenses 
Managing Bar Code Licenses 
Your BMC Track-It! Bar Code solution license includes the ability to use three bar code devices to scan 
and synchronize bar code data into the BMC Track-It! application.  If you plan on using more than three 
bar code devices for synchronization, you can obtain additional licenses through the BMC Track-It! 
Support Center, or by calling your BMC Track-It! sales representative.  (See Maintaining Registration 
Support and Licenses in the Administrator's Guide).  You can also view the status of your Bar Code 
Device licenses from the Asset Reconciliation - Bar Code window. 
  
  
Next Topic: 
Viewing Bar Code Transaction History (Database) 
Viewing Bar Code Transaction History (Database) 
The AssetTagCaptureLog table in your BMC Track-It! database displays the following information: 
  

 AssetTagCaptureLogID 
 Divide ID 
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 DeviceAssignedBatchID (Date and Time) 
 DeviceAssignedItemID 
 CompanyAssetUniqueID 
 CreateDate 
 SerialNumber 
 DataCaptureDate 
 LocationID 
 AssetTypeId (Added, Modified, or Rejected) 
 USERID 
 DEPT_ID 

  
Next Topic: 
Troubleshooting Bar Coding 
  
Troubleshooting Bar Coding 

Problem 

Cannot access the Bar Code features in BMC Track-It!: 
• Another user has feature open. 
• The user does not have full rights to the Inventory module, Locations, and Departments. 

  
  
  
  
  

Managing IT Assets with BMC Track-It! Web 
  
In addition to BMC Track-It! Technician Client, you can use BMC Track-It! Web to manage IT assets 
 When you're back at your desk, you can manage any of the assets you created or edited in BMC Track-
It! Web from the BMC Track-It! Technician Client. 
  
Note:  Online help is available once you log in to BMC Track-It! Web (and is separate from the BMC 
Track-It! Technician Client online help).  The topics in the online help are also available in the BMC Track-
It! Web Technician's Guide (PDF) on the Product Documentation section of our Support Web page  
To Access BMC Track-It! Web: 

1. Go to the URL provided by your BMC Track-It! Administrator (typically 
http://servername/TrackItWeb/ where "servername" is the name of the server). 

2. Enter your user name and password and click the Login button. 
 
The BMC Track-It! Web home page displays. 

  
  
  
  

Help Desk: Managing Your Work Orders 

Help Desk Overview 
  
The Help Desk module is designed to track IT related issues (such as problems with hardware or 
software, networking, or telecommunications) and requests for services (such as installations, purchases, 
and training).   
  

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=105&Offering=2&lang=EN
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Note:  Certain Help Desk features are add-on modules, such as BMC Remote  See the BMC Track-It! 
Add-ons on our Web site 
  
How the Help Desk Module Can Help You Manage Your Work Orders 
  
The following is a brief description of the Help Desk module features.  See the topics in this chapter for 
detailed information and instructions.   See also:  Managing Work Orders Workflow. 
  
View and Find Work Orders Details 
  
When you open the Help Desk module, the Work Order grid displays.  You can view all of the Work 
Orders from the Work Order grid.  There are several pre-defined system views (such as My Open Work 
Orders).  The default grid view displays information such as the Work Order Type, Priority, Date Entered, 
Summary, and Due Date.   
  
You can sort, filter, and group records in a grid, and create user-defined views.  You can also export and 
import views, and print and export grid contents. 
  
You can search for Work Orders and Work Order details with the full-text search feature, including all 
fields associated with Work Orders.   
  
View Work Order Audit Trail 
  
BMC Track-It! automatically tracks and displays technician and system activity for a Work Order so you 
can monitor changes through its lifecycle. 
  
Document Work Orders 
  
Documenting a Work Order is quick and easy due to drop-down lists on the Work Order window.  When 
you create a Work Order and select the Requestor's name, information is automatically displayed such as 
the User's contact information, department and location.  (The Users' list is updated by the BMC Track-It! 
Directory Importer which imports and synchronizes users from your Directory Service -- see Directory 
Importer Overview in the Administrator's Guide).  You can also edit and view user details directly from the 
Work Order, and view the Requestor's work order history. 
  
The Help Desk module interfaces with the Training module to display the user's course history. 
Integration with the Inventory module enables you to view the user's associated assets and audit 
information, including the asset's Work Order history. 
  
Once you enter a brief summary of the issue or request, then you can quickly classify and prioritize it with 
drop-down Work Order Types.  You can add detailed, categorized descriptions and notes, including 
private notes not visible to end uses using the Self Service application.  If more documentation is needed, 
you can attach files to Work Orders. 
  
Automatically Convert E-Mails to Work Orders 
The E-mail Monitor can be set up to automatically create work orders from e-mail 
requests so that they are sent to your help desk e-mail account. 
  
Create Work Order Templates and Copy of Work Orders 
You can save data entry time when documenting recurrent issues by creating Work Orders from 
templates and by copying Work Orders.   
  
Automatically Assign Work Orders based on Specific Skill Sets 
Skill Routing Work Order Policies can be set up so that Work Orders are automatically assigned to 
particular Technicians based on specific criteria, such as the Work Order Type.   
  

http://www.numarasoftware.com/track-it/help_desk_software.aspx
http://www.numarasoftware.com/track-it/help_desk_software.aspx
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Set up Service Level Agreements (SLAs) 
Service Level Agreements can be set up and associated with Work Order Event Policies. 
  
Set up Work Order Event Policies 
Work Order Event Policies can be set up to notify a Technician or Technician Group when certain events 
occur with Work Orders matching certain criteria.  Work Orders can be escalated to another technician if 
the work is not completed on time. 
  
Set up Help Desk Hours 
Help desk Operating Hours can be set up for automatic calculation of due dates and to determine when 
Work Order notifications are sent.   
  
Create Work Order Assignments 
If there is a complex Work Order that requires multiple tasks by various Technicians. 
Assignments can be added for each Technician and task. 
  
Automatically Calculate Due Dates 
Work Orders can be associated with Work Order Event Policies and Service Level 
Agreements (SLAs).  If so, the Work Order's due date is automatically calculated. 
  
Use Custom Fields 
Your BMC Track-It! Administrator can set up custom fields, including custom Status fields, for Work 
Orders specific to your organization.    
  
E-mail Work Order Details to Requestors and Technicians 
You can e-mail Work Order details to Requestors and Technicians that contain pre-populated 
information, such as the Work Order number, Summary, Description, and Status. 
  
Set up Work Order Status Updates 
Work Order Status Updates can be set up so that BMC Track-It! can automatically respond to users 
when they send e-mails requesting the status of a Work Order.   
  
Print Work Orders and Print/Export Work Order Grid Contents 
You can print Work Orders and print or export Work Order grids. 
  
Create Solutions from Work Order Resolutions and Work Order Resolutions from Solutions 
The Solutions module enables Technicians to maintain a database of solutions to common 
work order issues.  If you have resolved a common Work Order issue, you can add the resolution to the 
Solutions module. You can also insert a Solution directly into a Work Order as the 
Resolution. 
  
Track Work Order Time and Cost (Hours and Charges) 
An hourly charge can be set up per Technician and/or Technician Group, which is automatically 
calculated when you enter your hours. 
  
Document Work Order Resolutions 
Enables you to describe exactly how you solved the problem, helping you and other technicians in similar 
situations. 
  
Generate Reports 
Administrators and Technicians with permissions to view Reports can view Help Desk reports from the 
Help Desk or Reports modules.  (Technicians will only be able to view the report details for those they are 
privileged to view (based on Module, Location, Department, and Assigned Technician as set up by the 
BMC Track-It! Administrator).    
  
View Help Desk Metrics with the Dashboard 
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Administrators and technicians with permissions to view the Dashboard module can view Key 
Performance Indicators (KPIs) in the form of graphs (bar and pie charts) and pivot grids (interactive 
tables).   
  
Next Topic:  Managing Work Orders Workflow 

Creating announcements 
Administrators and Technicians can create announcements that can be viewed on the BMC Track-It! 
Home Page by Technicians (and end users if necessary).  You can post multiple announcements and set 
an expiration date and time for each announcement.  You can also format the text using HTML markup. 
  

Note:  You can create new announcements and delete them; however, they can't be edited.   It's best to 
create the text in a text editor, save it, then paste the text into the Announcement dialog. 
To Create an Announcement: 

1. Select Home Page from the Navigation Pane. 
2. Click the Add Announcements link in the Announcements panel. 
3. On the Announcement dialog, select or enter the date and time for the announcement to expire 

in the Announcement Expiration field. 
4. Type the announcement in the Announcement text box. 

If you want to format the text using HTML (font color, marquee, and other attributes), see below. 
5. If you want end users to be able to view the announcement (in addition to technicians), check the 

Visible in Self-Service checkbox. 
6. Click the Save button to close the dialog and post the announcement on the Home Page. 

To Delete an Announcement: 
1. On Track-It's home page, click the checkbox(es) next to the announcement(s) you want to delete. 
2. Click the Delete link. 

Text Formatting Using HTML 
You can use HTML to format the announcement's text.  Some common tags are listed below. 
  

Format Example Result 
Bold <B>Good Morning</B> Good Morning 
Italics <I>Good Morning</I> Good Morning 
Font Size <FONT size = "2">Good 

Morning</FONT> 
Good Morning 

Font Color <FONT color = 
#FF0000>Good 
Morning</FONT> 

Good Morning 

Hyperlink <A HREF = 
"http://www.mywebsite.com" 
target = "_blank">Click 
Here</A> 

Click Here 
(opens the 
targeted page) 

Scrolling 
Marquee 

<MARQUEE> Good 
Morning</MARQUEE> 

Good Morning 

  

Managing Work Orders 
Managing Work Orders Workflow 
  
The flowchart below represents the tasks in the following topics.   
  

http://support.numarasoftware.com/support/
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Viewing and Finding Work Orders, and Searching for Details 

Viewing and Finding Work Orders 

The list of Work Orders is displayed in the Work Order grid (Help Desk module).  For detailed information 
on working with grid views, see Viewing Information in Grids). 
  
Notes: 
  

 Change Management:  Work Orders that are associated with a Request for Change in the 
Change Management module can be identified by enabling the RFC Status column.  These Work 
Orders will display with an RFC Status such as Approved, Rejected, or Pending Approval.  You 
can manage the Request for Change by opening the Work Order and selecting the Change 
Management tab. 
  
To enable the RFC Status column, right click anywhere on the grid, then select Customize.  In 
the Customize Grid dialog (Columns tab), select RFC Status from the list, then click the Add 
button.  For more information, see Showing and Hiding_Columns. 

  
 System Health:  The Work Order displays in the Help Desk grid with the Work Order ID and the 

Summary from the System Health Monitor Log.  By customizing the grid view, you can also see 
which Work Orders were created by the System Health Monitor by adding the "Opened by" 
column.  For more information on System Health, see System Health Overview in the 
Administrator's Guide. 

To View Work Orders: 
1. If the Help Desk module is not already open, select Help Desk from the Navigation Pane. 

The Help Desk window displays and Work Orders are listed in the grid.  You can specify 
which columns to view (See Creating User-defined Views). The number of records display at 
the bottom of the grid.   
  

2. To view work orders using views (open, closed, overdue, etc.) select a view from the Current 
View menu at the top of the grid (or from the View menu in the Main Menu Bar). 
 
The name of the view displays (e.g. Current View - My Overdue Work Orders) and the records 
display in the grid.    

  
3. To view work order details, double-click the Work Order in the grid that you want to view, or select 

the Work Order, then select Open in the Tasks pane. 
 
The Work Order record opens. The top pane of the Work Order window displays the most 
commonly-used fields to describe a Work Order:  Requestor, Call Back Number, Asset, Work 
Order ID, Summary, Priority, and Status. 
  

To Find Work Orders: 
1. Do any of the following: 



BMC Track-It! 11 Web 

 © Copyright 1989 - 2012 Numara Software, Inc.  BMC Software, the BMC logos, and other BMC marks are trademarks or registered trademarks of BMC Software, Inc. in the 
U.S. and/or certain other countries. Track-It! is the property of Numara Software, Inc. and is registered with the U.S. Patent and Trademark Office, and may be registered or 

pending registration in other countries. Numara Software and BMC Software Confidential. 

81 

• Click Go to Work Order on the Help Desk Tasks menu 
• Click the Go to Work Order icon on the Help Desk toolbar 
• Select Go to Work Order from the Edit menu 
• Press the Ctrl+G keys 

2.  Enter the work order number in the Go to Work Order dialog, then click the OK button. 
 
The Work Order detail window opens displaying the Work Order. 

Customizing the Tabs Display 

Additional information about the Work Order is displayed on the tabs (such as Notes, Requestor, Asset, 
etc.). You can select which tabs to display, and which two to display at a time. 
To Customize the Tab Display: 

1. Right click anywhere on either of the two tab panes, then select the check boxes of the tabs you 
want to display. 

2. To display two tabs at once, right click the right pane (appears blank until a tab has been 
selected), then select a tab name. 

   
See Also:  Viewing Information in Grids 

  
  

Searching Work Order Details 

  
The BMC Track-It! search engine supports full-text search capabilities.   You can search for Work Order 
details ( text in Work Order database fields) from the Search field and Search button on each module's 
toolbar. 
To Search for Work Order Details: 

1. Enter the search term in the Search field (main toolbar), then select Work Orders from the 
Search button drop-down.   
The Search Work Orders dialog opens and displays the search results.  

2. The  Work Orders that include your search term are displayed in the Results list.  To view the 
Work Orders, double click (or right click and select Open). 

  
See also:  Searching for Information in BMC Track-It! and Searching for the Requestor's Name and 
Viewing User Information for a Work Order. 
  
  
  

Viewing a Work Order's Requestor Information and History 

  
You can view a Work Order's requestor information and work order history from the Requestor tab on a 
Work Order.  You can also sort or filter the Help Desk grid by the Requestor column to view work orders 
associated with a specific requestor.  (See Creating User-defined Grid Views.) 
  
The Requestor tab of the Work Order window displays the following details in the User Information 
section: 
  

User Information 
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• Name and Employee ID 
• Title 
• Location 
• Department and Department Number 
• Phone/Alternate Phone 
• E-mail 
• User Def. 1 
• User Def. 2 

  
To View  Requestor Details: 

1. Select the Requestor tab of the Work Order window. 
The User Information panels displays the information listed above. 

2. Click the User's Name link to open the Edit User dialog to view more details. 

Work Order History 

Work Orders associated with the requestor display on the Work Order History grid.  The grid can be 
customized (to display more columns, for example).  (See Creating User-defined Grid Views.) 
  
To View the Work Orders: 

1. To view work order details, double-click the Work Order in the grid. 
 
You can also right click anywhere on the Work Order History grid to open the Work Order, or e-
mail the Requestor or Technician. 

Viewing a Work Order's Asset Information and History 

  
You can view a Work Order's asset information and work order history from the Asset tab on a Work 
Order.  You can also customize the Help Desk grid to show the Asset column to view work orders 
associated with assets.  (See Creating User-defined Grid Views.) 
  
The Asset tab of the Work Order window displays the following details in the Asset Information section: 

Asset Information 

  
• Asset Name (or Asset ID if Asset Name is blank). 
• Asset ID 
• Asset Type 
• Location 
• Department 
• Department Number 
• Manufacturer 
• Model 
• Operating System Name for asset type Computer, Service Tag for all other asset types 
• Service Pack for asset type Computer, IP Address for all other asset types 

To View  Asset Details: 
1. Select the Asset tab of the Work Order window. 

The Asset Information panel displays the information listed above. 
2. Click the Asset ID link to open the Asset window to view more details. 
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Work Order History 

Work Orders associated with the asset display on the Work Order History grid.  The grid can be 
customized (to display more columns, for example).  (See Creating User-defined Grid Views.) 
  
To View the Work Orders: 

1. To view work order details, double-click the Work Order in the grid. 
 
You can also right click anywhere on the Work Order History grid to open the Work Order, or e-
mail the Requestor or Technician. 

Viewing the Work Order Audit Trail 

  
BMC Track-It! automatically tracks technician and system activity related to the Work Order and displays 
this information on the Audit Trail tab of the Work Order window.   The log includes who, what, when, 
and where activity took place.  Audit Trail information can also be used to generate reports.  You can also 
view the Audit Trail for all Work Orders in the Administration Console (see Viewing the Help Desk Audit 
Trail for Work Order Changes in the Administrator's Guide). 
To View a Work Order's Audit Trail: 
Accessing the Work Order Window 
  

1. Click the Audit Trail tab of the Work Order detail window. 
Activities display in reverse chronological order. 

The Audit Trail also displays information from BMC Track-It! e-mail conversation management 
(e-mails sent to and from Technicians, text messages sent to Technicians, and e-mails sent to 
and from Requestors).  You can click the message link to view the message contents. 

  
  
Creating Work Orders 

Creating Work Orders Workflow 

  
The flowchart below represents the tasks in the following topics.   
  

 
  

Documenting the Issue 

Documenting the Work Order Issue Workflow 

  
The flowchart below represents the tasks in the following topics.   
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Documenting the Work Order Issue 

  
When users contact you for assistance, you'll document the issue on the Work Order window in the Help 
Desk module.   The information you'll document includes: 
  

 Requestor's contact information 

 Requestor's asset information 

 Summary of the issue or request 

 Classification and prioritization of the issue 

 Detailed descriptions and notes 

 File attachments (supporting documents) 

To save time, you can create a Work Order from a Template (see Creating a Work Order from a 
Template). 
  
To Create a Work Order: 

1. Select New Work Order from the Tasks pane in the Help Desk module. 
You can also click the New button on the toolbar, or select File/New Work Order or CTRL+W. 

  
Next Topic:  Searching for the Requestor's Name and Viewing User Information for a Work Order 

Searching for the Requestor's Name and Viewing User Information for a Work Order 

  
To enter the requestor's name on a Work Order, you can either begin entering the first name in the 
Requestor field, or you can use the Search dialog to either view all users' names or search for a name. 
 As you are documenting the issue, you can view detailed information about the user (see Viewing User 
Information, below).   If your BMC Track-It! administrator has given you the appropriate permissions, you 
can add the requestor's contact information as well. 
  
  
To Enter the Requestor's Name: 

1. In the Requestor field, enter the first few letters of the requestor's name, then select it from the 
list if there are multiple names, OR 

2. Select the requestor's name from the Requestor drop-down list. 
  
To Search for the Requestor's Name: 
Note:  The Search Requestor dialog  automatically uses a wild card search to display all records.  See 
also Searching for Information in BMC Track-It! 
  

1. Click the Ellipses (...) button next to the Requestor field. 
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2. To view all users' names, click the Search button, or press the Enter key on the Search 
Requestor dialog. 

3. To search for a user, enter any part of the user's first or last name in the Search for text box, 
then press the Enter key or click the Search button. 
The search engine searches several fields, such as Full Name, Title, Phone, and Custom Text, 
so the results displayed will include users that with this information in their profile (see Viewing 
User Information, below).                  

4. To select the user, double click the user's name, or select the name and click the Select button, 
or press the Enter key. 
The Search Requestor dialog closes, and the user's name displays in the Requestor field of the 
Work Order window. 

  
To Add a New User: 

1. Click the Add (+) button next to  the Requestor field. 
2. Follow the instructions for the Edit User dialog (Editing User Properties and Manually Adding 

Users in the Administrator's Guide). 
  
To Select the Requestor's Call Back Number: 

1. Select the telephone number from the Call Back Number drop-down list. 
2. If a telephone number does not display, you can enter the number in the Call Back Number field. 
3. You can enter multiple telephone numbers.  Click the Save button on the toolbar to save each 

entry. 
  
To View User Information: 

1. Once the user's name displays in the Requestor field, double click the name. 
The Edit User dialog displays, showing the assets assigned to the user.  You can view additional 
user information on the General, Self-Service, and Graphic tabs.  (See (Editing User Properties 
and Manually Adding Users in the Administrator's Guide). 

  
Next Topic:  Selecting the Requestor's Asset and Viewing Asset Details 

Searching for the Requestor's Asset and Viewing Asset Details for a Work Order 

  
The Asset drop-down list in the Work Order window displays the assets assigned to a user, such as 
computers or other networked assets found in asset discovery as well as manually added assets (non-
networked assets such as DVD players).  As you are documenting the issue, you can view detailed 
information about the specific asset (see Viewing Asset Information, below). 
  
If a user is reporting an issue about an asset that is not displayed in the Asset drop-down list, you can 
search for the asset.  If your BMC Track-It! administrator has given you the appropriate permissions, you 
can add the requestor's asset as well. 
  
  
To Select the Requestor's Asset: 

1. In the Asset field, enter the first few letters of the asset's ID, then select it from the list if there are 
multiple IDs, OR 

2. Select the asset's ID from the Asset drop-down list. 
  
To Search for the Asset: 

1. Click the Ellipses (...) button next to the Asset field. 
2. Enter the Asset ID in the Search for text box of the Select User dialog, then press the Enter key 

or click the Search button. 
The users' names display in the Results grid. 
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3. Double click a user's name, or select a name and click the Select button, or press the Enter key. 
The Select User dialog closes, and the user's name displays in the Requestor field of the Work 
Order window. 

To Add the Asset: 
1. Click the Add (+) button next to  the Asset field. 
2. Follow the instructions for the Edit User dialog. 

 
See also Associating an Asset with a User. 

  
Viewing Asset Information: 

1. Once the asset ID displays in the Asset field, double click the ID. 
The Edit User dialog displays, showing the assets assigned to the user.  You can view additional 
user information on the General, Self-Service, and Graphic tabs. 

  
Next Topic:  Summarizing the Issue or Request 

Summarizing the Work Order Issue or Request 

  
Entering a brief summary of the issue or request enables you and other technicians to quickly locate the 
work order at a later time.  Text entries in the Summary field display in the Work Order grid and can be 
sorted alphabetically or filtered by key word.  You can also use the search feature to search for specific 
text in the Summary field.    For example, a user calls and reports that they cannot send or receive e-
mails.  You might want to summarize by entering "Cannot send or receive e-mails from Outlook".  When 
searching Work Orders at a later time, you can search for "e-mail", "Outlook", "send", etc. 
  
  
To Summarize the Issue or Request: 

1. In the Summary field, enter a brief description of the issue or request. 
  
Next Topic:  Classifying the Issue 
  
  
  

Prioritizing the Work Order 

  
You can prioritize a Work Order by defining its urgency and impact to your organization.  Priority levels 
are set up by your Administrator and indicate the level (such as "2-Urgent"), a resolution time (such as 45 
minutes), and hours of operation (7x24).  An example of an organization's Work Order priorities are as 
follows: 
  

1 -- Critical (30M 7x24) 
2 -- Urgent (45M 7x24) 
3 -- High (1H) 
4 -- Medium (4H) 
5 -- Low (# of hours equaling one business day) 
6 -- Project (No Date Due Defined) 

  
Your Track-It! Administrator may have set up Event Policies so that when a Work Order is created, Track-
It! matches the Work Order with criteria set up on the policies  to determine the Work Order's Due Date 
and Expected Completion Date.  Event Policies can be based on the following criteria:Requestor, 
Department, Location, Type, Subtype, Category, and Priority. 
The Event Policy displays above the Due Date if one is in place for the Work Order criteria.  
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See Setting up Work Order Event Policies in the Administrator's Guide.  
  
Your Track-It! Administrator may have also set up Skill Routing Policies. These are used to assign a 
specific Technician to Work Orders based on matching criteria (the same criteria used for Event Policies).  
  
  
  
To Prioritize the Work Order: 

1. Select an option from the Priority drop-down list on the Work Order window of the Help Desk 
module. 

  
Next Topic:  Adding Descriptions and Notes 
  
  
  

Adding Descriptions and Technician Notes to Work Orders 

  
In addition to the brief Summary description you can enter for a Work Order, you can add detailed Work 
Order descriptions and Technician Notes, including steps to reproduce the problem.  Technician Notes 
can be marked Private so that they can only be viewed by other technicians (and not by end users when 
Work Order information is e-mailed to them).  You can categorize the Work Order Description (e.g., 
Original Description or Additional Information). You can also categorize the Technician Note (e.g., 
Research).  
  
Notes display on the Notes panel in descending or ascending chronological order (depending on the Help 
Desk Journaling settings set up by your BMC Track-It! Administrator). Notes are color coded: Blue = Work 
Order Description; light yellow = Technician Note, and gray = e-mail conversation. 
  
You can also use shortcut keys (such as CTRL+Shift+N to place the cursor in the Notes field on a Work 
Order). 
  
You can edit and delete Description and Technician Notes depending on Journaling permissions set up 
by your BMC Track-It! Administrator. 
  
Notes are also created from e-mails to Requestors and Technicians from Work Orders.  See  E-mailing 
Work Order Details to Requestors and Technicians. 
  
To Add Description and Technician Notes: 

1. Select the Notes tab on the Work Order window of the Help Desk module, OR 
Press CTRL+Shift+N anywhere on the Work Order details window to place the cursor in the 
Notes field of the Notes tab (Notes Type:  Technician Note). 
Press CTRL+Shift+W anywhere on the Work Order details window to place the cursor in the 
Notes field of the Notes tab (Notes Type:  Work Order Description). 

2. Select Work Order Description from the Type drop-down list. 
a. Select an option from the Activity Code drop-down list to categorize the note (such as 

Additional Information or Original Description). 
b. Enter the note in the Notes text box. 

3. Select Technician Note from the Type drop-down list. 
a. Select an option from the Activity Code drop-down list to categorize the note (such as 

Research). 
b. Enter the note in the Notes text box. 

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&lang=EN
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4. By default, the Private checkbox for Technician Notes is not checked.  To change the note to 
Private so that only Technicians can view it (and not end users), click the Private checkbox. 

5. Click the Add Note button (or press CTRL+Enter). 
The note will display in the Notes panel. 

6. Click the Save button. 
  
To Edit a Description or Note: 
Note:  Notes created from e-mails or text messages from Work Orders cannot be edited.  Only the 
Private setting can be changed. 

1. Click the Edit button on the note you want to change, OR 
Press the Enter key while the note is selected to open the Edit Note dialog. 

2. You can change the Activity Code if necessary by selecting it from the drop-down list. 
3. Edit the information in the Notes text box. 
4. Check or uncheck the Private checkbox to change the note from Private to Public and vice versa. 
5. When you're finished with the edits, click the OK button. 

The Work Order window re-displays showing your changes. 
To Delete a Description or Note: 

1. Click the Delete button on the note you want to delete in the Notes panel, OR 
Select the note using the arrow keys, then press the Delete key.  Click Yes on the Delete 
Confirmation message.   

2. Click Yes on the confirmation dialog to delete the note or No to cancel the deletion. 
  
Next Topic:  Attaching Files to Work Orders 

Using Keyboard Shortcuts for Work Orders 

  
You can use the following shortcut keys specifically designed for Work Orders: 
  
Keyboard Key/ 
Key 
Combination 

Result 

CTRL+G 
  

Opens the Go to Work Order dialog.  Enter the number of  the Work Order to 
open it. 

CTRL+SHIFT+M Opens your e-mail editor with the Work Order details (addressed to the 
Requestor).  Edit the e-mail if desired before sending it. 

CTRL+SHIFT+N Places the cursor in the Notes text box of the Notes tab (Notes Type: 
 Technician Note) 

CTRL+SHIFT+W Places the cursor in the Notes text box of the Notes tab (Notes Type:  Work 
Order Description) 

CTRL+SHIFT+R Places the cursor in the Resolution text box of the Resolution tab 

CTRL+ENTER Adds the Note entered in the either of the Notes text boxes 

ENTER After selecting a saved Note, opens the Edit Note dialog 

CTRL+A Selects all text in the Notes or Resolution text boxes, as well as the Edit 
Note dialog 

ESC Closes the Edit Note dialog.  You can then choose whether to save the 
changes. 
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See also:  Adding Descriptions and Technician Notes to Work Orders, Documenting Work Order 
Resolutions, and Using Keyboard Shortcuts 

Spell Checking Work Order Notes 

You can spell check the Description and Technician Notes as well as Resolution notes. 
  
Accessing the Work Order Window 
  
To Spell Check Work Order Notes: 

1. After entering text, click in the notes text box, then press the F7 key. 
2. The Spelling dialog displays and works like any word processing application spell check tools. 
3. After you've made any necessary changes, click OK on the confirmation dialog indicating that the 

spell check is complete. 
  
  
  
  

Classifying the Work Order Issue 

  
After you have entered the Requestor's name, call back number, and summary of the issue, the next step 
is the classify the issue by Type, Subtype, and Category.  For example, if a user reports a problem that 
their computer's sound card is not working, you could classify the issue by:  Type (Problem), Subtype (PC 
Hardware), Category (Sound). 
  
Your Track-It! Administrator sets up the classifications.  The three-tiered structure (Type, Subtype, and 
Category) exists in a hierarchy.  Each level populates the next based on the value selected in the 
previous level.  For example, if the user is having a problem with a sound card, you would select the 
Subtype "PC Hardware" as the Type "Problem", and "Sound" as the Category, as shown below. 
  

Type 
Problem 

Subtype 
Application 
Network 
PC 
Hardware 

Category 
Display 
Sound 
UPS 

  
Classification enables you to sort and filter the list of Work Orders (grid) so you can quickly find a Work 
Order by the type of issue.  You can also use the search feature to search for specific text in the Type, 
Subtype, or Category fields. 
  
Administrators also use classification for Skill Routing Policies (to assign specific technicians to certain 
types of Work Orders).  (See Setting up Skill Routing Policies in the Administrator's Guide. 
  
To Classify the Issue: 
Notes:   
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 If your BMC Track-It! Administrator has given you the appropriate permissions, you can add 

values for Types, Subtypes, and Categories. 
  

  
1. Select the Classification and Schedule tab on the Work Order window of the Help Desk 

module. 
2. In the Classification and Schedule section, select an option from the Type drop-down list. 

Once you select the Type, the Subtype and Category values will change, based on the Type. 
3. Select an option from the Subtype drop-down list. 
4. Select an option from the Category drop-down list. 
5. Click the Save button on the toolbar. 

  
Next Topic:  Prioritizing the Work Order 
  
  

Assigning Technicians to a Work Order 

  
Your BMC Track-It! Administrator may have set up Skill Routing Work Order Policies so that Work Orders 
are automatically assigned to particular Technicians based on specific criteria, such as the Work Order 
Type.  For example, all Networking Work Orders would be automatically assigned to the Networking 
Group or Individual Technician, and all Desktop Work Orders to another group or Technician. (The 
Applicable Policies section on the Classification and Schedule tab on the Work Order window displays 
the name of the Skill Routing policy, if one is in place.)  However, if your Administrator has given you the 
necessary permissions, you can assign or re-assign a Technician to Work Order.  See Setting up Skill 
Routing Policies in the Administrator's Guide. 
  
To Assign a Technician to a Work Order: 

1. Select the Classification and Schedule tab on the Work Order window of the Help Desk 
module. 

2. In the Classification and Schedule section, select a Technician from the Technician Assigned 
drop-down list. 

3. Click the Save button. 
  
To Change Technicians in a Work Order: 

1. From the Classification and Schedule tab on the Work Order, select the Technician from the 
Assigned Technician drop-down list. 
 
If a Skill Routing policy is in place, as indicated on the Applicable Policies section, and the 
Assigned Technician does not match the Designated Technician based on the applicable Skill 
Routing Policy, an information icon next to the Technician's name will display.   
  

2. Click the Save button 
  
To Change Technicians from the Help Desk Grid 

1. From the Help Desk grid, select the Work Order, then 
a. Select the Change Technician link on the Tasks pane, OR 
b. Right click and select Change Technician from the context menu. 

  
2. The Assign Technician dialog displays.   

a. Double click the Technician's Name in the grid, OR 
b. Select a Technician from the list and click the Select button, OR 
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c. Enter the Technician's first or last name in the Search for: field and press the Enter key 
(or click the Search button), then click the Select button. 

  
To Reset the Skill Routing Policy's Designated Technician as the Work Order's Assigned Technician: 

1. Click the Apply button in the Applicable Policies section. 
2. Click the Save button 

  

Scheduling Work Order Due Dates and Times 

  
Some Work Orders are associated with Work Order Event Policies and Service Level Agreements 
(SLAs).  If so, the Work Order's due date is automatically calculated and displayed in the Due Date field. 
 (This is displayed on the Classification and Schedule tab of the Work Order under Applicable 
Policies).  You cannot edit the Due Date, but you can edit the Expected Completion Date. 
  
To Schedule a Work Order's Due Date and Time: 

1. Select the Classification and Schedule tab on the Work Order window of the Help Desk 
module. 

2. In the Classification and Schedule section, click the drop-down arrow of the Expected 
Completion Date field and select a date from the calendar. 
(You can also enter the date in the Due Date field without using the calendar.)  The calendar 
closes and the selected date displays. 

3. Click the Save button. 
  
See also:  Setting up Event Policies and Setting up Service Level Agreements (SLAs) 
  

Entering Custom Work Order Details (Custom Fields) 

  
Your BMC Track-It! Administrator can set up custom fields for Work Orders specific to your organization. 
  These fields display on the Classification and Schedule tab of the Help Desk module.  By default, the 
fields are labeled Lookup 1 through 6, Text 1 and 2, and Date 1 and 2.  Your Administrator can change 
the labels, so they will display according to your organization's specifications. 
To Enter Custom Work Order Details: 

1. Select the Classification and Schedule tab from the Work Order window. 
2. Enter the custom work order details in the Custom Fields section. 
3. Click the Save button. 

  
  

Attaching Files to Work Orders 

  
You can add files to Work Orders, such as text files, documents, or images.  You can also rename and 
delete file attachments. 
  
Accessing the Work Order Window 
  
To View Work Order Attachments: 

1. Right click the file on the Attachments tab, then select Open. 
  
Tip:  You can customize the grid view and add the # of Attachments column to quickly view which 
records have attachments.  See Showing and Hiding Columns in the Creating User-defined Views topic. 
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To Attach a File to a Work Order: 
1. Select the Attachments tab on the Work Order window of the Help Desk module. 
2. Click the Add button. 
3. In the Open Attachment dialog, navigate to the location of the file, then double click it, or select it 

and click the Open button. 
The file displays on the Attachments tab on the Work Order window. 

4. Click the Save button. 
  
To Rename a File Attachment: 

1. Right click the file on the Attachments tab, then select Rename. 
To Delete a File Attachment from a Work Order: 

1. Select the file on the Attachments tab, then press the Delete key.  Click Yes on the Delete 
Attachment(s) confirmation dialog. 

2. Click the Save button on the Work Order window. 
To Sort the List of Attachments: 

1. Click the column header (e.g. "Name"). 
To Change the Grid View of the List of Attachments: 

1. Right click anywhere on the Attachments tab, then select View. 
2. Select an option from the View menu (Text Only, Wrap Text, Auto Arrange). 

  
Next topic:  Spell Checking the Work Order 

Managing Work Order Assignments 

Adding Assignments to Work Orders 

  
If you have a complex Work Order that requires multiple tasks by various Technicians, you can add 
Assignments for each Technician and task.  For example, you might create a Work Order with 
Assignments as follows: 
  

WORK 
ORDER/ASSIGNMENTS 

TASKS TECHNICIAN 

Work Order #1 Set up new hire workstation Mike (Lead 
Technician) 

Assignment #1 Set up hardware/software John 
Assignment #2 Set up network and 

passwords 
Elizabeth 

Assignment #3 Set up telephone David 
  
Assignments are set up on the Assignments tab of the Work order window.  The Assignments form 
(window) and the Work order form are identical (with the exception of the Assignments tab on the Work 
Order form).  You can easily track the status of each Technician's Assignments by viewing them on the 
Assignments tab of the parent Work Order, or by viewing the individual Assignments from the Work Order 
grid view. 
  
A message displays when the last open Assignment is closed to inform you that the parent Work Order 
can be closed. 
  
In addition to adding Assignments from the Assignments tab for a specific Work Order, you can also 
create Assignments separately, then associate them to Work Orders.  See Re-associating Assignments 
to Work Orders. 
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You can also promote (convert) a Work Order Assignment to a Work Order, which disassociates it from 
the parent Work Order.  See Promoting Assignments to Work Orders. 
  
Tip:   You can filter, group, and sort the columns on the Work Order grid so that you can view which Work 
Orders have Assignments, status of each Work Order and Assignment, Technicians assigned, etc. 
To Add an Assignment to a Work Order: 

1. Open the specific Work Order from the Work Order grid of the Help Desk module. 
2. Select the Assignments tab on the Work Order window, then click the Add button. 
3. Complete the Assignments form as you would for the Work Order form, then click the Save 

button. 
The Assignment title bar displays the Assignment ID number. 
Tip:  You can view the Parent work order by clicking the arrow next to the ID field on the 
Assignments window 

4. When you close the Assignment window, the Assignments tab on the Work Order window 
displays a grid of all of its Assignments in descending chronological order. 

  
To View Assignments on a Work Order: 

1. Select the Assignments tab on the Work Order window. 
 
The Assignments display in a grid.  You can customize the grid as you would for the Help Desk 
grid (the available fields are the same).  For more information, see step 3 in Showing and Hiding 
Columns in Creating User-defined Views. 

  
To Delete Assignments from a Work Order: 

1. Select the Assignment from the Assignments tab on the Work Order window, then click the 
Delete icon (X). 

2. Click OK when the Delete Work Orders confirmation message displays. 
  
Next Topic:  Assigning Work Orders (Converting Work Orders to Assignments) 
  
See Also:  Copying Work Orders and Assignments 

Assigning Work Orders (Converting Work Orders to Assignments) 

  
You can convert Work Orders to Assignments by assigning them to other Work Orders.  This is useful, for 
example, if there are several Work Orders or Assignments that are actually sub tasks of a specific parent 
Work Order. 
  
Notes:   

• You cannot assign an open Work Order to a closed one, nor can you associate an assignment to 
another assignment. 

  
Accessing the Work Order Window 
To Assign Work Orders: 

1. Select the Assignment (or Work Order) from the Work Order grid of the Help Desk module. 
2. Click the Assign to Work Order hyperlink on the Tasks pane, OR 

Right click and select Assign to Work Order. 
3. On the Assign to Work Order dialog, search for the Work Order by ID or keyword. 

For more information on searching, see Searching for Information. 
4. Select the desired Work Order, then click the Select button. 

The Assign to Work Order dialog closes and the Work Order grid displays. 
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Closing Work Order Assignments 

  
Essentially, the steps to close a Work Order Assignment are the same as closing stand-alone Work 
Orders.  However, all Assignments must be closed before the Work Order can be closed.   
  
Refer to the following topics on completing Work Orders: 
  

• Closing Work Orders Overview 
• Closing Work Orders 
• Reopening Closed Work Orders 

  
Note:  You cannot reopen a closed Assignment if the parent Work Order is closed.  You can 
reopen the parent Work Order, then reopen the Assignment. 

   
Notes: 
  

• If you attempt to close a Work Order without closing its Assignments, the Close Open 
Assignments confirmation dialog will display asking if you want the Assignment(s) to be closed 
automatically.  If you select Yes, the Close Open Assignments confirmation dialog displays. 
 Select Yes to complete the Assignment(s). 

   
  
  
  
  
  

Promoting Assignments to Work Orders 

  
You can promote (convert) a Work Order Assignment to a Work Order, which disassociates it from the 
parent Work Order. 
  
To Promote an Assignment to a Work Order: 

1. Select the Assignment from the Work Order grid of the Help Desk module. 
2. Click Promote Assignment on the Tasks pane, OR 

Click the Promote Assignment icon on the toolbar, OR 
Right click and select Promote Assignment. 

3. Click Yes on the confirmation dialog. 
 
The Assignment is converted to a Work Order, and the Work Order detail window opens.  The 
title bar displays the Work Order number.  An entry displays in the Audit trail tab for the new Work 
Order that the Assignment was promoted.  The Assignment is removed from the Assignments tab 
of the parent Work Order.  The Audit Trail tab for the parent Work Order also shows that the 
Assignment was promoted.  Any hours and charges for parent Work Order will change 
appropriately. 

  
  

Saving Tab Layouts for Work Orders 
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In addition to customizing tab displays, you can arrange and save tab layouts for new and existing Work 
Orders and Assignments.  Once you save the tab layouts, when you create a new Work Order or 
Assignment, the tabs will display according to your settings. 
  
For example, you might want to arrange the tabs for new Work Orders with the following tabs: 
  
Classification 
and 
Schedule 

Requestor Notes   Attachments     

        

Example:  Tab Layout for New Work Orders 
  
You could arrange existing Work Orders to include the Assignments, Resolution, and Audit Trail tabs on 
the right pane. 
  
Classification 
and 
Schedule 

Requestor Notes   Assignments Audit Trail Resolution 

        

Example:  Tab Layout for Existing Work Orders 
To Save Tab Layouts for Work Orders: 

1. Arrange the tabs on the left and right pane (see the previous topic Customizing Tab Displays). 
2. From the Tab Layout button on the menu bar, select any of the following options: 

  
 Save as New Work Order 
 Save as New Assignment 
 Save as Edit Work Order 
 Save as Edit Assignment 

  
Depending on the layout you saved above, the new tab layout will persist when the window is 
reopened. 

Creating a Work Order from a Template/Creating Templates 

Creating a Work Order from a Template 

You can use work order templates to save data entry time when documenting recurrent issues.  For 
example, you can select work order templates with pre-populated information for resetting user 
passwords, replacing network components, restoring lost data, and other types of issues that may 
commonly occur within your organization. 
  
Important:  You can apply a template at any time, even for existing work orders.  However, any values 
existing in the template will replace the values in the work order. 
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To Use a Work Order Template: 
1. Select Template from the Actions menu on the Work Order window tool bar, then select the 

Template name. 
 
The Work Order displays with the pre-populated fields from the template.  The Assignments tab 
displays an information icon with a message that the Work Order must be saved in order to view 
the assignments. 

2. Click the Save button 
 
The assignments display in a grid on the Assignments tab.  The grid can be customized (to 
display more columns, for example).  (See Creating User-defined Grid Views.) 
 
You can change any of the values on the Work Order if necessary. 
  

3. When you are finished entering information, click the Save button on the toolbar. 
  
Next Topic:  Entering the Requestor's Contact Information 
  
See also:  Creating Work Order Templates in the Administrator's Guide and Copying Work Orders and 
Assignments in the Technician's Guide. 

Creating Work Order Templates 

  
You can create work order templates so that technicians can save data entry time when documenting 
recurrent issues.  For example, technicians can select work order templates with pre-populated 
information for resetting user passwords, replacing network components, restoring lost data, and other 
types of issues that may commonly occur within your organization.  Work Order Templates can also 
contain Assignments.  (See Adding Assignments to Work Orders.) 
  
You can create Work Order Templates from the Help Desk module or from the Administration Console. 
 You can also create them based on an Event Policy in  the Event Policies panel in the Administration 
Console.  (See Setting up Work Order Event Policies). 
  
Certain fields are unavailable while you are creating the template so that they can be selected when 
creating new work orders from them.  These are: 
  

 Asset 
 Call Back Number 
 Date Completed 
 Department Number 
 Expected Completion Date 
 Technician Assigned 

  
To Create a Work Order Template from the Help Desk Module: 

1. Select New Work Order from the Tasks pane in the Help Desk module. 
2. Select Template from the Actions menu on the Work Order window tool bar, then click Select 

Template. 
3. Click the New button on the Apply Template dialog box. 
4. Complete the Work Order form as described in the topic Documenting the Issue in the 

Technician's Guide. 
  
To Create a Work Order Template from the Administration Console: 

1. From the main menu bar, select Tools/Administration Console/Lookup Tables/Help 
Desk/Work Order Templates. 

2. Click the Add button on the Work Order Templates panel. 
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3. Complete the Work Order form as described in the topic Documenting the Issue in the 
Technician's Guide. 

To Create a Work Order Template from an Event Policy (Administration Console): 
1. From the main menu bar, select Tools/Administration Console/Lookup Tables/Help 

Desk/Event Policies. 
2. Select the Event Policy and click the Add (or Edit button for existing Event Policies). 
3. Click the Create Template button. 
4. Complete the Work Order form as described in the topic Documenting the Issue in the 

Technician's Guide. 
  
See also:  Creating a Work Order from a Template in the Technician's Guide. 
  
  

Copying Work Orders and Assignments 

  
You can copy work orders and assignments to save data entry time.  All attributes of a Work Order or 
Assignment will be copied, including attachments, except for the following (in reference to the Technician 
and Date information). 
  

Technician Information Dates 
Opened By 
Last Modified By 
Closed By 

Date Entered 
Date Opened 
Date Assigned 
Modified On 
Estimated Completion Date 
Date Completed 

  
To Copy a Work Order: 

1. Right click the Work Order from the Work Order grid and select Copy. 
You can also select the Work Order and press CTRL+C, OR 
Click the Copy icon on the main toolbar, OR 
Click Copy on the Tasks pane. 

2. On the Copy Work Order dialog, select or enter the number of copies to make. 
3. To also copy the Attachments associated with the Work Order, click the Include Attachments 

check box. 
4. Click the OK button. 

The copied Work Order(s) display in the Work Order grid, and are automatically assigned a Work 
Order ID (a system-generated consecutive number).  You can edit the copied Work Orders as 
necessary.   

  
  
  
  
Sending Messages to Technicians and Requestors from Work Orders 

E-mailing Work Order Details to Requestors and Technicians 

  
You can e-mail Work Order details to Requestors and Technicians, as well as other recipients, from BMC 
Track-It!   The message contains pre-populated information (e.g.,the Work Order Number, Summary, 
Description, and Status), as well as your own messages.  BMC Track-It! provides e-mail conversation 
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management so that messages and responses are captured on the Work Order Notes and Audit Trail 
tabs. 
  
Notes:   
  

• Make sure the recipients' e-mail and/or SMS addresses are specified, which can be set up by 
double clicking the user name link on the Work Order and going to the Notification tab on the 
Technicians dialog.  See Setting the Technician's E-mail Address for Notifications. 

• The Work Order Monitor and E-mail Monitor determine the frequency that messages are sent and 
received.  These settings are configured by your BMC Track-It! Administrator in the 
Administration Console. 

• You can configure the E-mail Templates for the Technician and Requestor from the Send 
Technician E-mail Message or Send Requestor E-mail Message dialogs (without having to go 
to the Administration Console).  See Configuring the E-mail Template, below. 

• You can edit and delete Description and Technician Notes depending on Journaling permissions 
set up by your BMC Track-It! Administrator. 

To E-Mail Work Order Details: 
You can send e-mails from the Work Order grid or within a Work Order. 

1. From the Help Desk module Work Order grid: 
a. Select the Work Order. 
b. Right click and select E-mail Requestor or E-mail Technician, OR 

Click the E-mail Requestor or E-mail Technician icon on the toolbar, OR 
Select E-mail Requestor or E-mail Technician from the Tasks pane. 

2. Alternatively, from the Work Order detail window, click the E-mail Requestor icon or select E-
mail from the E-mail Technician icon on the toolbar. 

3. On the Send Technician E-mail Message or Send Requestor E-mail Message dialog: 
Note:  When sending messages to the assigned Technician or Requestor, their e-mail addresses 
are set by default -- you don't have to enter them. 

a. Enter the e-mail addresses of recipients in addition to the assigned Technician in the Cc 
and Bcc fields (optional). 
(You can enter multiple e-mail addresses separated by commas or semi-colons.) 
To save these as the default e-mail addresses for this Work Order, click the Save e-mail 
addresses...check box. 

b. Enter a message in the text box. 
The text you enter will be added to the e-mail content automatically generated, which is 
based on the Manual Notification template. (See Configuring E-mail Templates if you 
want to change the default text.) 

c. Click the Preview button to view the message, then click the OK button. 
d. Messages addressed to the assigned Technician are marked Private by default (so that 

so that only Technicians, and not end users, can view them.  To mark the message 
Public, click the Private checkbox to deselect it. 

e. The Work Order's Attachments are included in the message by default.  To exclude the 
them, click to deselect the Include attachments... checkbox. 

f. Click the Save button. 
4. Click the Save button on the Work Order. 

  
To View Sent or Received Messages and Mark Them Private or Public: 
Once the Work Order is saved, the Work Order Notes tab displays the E-mail message note type (in 
gray) as "queued", the date and time, your name, and the additional message you entered.  When the 
Work Order Monitor sends the message, the Notes display the date and time the message was sent.   

  
When the recipient(s) receive the e-mail message, they can reply to the message and the information will 
be appended to the Work Order (on the Work Order Notes tab). 
  

1. To view the sent or received message contents, click the Edit button on the message. 
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2. If you want to change the message from Private to Public or vice versa, click the Private 
checkbox. 

To Delete Notes Created from Messages: 
1. Click the Delete button on the message note you want to delete in the Notes panel (these are 

highlighted in gray), OR 
Select the note using the arrow keys, then press the Delete key.  Click Yes on the Delete 
Confirmation message.   

2. Click Yes on the confirmation dialog to delete the note or No to cancel the deletion. 
3. Click the Save button on the Work Order. 

Texting Work Order Details to Technicians 

  
You can text Work Order details from BMC Track-It! to the assigned Technicians' mobile device.  The 
message contains pre-populated information (e.g.,the Work Order Number, Summary, Description, and 
Status), as well as your own message.  BMC Track-It! provides e-mail conversation management so that 
text messages are captured on the Work Order Notes and Audit Trail tabs. 
  
Notes:   
  

• If the Technician replies to the text message via his/her mobile device, the message will not be 
captured on the Notes panel (only text messages sent from BMC Track-It! are captured). 

• Make sure the Technician's SMS address is specified, which can be set up by double clicking the 
Technician's name link on the Work Order and going to the Notification tab on the Technicians 
dialog.  See Setting the Technician's E-mail Address for Notifications. 

• The Work Order Monitor and E-mail Monitor determine the frequency that messages are sent and 
received.  These settings are configured by your BMC Track-It! Administrator in the 
Administration Console. 

• You can configure the text message template from the Send Technician E-mail Message dialog 
(without having to go to the Administration Console).  Configuring E-mail Templates. 

  
To Text Work Order Details to Technicians: 
You can send text messages from the Work Order grid, or within a Work Order. 

1. From the Help Desk module Work Order grid: 
a. Select the Work Order. 
b. Select E-mail Technician, then select Text Message (SMS) from the Tasks pane, OR 

Right click and select E-mail Technician, then select Text Message (SMS), OR 
Click the E-mail Technician icon on the toolbar, then select Text Message (SMS). 

2. Alternatively, from the Work Order detail window, select Text Message (SMS) from the E-mail 
Technician icon on the toolbar. 

3. On the Send Text Message (SMS) dialog: 
Note:  When sending messages to the assigned Technician, his/her SMS address is set by 
default -- you don't have to enter it. 

a. Enter a message in the text box. 
The text you enter will be added to the e-mail content automatically generated, which is 
based on the Manual Notification template. (See Configuring E-mail Templates if you 
want to change the default text.) 

b. Click the Preview button to view the message, then click the OK button. 
c. Messages addressed to the assigned Technician are marked Private by default (so that 

so that only Technicians, and not end users, can view them.  To mark the message 
Public, click the Private checkbox to deselect it. 
This can also be changed after the message is sent.  See To View Sent Messages, 
below. 

d. Click the Save button. 
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To View Sent Messages and Mark Them Private or Public: 
Once the Work Order is saved, the Work Order Notes tab displays the text message note type (in gray) 
as "queued", the date and time, your name, and the additional message you entered.  When the Work 
Order Monitor sends the message, the Notes display the date and time the message was sent.   
  

1. To view the sent message contents, click the Edit button on the message. 
2. If you want to change the message from Private to Public or vice versa, click the Private 

checkbox. 
  
To Delete Notes Created from Messages: 

1. Click the Delete button on the message note you want to delete in the Notes panel (these are 
highlighted in gray), OR 
Select the note using the arrow keys, then press the Delete key.  Click Yes on the Delete 
Confirmation message.   

2. Click Yes on the confirmation dialog to delete the note or No to cancel the deletion. 
3. Click the Save button on the Work Order. 

  
Printing Work Orders 
  
To Print Work Orders: 

1. From the Help Desk module, select the Work Order, then select Print from the Tasks pane, OR 
Right click and select Print, OR 
Click the Print icon on the toolbar. 

  
  
  
  
  
  
  
Closing Work Orders 

Closing Work Orders Overview 

  
In BMC Track-It!, finalizing Work Orders can be a multi-step process, depending on your organization. 
 Typically, once all tasks are complete on a Work Order, including any Work Order Assignments, help 
desk technicians enter the following information on the Work Order: 
  

1. Document the issue's resolution 
2. Enter billing information if applicable 
3. Enter the date the Work Order was completed 
4. Change the Work Order's status (to Closed or other available statuses) 

  
Note:  In BMC Track-It!, there are two default statuses for Work Orders:  Open and Closed. 
 Your BMC Track-It! Administrator can create additional statuses to help you differentiate Work 
Orders, such as Pending (see Defining Work Order Statuses in the Administrator's Guide).   

  
5. You can also reopen closed Work Orders, if necessary. 

  
Once the completion date is entered on a Work Order, they display on system views, charts, and reports. 
 For example, you can view a list of Closed Work Orders in the Work Order grid of the Help Desk module, 
the Closed Work Order Count chart in the Dashboard module, and the Closed Work Orders by Technician 
report in the Reports module.  (Reports use the Work Order's Date Completed entry). 
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Next Topic:  Documenting Work Order Resolutions 
  
See also:  Reopening Closed Work Orders 
  

Documenting Work Order Resolutions 

  
While the Description and Technician Notes tab is typically used to describe an issue, the Resolution 
tab enables you to describe exactly how you solved the problem.  This information may help you and 
other technicians in similar situations.  Additionally, by keeping the issue's description separate from the 
resolution, you can add your resolution to the Solutions module.  If a solution already exists, you can use 
it as your Work Order's resolution. 
  
You can also use shortcut keys (such as CTRL+Shift+R to place the cursor in the Resolution field of the 
Resolution tab. 
  
Notes:   

• You can edit and delete Resolution Notes depending on Journaling permissions set up by your 
BMC Track-It! Administrator. 

To Document a Work Order's Resolution: 
1. Open the Work Order or Assignment and select the Resolution tab, OR 

Press CTRL+Shift+R anywhere on the Work Order details window to place the cursor in the 
Resolution field of the Resolution tab. 

2. Select an option from the Resolution Code drop-down list. 
Resolution Codes are set up by your BMC Track-It! Administrator for reporting purposes.  For 
example, if the issue was resolved by installing software, you could select Installation.  If the 
issue was user error, you could select Training. 

3. Enter your steps to resolve the issue in the Notes text box, then click the Add Note button, OR 
Enter a note in the text box, then press CTRL+Enter.  The note will display in the Notes panel 
descending chronological order. 
 
Unlike Descriptions and Technician Notes, Resolutions are public and cannot be marked private. 
 This means Resolutions will be visible in the Self Service Web for end users. 
  

4. Click the Save button. 
To Edit Resolution Notes: 

1. Click the Edit icon on the top right of the Resolution Note, OR 
Press the Enter key while the note is selected to open the Edit Note dialog. 

2. You can change the Activity Code if necessary by selecting it from the drop-down list. 
3. Edit the information in the Notes text box. 
4. When you're finished with the edits, click the OK button. 

The Resolution Tab re-displays showing your changes. 
  
To Delete a Resolution Note: 

1. Click the Delete button on the note you want to delete in the Notes panel, OR 
Select the note using the arrow keys, then press the Delete key.  Click Yes on the Delete 
Confirmation message.   

2. Click Yes on the confirmation dialog to delete the note or No to cancel the deletion. 
  
See also:  Creating Work Order Resolutions from Solutions and Creating Solutions from Work Order 
Resolutions 
   

Entering Work Order Billing Information (Hours and Charges) 
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For reporting purposes, your BMC Track-It! Administrator may require you to enter the amount of time you 
spend on a Work Order or Assignment.  The Administrator can also set up an hourly charge per 
Technician and/or Technician Group.  The total charge is automatically calculated when you enter your 
hours. 
  
Note:  Hours and charges are cannot be manually entered or changed on Work Orders that have 
Assignments.  This is because the parent Work Order's billing information is cumulative based on the 
values entered on the Assignments and is calculated by the system. 
To Enter Billing Information: 
Accessing the Work Order Window 
  

1. Open the Work Order if it has no Assignments, or the Assignment if it has a parent Work Order. 
2. Select the Resolution tab, and enter the number of hours spent in the Hours field. 
3. The Charge is automatically calculated and displays in the Charge field.  If it does not, you can 

manually enter it.   
(Check with your BMC Track-It! Administrator if an hourly rate needs to be established). 

4. Click the Save button. 
  
Next Topic:  Closing Work Orders 

Closing Work Orders 

Note:  All Work Order Assignments must be closed before the parent Work Order can be closed. 
  
You can close a Work Order from the Work Order grid, or from the Work Order window.  You can change 
the  Work Order's status from Open to Closed, or to any other status as set up by your BMC Track-It! 
Administrator. 
To Close a Work Order: 
Accessing the Work Order Window 
  

1. To change the status on the Work Order detail window, either click the Change Status to 
"Closed" button on the toolbar, or select "Closed" from the Status drop-down list. 
 
Once "Closed" is selected, the Date Completed field on the Classification and Schedule tab 
automatically displays the current date and time, but can be changed.   
  

2. To change the status from the Work Order grid: 
 Right click the Work Order, then select Change Status, OR 
 Select the Work Order, then click Change Status on the Tasks pane, OR 
 Select the Work Order, then click the Change button on the toolbar, and select Change 

Status. 
3. On the Change Status dialog, select Closed from the Status drop-down list. 
4. To add an optional Description or Technician note, select the note type from the Type drop-

down list, then enter the note in the Note text box. 
5. To categorize the note, select  the code from the Activity Code drop-down. 
6. To mark the note private, click the Private check box (the note will only be visible to Technicians 

and not end Users in e-mails and Self Service Web) 
7. When you are finished, click the OK button. 

 
The note displays on the Work Order's Description and Technician Notes tab. 

8. Click the Save button on the Work Order window. 
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The Audit Trail tab displays the date and time the Work Order's Status was changed and by 
whom. 

  
Next Topic:   Reopening Closed Work Orders 

Reopening Closed Work Orders 

  
If necessary, you can reopen a closed work order. 
To Reopen a Closed Work Order: 

1. To reopen a Work Order on the Work Order detail window, either click the Change Status to 
"Open" button on the toolbar, or select "Open" from the Status drop-down list. 
 
The Date Completed field on the Classification and Schedule tab is cleared. 
  

2. To change the status from the Work Order grid: 
 Right click the Work Order, then select Change Status, OR 
 Select the Work Order, then click Change Status on the Tasks Pane, OR 
 Select the Work Order, then click the Change button on the toolbar, and select Change 

Status. 
3. On the Change Status dialog, select Closed from the Status drop-down list. 
4. To add an optional Description or Technician note, select the note type from the Type drop-

down list, then enter the note in the Note text box. 
5. To categorize the note, select  the code from the Activity Code drop-down. 
6. To mark the note private, click the Private check box (the note will only be visible to Technicians 

and not end Users in e-mails and Self Service Web) 
7. When you are finished, click the OK button. 

 
The note displays on the Work Order's Description and Technician Notes tab. 

8. Click the Save button on the Work Order window. 
 
The Audit Trail tab displays the date and time the Work Order's Status was changed and by 
whom. 

  
See also:  Closing Work Orders 
  
Deleting Work Orders 
If your BMC Track-It! Administrator has given you the necessary permissions, you can delete Work 
Orders.   
  
Important Note:  Deleting a Work Order also deletes its assignments. 
To Delete a Work Order: 

1. Right click the Work Order from the Work Order grid and select Delete. 
You can also select the Work Order (or multiple Work Orders) and press Delete, OR 
Click the Delete icon on the main toolbar, OR 
Click Delete on the Tasks pane. 

2. The Delete Work Order confirmation dialog displays.  Click OK to delete the Work Order(s) and 
any Attachments. 

Viewing and Printing Help Desk Reports 
Note:   Technicians will only be able to view the report details for those they are privileged to view (based 
on Module, Location, Department, and Assigned Technician as set up by the BMC Track-It! 
Administrator).    
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You can view and print the following Help Desk Reports: 
                                

 Assets Ranked by Number of Logged Work Orders 
 Average Hours to Complete Work Orders by Technician 
 Average Hours to Complete Work Orders by Week 
 Average Response Time by Technician 
 Average Time to Complete Work Orders by Month 
 Calls Closed Summary by Date by Technician 
 Calls Closed Summary by Hour by Technician 
 Calls Received Summary by Date by Technician 
 Calls Received Summary by Hour by Technician 
 Closed Work Orders in SLA Violation 
 Completed Work Orders by Department 
 Completed Work Orders by Location 
 Completed Work Orders by Month 
 Completed Work Orders by Technician 
 Completed Work Orders with Department SLAs 
 Completed Work Orders with Requestor SLAs 
 Departmental Work Order Cost 
 Open SLA Violations 
 Open Work Order Aging 
 Open Work Orders by Date Entered 
 Open Work Orders by Due Date 
 Open Work Orders by Priority 
 Open Work Orders by SLA 
 Open Work Orders by Status 
 Open Work Orders by Technician 
 Overdue Work Orders by Date Entered 
 Overdue Work Orders by Due Date 
 Overdue Work Orders by Priority 
 Overdue Work Orders by Status 
 Overdue Work Orders by Technician 
 Technician Work Order Totals by Week 
 Total Work Orders by Priority by Month 
 Total Work Orders by Priority by Week 
 Total Work Orders Opened by Month 
 Total Work Orders Opened by Week 
 Unassigned Work Orders by Due Date 
 Users Ranked by Number of Logged Work Orders 
 Work Order Status by Department 
 Work Order Status by Location 
 Work Order Status by Technician 
 Work Order Summary Count 
 Work Order Trends by Technician 
 Work Order Trends by Type 
 Work Orders Closed within 1 Hour 

To View Help Desk Reports: 
1. Select the Reports module from the Navigation pane. 
2. Select Help Desk from the Reports by Module drop-down list above the Reports grid. 
3. Double click the report you want to view. 

  
See Also:   Reports Overview 
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Managing Work Orders with BMC Track-It! Web 
  
In addition to BMC Track-It! Technician Client, you can use BMC Track-It! Web so that you can 
troubleshoot and solve IT issues while not at your desk.  When you're back at your desk, you can manage 
any of the Work Orders you created or edited in BMC Track-It! Web from the BMC Track-It! Technician 
Client. 
  
Note:  Online help is available once you log in to BMC Track-It! Web (and is separate from the BMC 
Track-It! Technician Client online help).  The topics in the online help are also available in the BMC Track-
It! Web Technician's Guide (PDF) on the Product Documentation section of our Support Web page  
  
To Access BMC Track-It! Web: 

1. Go to the URL provided by your BMC Track-It! Administrator (typically 
http://servername/TrackItWeb/ where "servername" is the name of the server). 

2. Enter your user name and password and click the Login button. 
 
The BMC Track-It! Web home page displays. 

  
  
  
  

Maintaining Work Order Solutions 

Adding and Maintaining Work Order Solutions 
  
The Solutions module enables Technicians to maintain a database of solutions to common work order 
issues.  With the Solutions module, you can: 
  

 Add solutions and attach files 
 Find Previous Solutions to Work Order Issues 
 Create solutions from Work Order resolutions 
 Create Work Order resolutions from solutions 

  
Note:  Your BMC Track-It! Administrator can configure Self Service Web to allow end users to view 
attachments to Solutions. 
Adding Solutions 
To Add Solutions Directly in the Solutions Module: 
You can add solutions in the Solutions module, or you can create a solution from Work Order resolutions. 
  

1. Select the Solutions module from the Navigation Pane of the BMC Track-It! Technician Client. 
 
Solutions are displayed in a hierarchical structure as topics (book icons) and solutions (page 
icons).  The top-level topic is called the Root topic.  You can add sub-topics in multiple levels 
beneath the Root topic.  For example, you can create sub-topics called Hardware, Software, 
Network, etc., and sub-topics for each of these (such as PCs, Printers, and Routers under the 
Hardware sub-topic. 

Creating Topics 
1. To create a new topic, select New Topic from the Tasks pane, OR 

Right click a topic (book icon) and select New Topic. 
2. In the Topic Detail dialog, the Parent Topic is displayed in the indicated field.  To select a 

different Parent Topic, click the Ellipses button, select the topic from the Choose Parent Topic 
dialog, then click the OK button. 

3. Enter a name for the new topic in the Topic Name field of the Topic Detail dialog. 
  

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=105&Offering=2&lang=EN
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Creating Solutions 
  

1. Right click on a Topic (book icon), and select New Solution. 
2. In the Solution Detail dialog, enter a description for the solution in the Summary text box. 
3. To select a different Parent Topic, click the Ellipses button, select the topic from the Choose 

Parent Topic dialog, then click the OK button. 
4. Enter a detailed description for the solution in the Details text box. 

Attaching Files to Solutions 
  

1. If the Solution is not already open, double click the Solution icon (page icon) to open it. 
2. To attach a file to a Solution, click the Insert button in the Attachments section of the Solution 

Detail dialog. 
3. Navigate to the file from the Open Attachment dialog, then double click the file or click the Open 

button. 
The file name displays in the Attachments section of the Solution Detail dialog. 

4. Click the Save button. 
Organizing Topics and Solutions 
You can move Topics up and down the hierarchy. 
  
To Organize Topics and Solutions: 

1.  Click and drag the Topic or Solution to the parent topic. 
Editing Topics and Solutions 
To Edit Topic Names: 

1. Double click to open the Topic, OR 
2. Right click and select Edit. 
3. In the Topic Detail dialog, change the text in the Topic Name field, then click the Save button. 

  
To Edit Solutions: 

1. Double click to open the Solution, OR 
2. Right click and select Edit. 
3. In the Solution Detail dialog, make the desired changes, then click the Save button. 

  
Deleting Topics and Solutions 
To Delete a Topic: 

1. Right click the Topic (book)  icon, then select Delete. 
2. If you want to delete the topic and all of its contents, click the Yes button on the Confirmation 

dialog 
  
To Delete a Solution: 

1. Right click the Solution (page) icon, then select Delete. 
2. Click the Yes button on the Confirmation dialog to delete the Solution. 

Making Solutions Private or Public 
The following explains how to create solutions in the Solutions module.  You can also create solutions 
from Work Order resolutions.  You can make a solution private so that only Technicians can view it.  (By 
default, solutions are public -- end users can view them if they have permissions to Self Service Web.) 
To Make a Solution Private: 

1. Right click the Solution (page icon) in the Solutions list, select Set Solution State, then select 
Private. 
Private solutions are indicated by a page icon with a red circle-backslash symbol. 

2. To set the Solution state of all the Solutions in a Topic at once, select the parent Topic (book 
icon) directly above the set of Solutions, select Set Solution State, then select Private. 
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To Make a Private Solution Public: 
1. Right click the Solution (page icon) in the Solutions list, select Set Solution State, then select 

Public. 
  
See also:  Creating Solutions from Work Order Resolutions (BMC Track-It! Web) and Creating Work 
Order Resolutions from Solutions (BMC Track-It! Web) 

Finding Previous Solutions to Work Order Issues 
  
You can search for Solutions from the Search field and Search button on each module's toolbar (Help 
Desk, Inventory, Solutions, etc.), as well as from individual windows, such as Work Orders or Assets.    
To Search for Solutions: 

1. Enter the search term in the Search field (main toolbar), then select Solutions from the Search 
button's drop-down list. 
(The Search button displays the name of the last search, such as Search Asset, or Search 
User).  The Search Solutions dialog opens and displays the search results.  

2. Double click (or right click and select Open) to view the Solution. 
  
  
  

Creating Solutions from Work Order Resolutions 
  
If you have resolved a common Work Order issue, you can add the resolution to the Solutions module. 
To Create a Solution from a Work Order: 
Accessing the Work Order Window 
  

1. On the Resolution tab of the Work Order, click the Make Solution icon. 
2. On the Choose Parent dialog, click the Expand button (+) next to the Root topic icon, and 

continue expanding the topics until you find the one that best categorizes the resolution, then 
click the OK button. 

3. On the Solution Detail dialog, click the Save button (you can make any edits as necessary first). 
  
  

Creating Work Order Resolutions from Solutions 
  
You may find that there are common resolutions to an issue that already exist in the Solutions module. 
 You can insert a Solution directly into a Work Order as the Resolution. 
To Create a Work Order Resolution from a Solution: 

1. On the Notes tab of the Work Order, click the Insert Solution button. 
2. On the Insert Solution dialog, enter the search term in the Search for: field, then click the 

Search button. 
3. Double click (or right click and select Open) to select the Solution. 

  

Printing Solutions to Work Orders 
  
To Access the Solutions module: 
  

1. Select the Solutions module from the left pane of the BMC Track-It! Technician Client window. 
To Print Solutions: 

1. Select the Solution, then click the Print Solution icon on the toolbar, OR 
Right click the Solution, and select Print. 
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Maintaining Solutions with BMC Track-It! Web 
  
In addition to BMC Track-It! Technician Client, you can use BMC Track-It! Web to maintain Solutions. 
When you're back at your desk, you can manage any of the Solutions you created or edited in BMC 
Track-It! Web from the BMC Track-It! Technician Client. 
  
Note:  Online help is available once you log in to BMC Track-It! Web (and is separate from the BMC 
Track-It! Technician Client online help).  The topics in the online help are also available in the BMC Track-
It! Web Technician's Guide (PDF) on the Product Documentation section of our Support Web page 
marasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&la
ng=EN  
To Access BMC Track-It! Web: 

1. Go to the URL provided by your BMC Track-It! Administrator (typically 
http://servername/TrackItWeb/ where "servername" is the name of the server). 

2. Enter your user name and password and click the Login button. 
 
The BMC Track-It! Web home page displays. 

  
  
  
  

Purchasing: Managing Purchases 

Purchasing Module Overview  
  
You can create and track purchase orders with the Purchasing module, which is integrated with the 
Inventory module and Software License Management modules.  If you have a license for the Software 
License Management module, once the software is recorded in the Purchasing module, BMC Track-It! 
automatically populates the Software module with the names and number of licenses purchased.  (See 
Software Module Overview in the Administrator's Guide). 
  
Your BMC Track-It! Administrator configures the following Purchasing Lookup Tables so that you can 
quickly and easily create Purchase Orders (see the Purchasing chapter in the Administrator's Guide): 
  

 Vendors 
 Products (Master Items and Product Types) 
 Default Tax Rates 
 Default Shipping and Billing information 
 Automatic creation of purchase order numbers 
 Associate Software titles with Master Items 

Purchasing Steps Overview 
1. Create the Purchase Order in BMC Track-It!. 

a. Select the Vendor 
b. Verify Shipping and Billing information 
c. Select Items from the Master Items list (customized catalog of products) and add them to 

the Purchase Order 
BMC Track-It! automatically calculates the sub-total amount, sales tax, shipping charges, 
price adjustments and total amount 

d. Add relevant notes 
2. Print and mail and/or e-mail (from BMC Track-It!) the Purchase Order to the Vendor. 

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=105&Offering=2&lang=EN
http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&lang=EN
http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&lang=EN
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3. When the items are received, record the receipt date in BMC Track-It!. 
The items are automatically transferred to the Inventory module (to the Unassigned Asset). 

4. Assign the item to the requestor's asset (such as the computer). 
  
Next Topic:  Managing Purchases (Workflow) 

Managing Purchases (Workflow) 
  
The flowchart below represents the tasks in the following topics.   
  

 
  
  
  
Previous Topic:  Purchasing Module Overview 
Next Topic:  Viewing and Finding Purchase Orders 

Viewing and Finding Purchase Orders 
The list of Purchase Orders is displayed in the Purchasing grid (Purchasing module).  You can sort, filter 
and group Purchase Orders (see Sorting, Filtering, and Grouping Records and search for individual items 
(see Viewing Information in Grids).  You can also specify which columns (fields) to view (see Creating 
User-defined Views). 
To View Purchase Orders: 

1. Select Purchasing from the Navigation pane. 
The Purchasing window displays and Purchase Orders are listed in the grid.    

2. Double click a Purchase Order in the grid to open it. 
You can also select Open Purchase Order from the Tasks pane, click the Open icon on the tool 
bar, or select File/Open from the menu bar. 
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The top pane of the Purchase Order window displays the most commonly-used fields to 
describe the Purchase Order:  Requestor, Date Ordered, and Purchase Order Number. 
 Additional information about the Purchase Order is displayed on the  tabs (Order Information, 
Vendor Information, Shipping and Billing, Items, Notes, and License). 

Customizing the Tabs Display 
You can select which tabs to display, and which two to display at a time. 

1. Right click any tab name, and select the check boxes of the tabs you want to display. 
2. To display two tabs at once, right click the right pane (appears blank until a tab has been 

selected), then select a tab name. 
  
Previous Topic:  Managing Purchases (Workflow) 
Next Topic:  Creating Purchase Orders 

  
  

Creating Purchase Orders 
Creating Purchase Orders 
  
The first step to creating a Purchase Order is to enter basic information (Requestor, Date Ordered, and 
Purchase Order Number) in the header area of the Purchase Order window.  Then you'll enter order 
information (Date Required, Payment Terms, Comments, and additional user-defined fields as necessary. 
 The header pane at the top of the window displays basic information about the purchase and the tabs 
display the details.   You can customize the tabs that display (see also Customizing Tab Displays). 
  
Note:  An asterisk (*) indicates an entry in the field is required. 
To Create a Purchase Order: 
Basic Information 
  

1. Select Purchasing from the Navigation pane. 
2. Select New Purchase Order from the Tasks pane. 
3. Select or enter the name of the person requesting the purchase in the Requestor's field 

(required). 
4. Select or enter the date the item was ordered in the Date Ordered field. 
1. Enter a number for the purchase order in the Purchase Order Number field (required).  

  
Order Information 
  

1. Select the Order Information tab. 
2. Select or enter the date the item is required in the Date Required field. 

 
Note:  Only enter the date you receive the item in the Date Received field when you want to 
complete the Purchase Order.  It will remain open until you enter the date received.  See 
Receiving Purchased Items into Inventory. 

  
3. Enter the payment terms (such as Net 30) in the Payment Terms field. 
4. Enter any comments as necessary in the Comments field. 

  
Custom Fields 
  
Note:  User-defined fields can contain text values only -- no calculations are made on these fields.  They 
will display on the printed purchase order and can display on user-defined reports. 
  
Text Fields 
  

You can enter text in up to four user-defined text fields.  By default, the labels for 
these fields display Text 1 through Text 4.  However, the BMC Track-It! 
Administrator can change the label names.  See Changing Field Label Text. 
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Date 
Fields 

You can enter dates in up to two user-defined date fields.   

Number 
Fields 

You can enter whole numbers (such as 10)  in the Integer field and values with 
decimals (such as .75) in the Decimal field. 

  
  
Previous Topic:  Viewing and Finding Purchase Orders 
Next Topic:  Entering Vendor Information on Purchase Orders 
  
  
  

Entering Vendor Information on Purchase Orders 
To Enter Vendor Information on Purchase Orders: 

1. Select the Vendor Information tab on the Purchase Order. 
2. Select the vendor from the Vendor drop-down list. 

a. If your BMC Track-It! Administrator has given you permissions, you can add a Vendor 
that is not listed.  To add a vendor, click the Add button (+) next to the Vendor drop-
down arrow.  See Setting Up Vendors in the Administrator's Guide for detailed 
instructions. 

3. The Address and Contact information will automatically display for the selected vendor if the 
information has been set up in Lookup Tables.   
 
Note:  If necessary, you can change the contact information on the Vendor Information tab, but 
the changes will not be reflected in the Vendors Lookup Tables.  To change the Lookup Tables, 
select Vendors from the See Also link in the Tasks pane. 

  
Previous Topic:  Creating Purchase Orders 
Next Topic:  Verifying Shipping and Billing Information for Purchase Orders 
Verifying Shipping and Billing Information for Purchase Orders for Purchase Orders 
  
When you create a purchase order, you'll need to verify the shipping and billing information.  This 
information will display on the printed purchase order.  Your BMC Track-It! Administrator can set up 
default shipping and billing information for purchase orders in the Administration Console (Purchasing 
Lookup Tables).  This information will display for each new purchase order that is created.  (See Setting 
up Shipping and Billing Information for Purchase Orders).  You can, however, change the information for 
specific purchase orders, and include additional shipping information (such as delivery instructions). 
To Verify Shipping and Billing Information on Purchase Orders: 
  

1. Select the Shipping and Billing tab on the Purchase Order. 
2. If the default information in the Bill to:  and Ship to:  text boxes is not correct, you can make any 

necessary changes (this will not affect the default information saved in Lookup Tables. 
3. You can enter additional shipping information in the Shipping Information text box. 

  
Previous Topic: Entering Vendor Information on Purchase Orders 
Next Topic:  Adding Items from the Master Items List to Purchase Orders 
  
  
  
Adding Items from the Master Items List to Purchase Orders 
When you create a purchase order, you add the items you want to purchase from the Master Items list. 
 This list, created by your Track-It! Administrator or designated Technician, is a customized catalog of 
common Items you'll be purchasing and/or adding to inventory to save time with data entry.  For detailed 
information on the Master Items list, see Creating the Master Items Catalog for Purchasing, Inventory, 
and Library in the Administrator's Guide. 
To Add Items from the Master Items List to a Purchase Order: 
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1. Select the Items tab on the Purchase Order. 
2. Click the Add button to select an item from the Master Items list. 
3. On the Master Item dialog, select the item you want to add to the purchase order. 

 
Note:  If the item is not on the Master Item list, Administrators can create it and add it to the 
Master Items list in the Administration Console.  You can access the list from the Master 
Items link on the Tasks pane of the Purchasing module.  See Creating Items for Purchasing and 
Inventory in the Administrator's Guide for detailed information. 
  

4. In the Product Information section of the Line Item dialog, the Product name displays.  Enter 
the Part Number. 

5. In the Order Information section, enter the quantity of items you want to order in the Quantity 
Ordered text box. 

6. Enter the price per item in the Price field. 
7. Click the checkbox Create Tracked Items in Unassigned Equipment when this item is 

received. 
  

This will place the item in the Tracked Items list in the Unassigned Equipment asset so you 
can assign it to the Requestor.  The Purchase Order information will display on the Tracked 
Item dialog for the item. 
  
See Storing Items in the Unassigned Equipment List, Transferring Items to and from the 
Unassigned Equipment List, and Promoting Items to Assets. 
  

8. Click the OK button on the Line Item dialog. 
The Items tab displays the selected item and details. 

   
When you're ready to receive the item, see Receiving Purchased Items into Inventory. 

To Delete an Item: 
1. Close the Line Item dialog. 
2. On the Items tab, select the item and click the Delete button. 
3. Click Yes on the Confirmation dialog. 

The Total is recalculated and displayed. 
4. Click the Save button on the Purchase Order window. 

  
Previous Topic:  Verifying Shipping and Billing Information for Purchase Orders 
Next Topic:  Entering Shipping Charges, Taxes, and Viewing Total Amount 
Entering Shipping Charges, Taxes, and Calculating the Total Amount for a Purchase Order 
Once you've added items to the Purchase Order from the Master Items list, BMC Track-It! calculates and 
displays the Sub-Total amount.  Next, you enter any Shipping charges.  The sales tax is automatically 
calculated.  You can also enter any price adjustments. 
To Enter Shipping Charges, Taxes, and Calculate the Total Amount: 

1. If there are shipping charges, enter them in the Shipping field. 
The Sales Tax is automatically calculated and displayed.  (Your BMC Track-It! Administrator 
configures the sales tax and whether or not tax is calculated on Shipping in the Administration 
Console).  However, you can change the sales tax for the purchase order if necessary.  See 
Setting up Sales Tax for Purchase Orders in the Administrator's Guide. 

2. If there is a price adjustment, such as a discount or surcharge, enter it in the Price Adjustment 
field. 
Negative numbers can be entered as follows:  -50.75 or (50.75). 
 
The Total amount is automatically calculated and displays. 
  

3. Click the Save button on the Purchase Order window. 
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Previous Topic:  Adding Items from the Master Items List to Purchase Orders 
Next Topic:  Adding Notes to a Purchase Order 
Adding Notes to a Purchase Order 
To add notes to a purchase order: 

1. Select the Items tab on the Purchase Order. 
2. Select the Notes tab and enter text in the textbox. 
3. Click the Save button when you've finished working with the Purchase Order. 

  
Previous Topic:  Entering Shipping Charges, Taxes, and Viewing Total Amount 
Next Topic:  Copying and Deleting Purchase Orders 
  
  
Attaching Files to Purchase Orders 
  
You can add files to Purchase Orders, such as text files, documents, or images.  You can also rename 
and delete file attachments. 
  
To View Purchase Order Attachments: 

1. In the Purchasing grid, double-click the Purchase Order you want to view, or select the Purchase 
Order, then select Open Purchase Order in the Tasks pane. 

2. Right click the file on the Attachments tab, then select Open. 
  
Tip:  You can customize the grid view and add the # of Attachments column to quickly view which 
records have attachments.  See Showing and Hiding Columns in the Creating User-defined Views topic. 
To Attach a File to a Purchase Order: 

1. Select the Attachments tab on the Purchase Order window. 
2. Click the Add button. 
3. In the Open Attachment dialog, navigate to the location of the file, then double click it, or select it 

and click the Open button. 
The file displays on the Attachments tab on the Purchase Order window. 

4. Click the Save button. 
  
To Rename a File Attachment: 

1. Right click the file on the Attachments tab, then select Rename. 
To Delete a File Attachment from a Purchase Order: 

1. Select the file on the Attachments tab, then click the Delete button on the confirmation dialog. 
You can also right click the file and select Delete, or press the Delete key. 

2. Click the Save button on the Purchase Order window. 
To Sort the List of Attachments: 

1. Click the column header (e.g. "Name"). 
To Change the Grid View of the List of Attachments: 

1. Right click anywhere on the Attachments tab, then select View. 
2. Select an option from the View menu (Text Only, Wrap Text, Auto Arrange). 

  

Copying and Deleting Purchase Orders 
Copying Purchase Orders 
If you frequently submit purchase orders for the same item, you can copy purchase orders to save data 
entry time.  You can generate as many copies as you desire from a single purchase order.   
  
The following fields are automatically populated when a PO is created: 
  

 Purchase Order No. (if Auto Incrementing is set up in the Administration Console) 
 Date Ordered (current date) 
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 Bill to Information 
 Ship to Information 
 Tax Rate 

The following fields are not copied: 
  

 Date Ordered 
 Purchase Order No. 
 Date Received 
 Item Quantity Received 

To Copy Purchase Orders: 
1. From the Purchasing module, right click the Purchase Order and select Copy Purchase Order, 

OR 
 Click the Copy icon on the main toolbar, OR 
 Click Copy Purchase Order on the Tasks pane. 

2. On the Copy Purchase Order dialog, enter the number of copies you want to generate. 
3. Select the Copy Items checkbox if you want copy the items listed on the Purchase Order. 
4. Click the OK button. 

The Copy Purchase Order dialog closes and the new purchase order(s) displays in the Purchase 
Order grid.   

5. Open the purchase order and make any necessary changes. 
6. Click the Save button. 

Deleting Purchase Orders 
As your purchase orders accumulate, you might find it desirable to clear some of the older records. This 
will clean up your computer memory and improve system performance. 
  
Note:  You should discuss any plans to delete purchase order records with your BMC Track-It! 
Administrator before you implement them. 
To Delete Purchase Orders: 

1. From the Purchasing module, right click the Purchase Order and select Delete Purchase Order, 
OR 

 Click the Delete icon on the main toolbar, OR 
 Click Delete Purchase Order on the Tasks pane. 

  
The Purchase Order is deleted and is removed from the grid. 

  

Printing Purchase Orders 
  
To Print Purchase Orders: 

1. From the Purchasing module, select the Purchase Order, then select Print from the Tasks 
pane, OR 

 Right click and select Print, OR 
 Click the Print icon on the toolbar. 

E-mailing Purchase Order Details to Requestors 
  
You can e-mail Purchase Order details to Requestors  that contain pre-populated information, such as the 
Purchase Order number, Date Ordered, Vendor, and Total price. 
To E-Mail Purchase Order Details: 

1. From the Purchasing module, select the Purchase Order that you want to e-mail. 
2. Click the E-mail Requestor icon on the toolbar. 

Receiving Purchased Items into Inventory 
When you physically receive one or more items of a purchase order and record the receipt date in the 
Purchasing module, the items are automatically transferred to the Inventory module (to the Unassigned 
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Asset).  Then you can assign the item to the requestor's asset (such as assigning a monitor to the 
requestor's computer).  You can choose to receive all items at once with the Receive All feature, or 
receive items individually. 
  
If you have a license for the Software License Management module, when you receive the software 
item in the Purchasing module, you can choose to create a single license for each item received or a 
bundled license (each item received will create a new license containing your specified number of 
licenses in the bundle).  The licenses will be created and will display on the Software title dialog in the 
Software License Management module and on the license tab of the Purchase Order window. 
  
Note:  In order to use the Software License Management module with the Purchasing module, you'll 
need to set up Lookup Tables.    The item must be associated to a title for this to display   Associating 
Software Titles with Master Items 
  

Receiving Items 

Note:  If you have the Software License Management Module, see below, Receiving Software with 
the Software License Management Module. 
  
To Receive Purchased Items into Inventory: 

1. Select Purchasing from the Navigation pane. 
2. Select the Purchase Order from the Purchase Order grid. 

Note:  If you don't know the Purchase Order number, you can search by the item's Product 
Name.  To search for the item, enter the item's Product Name in the Search textbox on the 
Purchasing toolbar, then select Search Purchasing from the Search drop-down list. 

3. To receive all items at once, click the Receive All button on the Purchase Order toolbar (or 
select Receive All from the Actions menu on the menu bar). 

4. To receive individual items separately: 
a. Open the received item on the Items tab of the Purchase Order window. 
b. On the Line Item dialog, enter the number of items received in the Quantity Received 

field in the Receiving Information section. 
5. If you are creating the Purchase Order at the same time you are receiving items, click the 

checkbox Create Tracked Items in Unassigned Equipment when this item is received. 
  

This will place the item in the Tracked Items list in the Unassigned Equipment asset so you 
can assign it to the Requestor.  The Purchase Order information will display on the Tracked 
Item dialog for the item. 
  
See Storing Items in the Unassigned Equipment List, Transferring Items to and from the 
Unassigned Equipment List, and Promoting Items to Assets. 

  

Receiving Software with the Software License Management Module 

To Receive Software with the Software License Management Module:  
(Steps 1-5 below are identical to the steps above). 
  

1. Select Purchasing from the Navigation pane. 
2. Select the Purchase Order from the Purchase Order grid. 

Note:  If you don't know the Purchase Order number, you can search by the item's Product 
Name.  To search for the item, enter the item's Product Name in the Search textbox on the 
Purchasing toolbar, then select Search Purchasing from the Search drop-down list. 

3. Open the received item on the Items tab of the Purchase Order window. 
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4. On the Line Item dialog, enter the number of items received in the Quantity Received field in the 
Receiving Information section. 

5. Click the checkbox Create Tracked Items in Unassigned Equipment when this item is 
received. 
 
This will place the item in the Tracked Items list in the Unassigned Equipment asset so you can 
assign it to the Requestor.  See Storing Items in the Unassigned Equipment List, Transferring 
Items to and from the Unassigned Equipment List, and Promoting Items to Assets. 

6. To receive software, click the checkbox Create Software License when this item is received. 
a. Select one of the following options: 

 
  
Single 
License 

Each item received will create a new license 

Bundle 
License   

Each item received will create a new license 
containing your specified number of licenses in 
the bundle 

  
b. If you selected Bundle License, enter the number of licenses in the bundle in the 

specified field. 
7. Click the OK button. 
8. If you created Software licenses, the Open Software Title dialog displays.  Click Yes if you'd like 

to view the corresponding Software Title, or No to close the dialog and return to the Items tab on 
the Purchase Order. 
 
The software license information displays on the Licenses tab of the Purchase Order. 

Viewing and Printing Purchasing Reports 
  
You can view and print the following Purchasing Reports: 
  

 Closed Purchase Order Summary 
 Open Purchase Order Summary 
 Open Purchase Orders by P.O. Date 
 Open Purchase Orders by Required date 
 Open Purchase Orders by Technician 
 Open Purchase Orders by Vendor 
 Overdue Purchase Orders by Required Date 
 Overdue Purchase Orders by Vendor 
 Summary of Received P.O.s by Technician 
 Summary of Received P.O.s by Vendor 
 Vendor Listing 

  
To View Purchasing Reports: 

1. Select the Reports module from the Navigation pane. 
2. Select Purchasing from the Reports by Module drop-down list above the Reports grid. 
3. Double click the report you want to view. 

  
  

Training: Tracking Training for Individuals in Your Organization 

Tracking Training for Individuals in Your Organization 
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The BMC Track-It! Training module enables you to schedule and track users' training -- whether within 
your organization or by external providers.  Although you can use the Training module to track any kind of 
training, it is designed to help you monitor computer training.  You can use the Help Desk module to 
analyze a user's work order history that might suggest training needs.  You can view the hardware and 
software associated with a user through the Inventory module to identify a user's expertise for knowledge 
management.  You can also use the Library module to track textbooks, computer-based training on CDs, 
Web based training, training materials and equipment, etc. 
To View Course Histories for an Individual: 

1. Select the Training module from the Navigation Pane. 
2. The list of your organization's Users displays.  Select a User, then click Open Course History 

from the Tasks pane. 
The Edit User dialog displays the Course History tab and the list of courses scheduled for the 
individual. 

  
Next Topic:  Scheduling Training for Individuals in Your Organization 
  
  
  

Scheduling Training for Individuals in Your Organization 
  
You can schedule training for the individuals in your organization and maintain training information in the 
Training module. 
To Schedule Training: 

1. Select the Training module from the Navigation Pane. 
2. The list of your organization's Users displays.  Select a User, then click Open Course History 

from the Tasks pane. 
The Edit User dialog displays the Course History tab and the list of courses scheduled for the 
individual. 

3. To schedule a course for the individual, click the Add button. 
4. Select the course from the Course Listing dialog, then click the Select button. 

The Course Enrollment dialog displays with course information as set up in the Administration 
Console Lookup Tables. 

5. If any of the course information has changed, you can change it on this dialog.  (The information 
will not be changed in the Course set up in Lookup Tables -- this is only to record information for 
the specific class). 

6. There are six Text fields you can use to enter additional course information 
7. Click the OK button on the Course Enrollment dialog when you are finished entering 

information. 
  
To Set Up New Courses from the Training module: 

1. Click the Courses link from the See Also list on the Tasks pane 
The Courses dialog displays in the Administration Console,  OR 

 From Step 4 above, click the New button. 
  
To E-mail an Individual from the Training Module: 

1. Select the individual from the Users grid, then click E-mail User on the Tasks pane. 
You can also  right click the individual, then select E-mail User. 

  
Next Topic:  Recording an Individual's Grade When Training is Completed 

Recording an Individual's Grade When Training is Completed 
  
To Record an Individual's Grade for a Course: 

1. Select the Training module from the Navigation Pane. 
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2. The list of your organization's Users displays.  Select a User, then click Open Course History 
from the Tasks pane. 
The Edit User dialog displays the Course History tab and the list of courses scheduled for the 
individual. 

3. Double click the course to edit it. 
4. Enter the grade in the Grade text box (such as A, Passed, Successful, etc.) then click the OK 

button. 
5. Click the Save button on the Edit User dialog. 

The Users grid re-displays. 

Library: Tracking Loaned Library Items 

Library Overview 
  
You can track items that you lend to the individuals in your organization, such as books, manuals, 
textbooks, videos, and even hardware such as laptops.  You can create new Library items in the Library 
Module, or you can add them from the Master Items list (a customizable catalog of products).  (For more 
information, see Creating the Master Items Catalog for Purchasing and Inventory in the Administrator's 
Guide.) 
  
When you loan (check out) a Library item, you select the borrower's name from the User list, enter the 
Check Out and Due Dates, and Comments as necessary.  Then when the item is returned, you enter the 
Check In date.  If an item has not been returned by the due date, BMC Track-It! lets you know by 
displaying it as Overdue.  (The default grid view for Library items is by Status:  In, Out, and Overdue). 
 You can open the item's record and contact the borrower since the User's contact information 
automatically displays from the User Lookup Tables. 
  
Next Topic:  Creating New Library Items in the Administrator's Guide. 
  
  
  
  
  
  
  
  

Viewing and Finding Library Items 
  
To View Library Items: 

1. Select the Library module from the Navigation Pane. 
The Library grid displays with a list of items by loan status:  In, Out, or Overdue.  The User's 
name and phone number displays, as well as the Due Date and Date Checked Out. (You can 
display more columns by customizing the grid.  See 

2. Double click a library item to open it to view more details. 
  
To work with the grid view, see the chapter on Viewing Information in Grids. 
  
To Find a Library Item: 
You can search for library items from the Search field and Search button on each module's toolbar 
(Library, Help Desk, Inventory, Solutions, etc.), as well as from individual windows, such as Work Orders 
or Assets.    
  
To Search for Library Items: 
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1. Enter the search term in the Search field (main toolbar), then select Library Items (automatically 
selected in the Library module) from the Search button drop-down.   
The Search Library Items dialog opens and displays the search results.  

2. The Library Items that include your search term are displayed in the Results list.  To view the 
Library Items, double click (or right click and select Open). 

  
Next Topic:  Creating New Library Items 
  
  

Creating New Library Items 
  
You can either create a new library item by entering an item name, or you can add an item from the 
Master Items list. 
  
To Create a New Library Item: 

1. Select the Library module from the Navigation Pane. 
2. Click New Library Item on the Tasks pane. 
3. Enter the Library Item Name in the indicated field, or click the Ellipses button (...) and select the 

item from the Master Item Listing dialog. 
4. If available, enter the item's Serial Number (or any other identifying number, such as an ISBN 

number for a book). 
5. Enter an Asset Number if desired. 

 
Note:  If the library item is a network asset (such as hardware or software), you can find this 
information in the Inventory module. 
 
The Status field displays In, Out, or Overdue. 

6. You can enter comments about the item on the Comments tab. 
 
If the General, History, and Comments tabs do not display, see Creating User-defined Views. 
 (These tabs are explained in Loaning Library Items topic). 

  
Next Topic:  Loaning Library Items 
  

Loaning Library Items 
  
Checking Out Items 
To Check Out Library Items: 

1. Select the Library module from the Navigation Pane. 
2. Select the library item in the grid, then click Check Out Library Item from the Tasks pane (or 

click the Check Out icon on the menu bar). 
3. On the General tab, the Check Out Date automatically displays the current date.  You can 

record a previous date if necessary. 
4. Select or enter the Due date in the designated field. 

BMC Track-It! will monitor the due date and list the item as Overdue in the Library grid if it is not 
checked in on time. 

5. Select the borrower's name from the User drop-down list. 
The User's contact information automatically displays if you have selected the User.   

6. Enter any comments as necessary on the Comments tab. 
 
The History tab displays details on who borrowed the item, when it was checked out, checked in, 
etc. 
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7. Click the Save button. 
 
The Library grid displays showing the updated record. 

Checking In Items 
To Check In Library Items: 

1. Select the library item in the grid, then click Check In Library Item from the Tasks pane (or click 
the Check In icon on the menu bar). 

2. Click Yes on the Check In confirmation dialog. 
The Item's status changes to In and displays on the grid. 

  
Next Topic:  Library Reports 

Viewing and Printing Library Reports 
  
You can view and print the following Library Reports: 
  

 Library Item Status 
 Library History 

  
To View Library Reports: 

1. Select Reports from the Navigation Pane. 
2. Select Library from the Reports by Module drop-down list. 
3. The list of reports by module displays.  (See Viewing Reports and Printing reports for detailed 

instructions). 

Reports 

Reports Overview 
  
In addition to the graphs and pivot grid reports available in the Dashboard module, you can view and print 
over 100 system reports from various modules in BMC Track-It!, such as Help Desk and Inventory.  The 
reports display in the Crystal Reports XI Viewer.  You can export the reports to Crystal Reports XI and 
create your own customized reports.  You can also import and export reports to share with other BMC 
Track-It! users. 
  
For more information, see the Business Objects support page on their Web site at 
www.businessobjects.com, and the Crystal Reports XI user guide. 
  
Next Topic:  Viewing Reports 

Viewing Reports 
  
You can view reports from the Reports module.  You can also view reports from individual modules such 
as the Help Desk module.  An advantage of viewing the reports from the individual module is that you can 
filter the records in the grid to your specifications, then select a report. 
To View a Report from the Reports Module: 

1. Select Reports from the Navigation Pane. 
2. Select a module (such as Help Desk) from the Reports by Module drop-down list. 
3. The list of reports by module displays.   

The Reports Source column displays System View or User-defined report. 
4. To preview the report, select the report, then click Preview Report from the Tasks pane. 

You can also right click there report and select Preview Report. 
5. On the Enter Parameter Values dialog, enter the start date and end date range for the report: 

http://www.businessobjects.com/
http://help.sap.com/businessobject/product_guides/
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a. Either enter the date in the Enter a Value fields (for Start and End dates)  in the format 
"yyyy-mm-dd" or click the Calendar icon and select the date. 

b. To include all dates, click the No lower value checkbox. 
6. Click the OK button. 

The report displays in the Crystal Reports XI viewer, with a graphical representation at the top 
(such as a bar chart), and details on the subsequent pages. 

To View Reports from Individual Modules (Such As Help Desk): 
1. Select a module (such as Help Desk), then filter the records in the grid  to your specifications. 

 (See Sorting, Filtering, and Grouping Records). 
2. Click Print Report with Filter on the Tasks pane. 
3. On the Reports dialog, select the report, then click the Select button. 

The report displays in the Crystal Reports XI viewer, with a graphical representation at the top 
(such as a bar chart), and details on the following pages. 

To Navigate Report Pages: 
1. Use the scroll bar to view the pages, or click the control buttons ( Next, Last, Previous, or First 

page) at the top of the viewer. 
2. To view report sections, click the Toggle Group Tree icon.   

The report sections display on the left pane of the viewer. 
a. Click an item in the pane to view each section. 
b. Click the Toggle Group Tree again icon to close the pane. 

3. Click the page control buttons to navigate through the report. 
To Search Report Text: 

1. Click the Find Text icon. 
2. In the Find Text dialog, enter the text in the Find What field, then click the Find Next button. 

If the text is found, it is outlined in red. 
  
Next Topic:  Printing reports 

Printing Reports 
  
To Print Reports from the Reports Module: 

1. Select Reports from the Navigation Pane. 
2. Select a module (such as Help Desk) from the Reports by Module drop-down list. 
3. The list of reports by module displays.   

The Reports Source column displays System View or User-defined report. 
4. Click Print Report on the Tasks pane. 
5. Select options from the Print dialog, then click OK. 

The report prints directly to your printer. 
  
To Print Reports from Individual Modules (such as Help Desk): 

1. Select a module (such as Help Desk), then filter the records in the grid  to your specifications. 
 (See Sorting, Filtering, and Grouping Records). 

2. Click Print Report with Filter on the Tasks pane. 
3. On the Reports dialog, select the report, then click the Select button. 
4. On the Enter Parameter Values dialog, enter the start date and end date range for the report: 

a. Either enter the date in the Enter a Value fields (for Start and End dates)  in the format 
"yyyy-mm-dd" or click the Calendar icon and select the date. 

b. To include all dates, click the No lower value checkbox. 
5. Click the OK button. 

The report displays in the Crystal Reports XI viewer, with a graphical representation at the top 
(such as a bar chart), and details on the subsequent pages. 

6. Click the Print button on the viewer. 
7. Select options from the Print dialog, then click OK. 

The report prints directly to your printer. 
  
Next Topic:  Importing and Exporting Reports 
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Importing and Exporting Reports 
  
You can import and export reports to share with other BMC Track-It! users.  You can also export the 
reports to Crystal Reports XI and create your own customized reports.   
  
Note:  BMC Track-It! enables you to create custom reports using Crystal Reports XI, and includes the 
Crystal Reports Professional Edition. 
  
To Import Reports: 

1. Select Reports from the Navigation Pane. 
2. Select a module (such as Help Desk) for the type of report from the Reports by Module drop-

down list. 
When the report is imported, it will be available from the selected module. 

3. Click Import Report from the Tasks pane. 
4. Click the Browse button to find the file on your directory. 
5. Enter a name for the report in the Report Title field 

The file name displays with a .rpt extension (indicating a Crystal Report) in the File name of 
report field. 

6. Click the Save button. 
The imported report displays as a User-created Report in the specific module grid (such as Help 
Desk) in the Reports module.  It also displays on the Reports menu in the individual module (see 
Viewing Reports from Individual modules in Viewing Reports). 

  
To Export Reports: 

1. Select the report you want to export from the Reports module, then click the Export Report from 
the Tasks pane. 
You can also preview the report, then click the Export Report button from the Crystal Reports 
XI viewer. 

2. On the Save As dialog, navigate to the folder in your directory where you want to export the 
report. 

3. Enter a name for the report in the File Name field. 
4. Select the type of file for the report from the Save As Type drop-down list (such as .rpt, .xls, etc.). 
5. Click the Save button. 
6. Click OK when the Export Completed message displays.   

  
Next Topic:  Customizing Reports 

Dashboard: Working with Graphs and Pivot Grids 

Viewing Help Desk Metrics with the Dashboard (Overview) 
  
The BMC Track-It! Dashboard summarizes and organizes large amounts of your BMC Track-It! work 
order data into reports and Key Performance Indicators (KPIs) in the form of graphs (bar and pie charts) 
and pivot grids (interactive tables).  BMC Track-It! analyzes the data and displays status and trends 
including Overdue Work Orders by Technician and Priority, and Service Level Agreement Fulfillment. 
 You can customize the charts and pivot grids to your specifications using the Configuration Panel.  For 
example, you can filter the Technicians field to only display certain Technicians or Technician Groups by 
a specific Work Order Type, such as Telecom or Network.  You can view one graph or pivot grid at a time 
on the Dashboard.  However, Track-It's customizable Home Page can display two additional Dashboard 
graphs that you select.   
  
Caution:  Reports security is not implemented for the Dashboard module (graphs and pivot grids).  If 
your Technicians have access to the Dashboard module, they will be able to view all System Dashboard 
graphs and pivot grids, as well as the two default Dashboard graphs (Overdue Work Orders and Work 



BMC Track-It! 11 Web 

 © Copyright 1989 - 2012 Numara Software, Inc.  BMC Software, the BMC logos, and other BMC marks are trademarks or registered trademarks of BMC Software, Inc. in the 
U.S. and/or certain other countries. Track-It! is the property of Numara Software, Inc. and is registered with the U.S. Patent and Trademark Office, and may be registered or 

pending registration in other countries. Numara Software and BMC Software Confidential. 

123 

Order Activity This Month) on their Home Page.  To set Dashboard security, see Restricting Privileges by 
Module in the Administrator's Guide.) 
  
The following graphs and pivot tables are shipped with BMC Track-It!: 
  
Note:  The graphs and pivot tables display a trend over a period of time. 
  

 Open Work Orders 
 Work Order Activity 
 Work Orders Closed within 1 Hour (Work Orders closed within one hour of creation) 
 Overdue Work Orders 
 Problem Analysis (Work Orders by Type) 
 Service Level Agreement Work Order Status 

 Open SLA Violations (by due date) 
 SLA Work Orders in Alarm State (not completed by Service Level Agreement specified 

time or date) 
 SLA Fulfillment (Work Orders where the Service Level Agreement was not met) 

  
The graphs and pivot grids are explained in detail below: 
  

System 
View (Help 
Desk) 

Description 
  

Available Measures Default View 

Open Work 
Orders 

 Open Work Orders 
 Point in time 

  

 Work Order Count 
 Average Work 

Hours Overdue 
 Work Hours Open 

  

Open Work Orders 
count grouped by 
Assigned Technician 
and Priority 

Work Order 
Activity 

  Work Orders 
opened and closed 
for a time interval 

 Trend (Time 
interval) 

 Within one year 

  
• Active Work Order 

day balance count 
• Closed Work 

Order count 
• New Work Order 

count 
• Work hours to 

close count 
  

Active Work Orders 
grouped by Priority 

Work 
Orders 
Closed 
within 1 
Hour 

 Work Orders 
closed within one 
hour of creation 

 Trend (Time 
interval) 

 Within one year 

 First Call Closed 
Count 

 First Call Work 
Hours to Close 
Count (average 
number of work 
orders that were 
closed within an 
hour) 

  

First Call Closed 
count grouped by 
Technician and Time 
Interval 
  
   
  
  
  
  

Open SLA 
Violations 

  Work Orders that 
have not been 
closed by the SLA 
Due Date 

 Point in time 
  

 Work Orders 
Open 

 Work Orders 
Overdue 

 Work Order 
Count 

  

Work Order Group 
count grouped by 
SLA Name and 
Technician 
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Overdue 
Work 
Orders 

 Open Work Orders 
that have not been 
closed by the Due 
Date 

 Point in time 
  

 Overdue Work 
Order Count 

 Work Hours 
Overdue (average 
time overdue) 

  

Overdue Work Order 
count grouped by 
Priority and 
Technician 
   
  
  

Problem 
Analysis 

  Work Orders by 
the top 10 problem 
Types 

 Trend (Time 
interval) 

 Within one year 

 Active Work Order 
Day Balance 
Count 

 Closed Work 
Order Count 

 New Work Order 
Count 

 Work Hours to 
Close Count 

  

New Work Order 
count grouped by 
Type 
  
   
  

SLA 
(Service 
Level 
Agreement) 
Work 
Orders in 
Alarm State 

  Work Orders not 
completed by 
Service Level 
Agreement 
specified time or 
date) 

 Point in time 

 Work Hours Open 
 Work Hours Since 

Alarm 
 Work Order Count 

Work Order count 
grouped by SLA 
name and Technician 

SLA 
Fulfillment 

 Work Orders not 
meeting the 
Service Level 
Agreement 

 Trend (Time 
interval) 

  Within one year 

 Average Unfulfilled 
Work Orders 

 Fulfilled Service 
Level Agreement 
at Close Count 

 Percent Fulfilled 
Work Orders 

 Unfulfilled Service 
Level Agreement 
at Close Count 

  

Percent Fulfilled 
Work Orders 
grouped by 
department and time 
interval 
   
  
  
  

  
Next Topic:  Viewing Help Desk Graphs with the Dashboard 

Help Desk Graphs 
Viewing Help Desk Graphs with the Dashboard 
  
The Help Desk graphs display the Key Performance Indicators of your Help Desk, such as Work Orders 
not completed by Service Level Agreement time or date and Work Orders by type.  Depending on the 
graph, the analysis is point in time or by time interval (such as the number of Work Orders closed within 
one hour of creation this month. The graphs display the same information as the pivot grids, but as bar or 
pie charts.   
  
You can customize the graphs (using the Configuration Panel) by type, measure, category, and time 
interval.  You can further customize them by filtering  the information (such as by certain Technicians or 
Work Order types).  You can copy, print, export, and share the graphs as well. 
  
For a detailed description of the graphs, see Viewing Help Desk Metrics with the Dashboard (Overview). 
  
To View a Graph: 

1. Select the Dashboard module from the Navigation Pane. 
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2. Select the graph from the View menu (e.g., Current View/Help Desk/System Views/Overdue 
Work Orders). 
  

Default Graphs 

The default graph display as bar charts with pre-formatted categories and time intervals; however you can 
customize them.  See Customizing Graphs (Dashboard). 
To Clear Filters and View the Default Graphs: 

1. Select Abandon Changes to Current View from the View drop-down list at the top of the graph. 
This returns the graph to the default system view. 

  
Next Topic:  Filtering Help Desk Graphs (Dashboard) 
Customizing Graphs (Dashboard) 
  
You can customize the graphs using the Configuration Panel by type, measure, category, and time 
interval (depending on the graph): 
  

Graph Attributes Options 
Graph Type Bar or Pie 
Graph Sub Type Side by Side Bar or Stacked Bar 
Time Period Displays a specific period of time, e.g., This Month 
Measure (Y Axis) Count, average, or percentage. Varies per chart. 

(e.g., Work Order count) 
Category Type Time Interval or Field Value 
Category (X Axis) Time Interval or Field Values 
Sub Category (X 
Axis) 

Field Values 

  
To Customize a Graph: 

1. If the Configuration Panel is not displayed, click the tab to the right of the graph to display it. 
The Configuration Panel displays the settings for the options described in the table above (such 
as Chart Type and Category). 

2. Select the options you want to display for your customized chart. 
In a few seconds, the chart displays as a color-coded bar or pie chart.  You can also filter the 
graph (see Filtering Help Desk Graphs (Dashboard). 

  
To Save Your Customized Graph: 

1. Once you have customized your graph, select Save Current View As from Current View on the 
menu bar. 

2. On the Save Current View As dialog, enter a name for your graph, then click the Save button. 
3. To access your customized graph at a later time, select it from the Help Desk option from the 

Current View on the menu bar. 
 
A customized (or filtered) graph or pivot grid that has been initially saved, then modified, will 
display an asterisk (*) after the name, such as Overdue Work Orders*.  (System graphs and pivot 
grids that have been modified will also display the asterisk.  See below to return them to their 
default state). 

  
To Share Your Customized Graph: 
See Exporting and Importing Views. 
  
To Clear Filters and View the Default Graphs: 
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1. Select Abandon Changes to Current View from the View drop-down list at the top of the graph. 
This returns the graph to the default system view. 

  
Next Topic:   Filtering Help Desk Graphs (Dashboard) 
   
   
   
  
Filtering Help Desk Graphs (Dashboard) 
  
You can filter the data in a graph to limit the data.  For example, you might only want to view Overdue 
Work Orders for certain Technicians or Technician Groups. 
  
Note:  The values in the Filter by drop-down list depend on the type of graph. 
  
To Filter a Graph: 
This example will show how to view the graph by specific Technician Groups. 
  

1. Select the graph you want to filter from View menu (e.g., Current View/Help Desk/System 
Views/Overdue Work Orders). 

2. If the Configuration Panel is not displayed, click the tab to the right of the graph to display it. 
3. Click the Filter button at the bottom of the Configuration Panel. 
4. The Filter dialog displays.  Select a Category name (field name), e.g. Technician Assigned, 

beneath "Filter by". 
5. Select a comparison type from the middle drop-down list (e.g. "equals" or "like"). 
6. Enter or select a comparison value from the value drop-down list (e.g. Network Group). 
7. Select And or Or from the drop-down list (e.g. to view a graph with both the Network Group and 

the Desktop Group, select Or.   
8. If you want to set additional conditions, repeat steps 4-6, then click the and/or button, and select 

"and" or "or" from the drop-down list. 
You can continue step 8 to filter on multiple conditions. 

9. Click the Accept button to save the custom filter and filter the graph. 
The grid displays only the records that meet the condition(s) of your filter.  In this example, graph 
displays the number of Overdue Work Orders for the Network Group and the Desktop Group. 

  
To Clear the Custom Filter:   

1. Click the Filter button. 
2. Click the Delete button on each row of the Filter dialog. 

  
A customized (or filtered) graph or pivot grid that has been initially saved, then modified, will display an 
asterisk (*) after the name, such as Overdue Work Orders*.  (System graphs and pivot grids that have 
been modified will also display the asterisk.  See below to return them to their default state). 
  
To Clear Filters and View the Default Graphs: 

1. Select Abandon Changes to Current View from the View drop-down list at the top of the graph. 
This returns the system graph to the default system view, and a customized graph to its last 
saved state. 

  
Next Topic:  Printing Graphs and Pivot Grids from the Dashboard 

Help Desk Pivot Grids 
Viewing Help Desk Pivot Grids with the Dashboard 
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A Pivot Grid is an interactive table that you can customize based on fields and data in your BMC Track-It! 
database to summarize Help Desk Work Order data.  The pivot grids display the same information as the 
Dashboard graphs (such as Problem Analysis-Work Orders by Type).  However, the pivot grids are a 
matrix format with actual data that recalculates depending on way you select the measure, arrange the 
fields, and apply filters (e.g. Technicians in rows and Months in columns).  You can view more dimensions 
(categories of information) at a time in a pivot grid than with a graph.    
  
You can filter the data as with the Dashboard charts.  For example, if you want to see only certain Work 
Order types, you can filter the Type field.  You can view system pivot grids and move the data back to the 
default view with the click of a button.  You can also save customized pivot grids, print, and import and 
export them to share with other BMC Track-It! users. 
  
For a detailed description of the graphs, see Viewing Help Desk Metrics with the Dashboard (Overview). 
  
An example of the Overdue Work Order Count pivot grid, grouped by Priority and Technician, then filtered 
by Technician, Priority, Department, and Type is displayed below: 
  

Overdue Work Order Count TECHNICIAN PRIORITY   
*Desktop 
Group 

*Network 
Group 

Telecom 
Group 

Grand Total 

DEPARTMENT TYPE 4-Low 1-Critical 3-Medium   
Executive Hardware 1   2 3 
Executive Total 1   2   
Sales Hardware         
  Network 3   2 5 
  Telecom   5   5 
Sales Total 3 5 2   
Grand Total 4 5 2 13 

Overdue Work Order Count Pivot Grid 
  
See the tutorial with examples on customizing a pivot grid (Pivot Grid Tutorial: Customizing Problem 
Analysis Pivot Grid).  See Customizing Pivot Grids (Dashboard) for step-by-step instructions. 
  
To View a Pivot Grid: 

1. Select the Dashboard module from the Navigation Pane. 
2. Select the pivot grid from the View menu (e.g., Current View/Help Desk/System 

Views/Overdue Work Orders Pivot (PIT). 
  

To View Specific Cell Data (e.g. Work Orders) from the Data Area: 
1. Double click a cell containing data. 

The Pivot Drill Across dialog displays a Work Order grid containing the actual Work Orders 
reported on the pivot grid.   

2. Double click a Work Order to open it. 
(You can keep the Pivot Drill Across dialog open while you view others from the pivot grid). 

Default Pivot Grids 

The default pivot grids display as tables with pre-configured measures, time intervals, and fields as rows 
and columns.  However you can customize them.  See Customizing Pivot Grids (Dashboard) 
To Clear Filters and View the Default Grids: 

1. Select Abandon Changes to Current View from the View drop-down list at the top of the graph. 
This returns the system pivot grid to the default system view, and a customized pivot grid to its 
last saved state. 



BMC Track-It! 11 Web 

 © Copyright 1989 - 2012 Numara Software, Inc.  BMC Software, the BMC logos, and other BMC marks are trademarks or registered trademarks of BMC Software, Inc. in the 
U.S. and/or certain other countries. Track-It! is the property of Numara Software, Inc. and is registered with the U.S. Patent and Trademark Office, and may be registered or 

pending registration in other countries. Numara Software and BMC Software Confidential. 

128 

  
Next Topic:  Pivot Grid Tutorial: Customizing Problem Analysis Pivot Grid 
  
Pivot Grid Tutorial:  Customizing Problem Analysis Pivot Grid 
  
For those unfamiliar with pivot tables, the following tutorial will help you understand the basics of pivot 
grids and walk you through manipulating data in a pivot grid in BMC Track-It!   We'll customize a Problem 
Analysis pivot grid to show the New Work Order Count grouped by Type, Department, and Location. 
  

Pivot Grid Elements 

The pivot grid is an interactive table that you can customize based on fields and data in your BMC Track-
It! database.   It is comprised of the following elements: 
  

Element Description 
Row Field A field from your database that you place as a row in the pivot grid, e.g. 

"Type".  You can create different views of the data by dragging the fields to 
the row or column areas of the pivot grid. 

Column Field A field from your database that you place as a column in the pivot grid, 
e.g. "Dept" or "Month".  You can create different views of the data by 
dragging the fields to the row or column areas of the pivot grid. 

Filter Field A field from your database that you place as a filter in the pivot grid to 
show only specific values of the field, e.g. the specific technician's name 
from the  "Technician" field. 

Data Item A measure (such as a "count") that recalculates the data depending on the 
pivot grid view. 

Data Area Cells in the grid that contain the data from your database.  Point-in-Time 
pivot grids enable you to "drill across" and access the actual Work Orders 
from the numbers in the data area. 

Item A subcategory of a row or column field, e.g. Sales, Executive, and 
Engineering are Items for the Department field. 

  
Below is a representation of a pivot grid identifying its elements: 
  

Drop Filter Fields 
Here 

        

Drop Data Items 
Here 
  

  
Drop Column Fields Here 

New Work Order 
Count 
  

  

Drop Row Fields 
Here 

 Dept 
  

  

 Type 
  

Sales 
(Item) 

Executive Engineering Grand 
Total 

Telecom 55 2 0   57 
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Grand Total 55 2 0 57 

Data Area 

Pivot Grid Elements 

  
  
The following steps explain how to: 
  

1. Determine What Questions You Need to Answer about your Help Desk 
2. Select a System Pivot Grid as a Starting Point 
3. Customize the Relevant Pivot Grid to Display the Actual Numbers You Need 

• Select a Time Interval and Measure 
• Filter the Pivot Grid 
• Select Fields for the Columns in the Grid 

4. Save the Pivot Grid. 
5. Print, Copy, or Export the Pivot Grid 

• Print the Pivot Grid 
• Export the Pivot Grid to Excel 

Step 1:  Determine What Questions You Need to Answer about Your Help Desk. 

Depending on the pivot grid, you can answer questions based on measures (counts) and 
fields related to your BMC Track-It! data.   (See Viewing Help Desk Metrics with the 
Dashboard (Overview) for detailed information which measures, fields, and other information 
is available for each chart and grid). 

  
Available Measures and Fields to Create Graphs and Pivot 

Grids for Help Desk 
(Depending on the Graph or Pivot Grid) 

Measures Fields 

• Active Work Order Day 
Balance Count 

• Average Unfulfilled Work 
Orders 

• Closed Work Order Count 
• First Call Work Hours to Close 

Count 
• New Work Order Count 
• Unfulfilled SLA at Close Count 
• Work Hours Open 
• Work Hours Overdue 
• Work Hours Since Alarm 
• Work Hours to Close Count 

• Activity Date 
• Category 
• Department 
• Location 
• Lookup 1 
• Lookup 2 
• Priority 
• SLA (Service Level 

Agreement) 
• Status 
• Subtype 
• Task Location 
• Technician 
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Let's start with a simple question.  Suppose an executive in your organization suspects that the reason 
sales figures are down is because the new telephone system has not been working properly since it's 
been installed.  He asks you how many calls your Help Desk has received for telephone-related problems 
in the past month.   

Step 2:  Select a System Pivot Grid as a Starting Point. 

1. Familiarize yourself with the different types of charts and pivot grids in the Dashboard module. 
(See Viewing Help Desk Metrics with the Dashboard (Overview) for detailed information on each 
chart and grid). 

2. For this example, we'll look at the Problem Analysis graph in the Dashboard module.  We can see 
from the bar chart that there are more telephone-related Work Orders in the past month than any 
other type of problem, with over 50 Work Orders.  We've added a sub-category to the graph to 
look at which departments have called to report the problem, and discovered that most of the 
calls did, in fact, come from the Sales department.  Now we'd like to report on the actual numbers 
by using a pivot grid. 

  

Step 3:  Customize the Relevant Pivot Grid to Display the Actual Numbers You Need. 

We'll manipulate the Problem Analysis pivot grid to show the New Work Order Count 
grouped by Type, Department, and Location. 
  

a.  Select a Time Interval and Measure 

Note:  Pivot grids can display trends (Time Interval) or a specific point in time. 
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1. From the Dashboard, we'll select the Problem Analysis pivot grid.   
The default pivot grid shows "Closed Work Order Count" with a time period of "This 
Month".   
  
 Current View - Problem Analysis Pivot 

      

Time Display 
Interval 

Time Period   

Default This Month   

      

Drop Filter Fields Here 

 Closed Work Order 
Count 
  

  
Drop Column Fields Here 

Drop Row Fields Here 
  

 Type 
  

Closed Work Order Count   

  

Default Problem Analysis Pivot Grid 

   
2. We're only interested in the past month, so we'll change the Time Period drop-down to Past 

Month. 
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3. We don't need to know the Closed Work Order Count at this time, so we'll change the measure 

to New Work Order Count.  Notice the asterisk (*) after the Current View name.  This indicates 
a customized grid. 

  

Current View - Problem Analysis Pivot* 

  

Time Display 
Interval 

Time Period   

Default 
  

Past Month   

      

Drop Filter Fields Here 

New Work Order 
Count 
  

  
Drop Column Fields Here 

Drop Row Fields Here 
  

 Type 
  

Closed Work Order Count   

Customized Problem Analysis Pivot Grid 

  
4. To change the measure (the count of Work Orders), we need to display the Field list, so 

we right click on the pivot grid to display the Field List dialog.   
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5.  
  

Pivot Grid Field List 
                              X 
Drag Items to the Pivot Grid 
  

Active Work Order Day 
Balance Count 
Activity Date 
Category 
New Work Order Count 
Lookup 1 
Lookup 2 
Technician 
Priority 
SLA Name 
Sub type 
Work Hours to Close 
Count 

  

Add to      Data Area 

   
5. We want to remove the Closed Work Order Count data item from the Data Items area of the 

pivot grid (where it says Drop Data Items Here), so we drag it to the Field List dialog. 
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6. Then we drag the New Work Order Count field from the Field List dialog to the Data Items 
area. 

  
Drop Filter Fields Here   

Drop Data Items 
Here  
 New Work Order 
Count 
  

  
  
Drop Column Fields Here 

Drop Row Fields Here 

Type 
  

New Work Order Count   

Telecom   
57 

Desktop 25 

Network 10 

Grand Total 92   

Customized Problem Analysis Pivot Grid 

   
We can immediately see in the pivot grid  that there are 57 new Work Orders in the Telecom 
type, 25 for Desktop Applications, and 10 for Network for the past month, with a grand total of 
92 new Work Orders. 

b.  Filter the Pivot Grid. 
  

1. We're only interested in Telecom, so we'll filter out the rest of the Types.  We'll do this 
dragging the Type field to the Filter Field area. 

2. Then we'll de-select all of the types from the Filter drop-down on the Type field.  Then 
we'll select only the Telecom type. 
  

Now only the Telecom type filter field displays with an updated New Work Order Count in the 
data cell. 
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c.  Select Fields for the Columns in the Grid. 

  
1. Since we need to know how the Sales department was affected by the telephone problems, we'll look at how 

many Work Orders there were by Department.  We'll drag the Department field from the Field List dialog to 
the right of the New Work Order Count field in the column area.   

  
Drop Filter Fields Here 
  

 Type 
  

  

   
 New Work Order 
Count 
  

Drop Column Fields Here 
  

   Dept 
  
  

  

Drop Row Fields 
Here 
  

Sales Executive Engineering Grand 
Total 

New Work Order 
Count 

55 2 0 57 

Customized Problem Analysis Pivot Grid 

  
We can see in the Department column that 55 Work Orders came from the Sales department, 
and two came from Executives. 
  
2. We'd like to filter the list to only show the Sales department, so we'll filter out the rest of 

the departments.  We'll do this by de-selecting all of the departments from the Filter drop-
down on the Department field, then we'll select Sales. 

3. We have Sales representatives in several Locations all over the country, and we want to 
pinpoint which location reported telephone problems.  We'll do this by dragging the 
Locations field to the right of the Department field in the column area. 



BMC Track-It! 11 Web 

 © Copyright 1989 - 2012 Numara Software, Inc.  BMC Software, the BMC logos, and other BMC marks are trademarks or registered trademarks of BMC Software, Inc. in the 
U.S. and/or certain other countries. Track-It! is the property of Numara Software, Inc. and is registered with the U.S. Patent and Trademark Office, and may be registered or 

pending registration in other countries. Numara Software and BMC Software Confidential. 

136 

 
   

Drop Filter Fields Here 
  

  
 Type 
  

  

  
 New Work Order 
Count 
  
  

Drop Column Fields Here 
  

   Dept 
  

 Location 
  

  

Drop Row Fields 
Here 
  

Sales 

  Tampa New York Sales Total 

New Work Order 
Count 

2 55 57 

Customized Problem Analysis Pivot Grid 

   
Now the two Sales locations that reported telephone problems (Tampa and New York) are 
displayed in columns, and you can see that the New York Sales department had the most 
telephone issues. 
  
You can continue to create different views of the data by dragging the fields from the Field 
List dialog to the row or column areas of the pivot grid. 

Step 4:  Save the Pivot Grid. 

Now we'll save the customized pivot grid so that we can later select it from the pivot grid list, 
export it, and share it with other BMC Track-It! users.   
a. Select Save Current View As from Current View on the menu bar. 
b. On the Save Current View As dialog, we'll enter a name for the pivot grid (we'll call it 

"Telecom Sales Problem Analysis"), then click the Save button. 

Step 5:  Print and Export the Pivot Grid. 

Now you can report to your executive that the New York Sales department submitted 55 Work 
Orders in the past month due to telephone problems which probably affected their sales 
performance.  We'll print the pivot grid and also export it to Excel.  You can also copy and 
paste an image of the grid into a document.  See Printing and Exporting Graphs and Pivot Grids from the 
Dashboard. 

a.  Print the Pivot Grid. 

1. Click Print KPI on the Tasks pane. 
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2. The Preview window displays.  Click the Print button. 
The Windows Print dialog displays.  Select options and click the Print button. 
An image of the pivot grid is sent to your printer. 

b.  Export the Pivot Grid to Excel. 

  
1. Click Print KPI on the Tasks pane. 
2. From the Preview dialog, select Export from the File menu or the Export Document 

drop-down on the toolbar. 
3. Select Excel. 
4. The Windows Save As dialog displays.  Enter a name for the file and save it to your 

desired location, then click the Save button. 
You can now open the pivot grid in Excel. 

  
Next Topic:  Customizing Pivot Grids (Dashboard) 
Customizing Pivot Grids (Dashboard) 
  
You can customize the Pivot Grids by selecting the measure, arranging the fields, and applying filters. 
 For an example of customizing a pivot grid, see the Pivot Grid Tutorial: Customizing Problem Analysis 
Pivot Grid 
  
There are a few basic steps to customize a pivot grid, as explained in the Pivot Grid Tutorial in the 
previous topic. 
  

1. Determine What Questions You Need to Answer about your Help Desk 
2. Select a System Pivot Grid as a Starting Point 
3. Customize the Relevant Pivot Grid to Display the Actual Numbers You Need 

 Select a Time Interval and Measure 
 Select Fields for the Row, Column, Filter, and Data Areas of the Grid 
 Filter the Pivot Grid 

4. Save the Pivot Grid. 
   
Determining What Questions You Need to Answer about your Help Desk 

Depending on the pivot grid, you can answer questions based on measures (counts) and 
fields related to the Help Desk.   (See Viewing Help Desk Metrics with the Dashboard 
(Overview) for detailed information which measures, fields, and other information is available 
for each chart and grid).  See an example in Pivot Grid Tutorial: Customizing Problem Analysis 
Pivot Grid. 
  

Selecting a System Pivot Grid as a Starting Point 
1. Select the Dashboard module from the Navigation Pane. 
2. Select the pivot grid from the View menu (e.g., Current View/Help Desk/System 

Views/Problem Analysis Pivot). 
  
Customizing the Pivot Grid 
To Select a Time Interval and Measure: 
Note:  Pivot grids can display trends (Time Interval) or a specific point in time. 
  

1. If you want the pivot grid to display a count (or average, depending on the pivot grid) in each cell of the pivot grid data 
area, select an option from the Time Period drop-down list. 
The pivot grid displays a summarized sub-total in each data cell. 

2. If you want the pivot grid to display specific dates, months, years, etc., as columns: Select an option from the Time 
Display Interval drop-down list, then 

3. Drag the Activity Date field from the Pivot Grid Field List dialog to the Column area of the pivot grid. 
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The pivot grid displays a column for each Time Display Interval (such as each month or year). 
 
(See Select Fields for the Row, Column, Filter, and Data Areas of the Grid, below, for details on using the Pivot Grid 
Field List dialog). 
  

Selecting Fields for the Row, Column, Filter, and Data Areas of the Pivot Grid 
The Pivot Grid Field List dialog displays a list of Measures and Fields available for each pivot grid. 
To Select Fields with the Pivot Grid Field List dialog: 

1. Right click in the pivot grid header area, then select Show Field List. 
Click and drag the borders of the Pivot Grid Field List dialog to view all of the available fields. 

2. To select the fields, either: 
a. Drag the field to the row, column, or data item areas on the pivot grid, or 
b. Select the field, then select an option (such as Row Area or Column 
Area) on the drop-down next to the Add to button at the bottom of the Pivot 
Grid Field List dialog, then click the Add to button. 
 
Note:  An "X" will display on the Field  if you try to place it in an invalid area. 

3. To hide a field from the pivot grid, right click the field and select Hide, or drag the field back to the 
Pivot Grid Field List dialog. 

4. To move a field, right click the field and select an option from the Order list (such as Move to 
Right). 

5. To hide the field list, click the close button on the Pivot Grid Field List dialog, or right click the 
grid header and select Hide Field List. 
  

Filtering the Pivot Grid Fields 
There are two ways to filter data in a pivot grid:   

1) By placing a Field in the Filter Area of the pivot grid, then selecting items from its Filter 
list, and/or by 
2) Selecting items from a Row or Column Field's Filter list. 

To Filter Fields Using the Filter Area of the Pivot Grid: 
1. Drag a Field from the  Pivot Grid Field List dialog (such as Priority) to the Filter Area of the 

pivot grid. 
2. Click the Filter drop-down on the Field button. 
3. Check the items you want to display from the Filter list (such as Critical or Urgent from the 

Priority field), then click the OK button. 
The summarized count is displayed in the data cell based on the selected filter. 

  
To Filter Row and Column Fields: 

Repeat Steps 2-3 above. 
  

Refreshing the Pivot Grid Data 
Typically, the database automatically updates the data that displays in the pivot grids every 15 minutes.  If 
you have been working with a grid for a longer amount of time, you can refresh the data. 
  
To Refresh the Pivot Grid Data: 

1. Right click the grid header and select Refresh Data. 
If the data in the database has changed, it will be reflected in the data cells. 
  

Clearing Filters 
To Clear Filters and View the Default Grids: 

1. Select Abandon Changes to Current View from the View drop-down list at the top of the graph. 
This returns the a system pivot to the default system view, and a customized pivot grid to its last 
saved state.  A customized (or filtered) graph or pivot grid that has been initially saved, then 
modified, will display an asterisk (*) after the name, such as Overdue Work Orders*.  (System 
graphs and pivot grids that have been modified will also display the asterisk). 
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To Save Your Customized Pivot Grid: 
1. Once you have customized your Pivot Grid, select Save Current View As from Current View on 

the menu bar. 
2. On the Save Current View As dialog, enter a name for your Pivot Grid, then click the Save 

button. 
3. To access your customized Pivot Grid at a later time, select it from the Help Desk option from the 

Current View on the menu bar. 
  

To Share Your Customized Pivot Grid: 
See Exporting and Importing Views. 
  
Next Topic:   Printing and Exporting Graphs and Pivot Grids from the Dashboard 
  

Printing and Exporting Graphs and Pivot Grids from the Dashboard 
  
You can copy print, customize, export, and e-mail graphs and pivot grids with the Dashboard Preview 
dialog. 
  
To Copy a Graph to the Clipboard: 

1. Select the graph you want to print from View menu (e.g., Current View/Help Desk/System 
Views/Overdue Work Orders). 

2. Right click anywhere on the graph and select Copy to Clipboard. 
3. Open the desired application (such as a word processing program) and paste it into the 

document. 
An image of the graph displays. 

  
To Print a Graph or Pivot Grid: 

1. Select the graph or Pivot Grid you want to print from View menu (e.g., Current View/Help 
Desk/System Views/Overdue Work Orders). 

2. Click Print Current View on the Tasks pane, or click the Print icon on the toolbar. 
3. The Preview window displays.  Click the Print button. 

The Windows Print dialog displays.  Select options and click the Print button. 
  
To Show or Hide Titles, Labels and Legends, and Rotate the Graph: 

1. Right click anywhere on the graph and select Copy to Clipboard. 
2. The Preview displays the graph with your selected options. 

  
To Export a Graph or Pivot Grid: 

1. Select the Graph or Pivot Grid, then click Print Current View on the Tasks pane, or click the 
Print icon on the toolbar. 

2. From the Preview dialog, select Export from the File menu or the Export Document drop-down 
on the toolbar. 

3. Select the type of file you want to export:  PDF, HTML, Excel, Rich Text, or Graphic. 
4. The Windows Save As dialog displays.  Enter a name for the file and save it to your desired 

location, then click the Save button. 
  
To E-mail a Graph or Pivot Grid (Image): 
You can e-mail a graph or pivot grid image (PDF or bitmap) from the e-mail icon.  If you want to e-mail a 
file, see To Export a Graph or Pivot Grid above. 
  

1. Select the Graph or Pivot Grid, then click Print Current View on the Tasks pane, or click the 
Print icon on the toolbar. 

2. From the Preview dialog, click the E-mail icon on the toolbar. 
3. Select the type of file you want to e-mail.  You can e-mail PDF or Graphic (bitmap). 
4. The Windows Save As dialog displays.  Enter a name for the file, then click the Save button. 
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Your e-mail editor opens (such as Microsoft Outlook) with the file attached. 

Change Management: Managing Requests for Change 

Change Management Overview 
  
Track-It!'s Change Management module provides an automated process to track and manage Requests 
for Change in your organization.  When a Work Order is created that matches the criteria defined in a 
Change Management Policy it creates an associated Request for Change that is automatically placed into 
the approval process.  Requests for Change are managed by the Work Order's Assigned Technician in 
the BMC Track-It! Technician Client.  Approvers who have been assigned to the Request for Change 
communicate and vote through BMC Track-It! Web.  Automatic notifications can be set up so that 
Approvers and Technicians are notified about specific events in the Request for Change's lifecycle.     
  
Change Management Roles 
The individuals involved in the Change Management process are: 
  
BMC Track-It! Administrator 
The BMC Track-It! Administrator sets up Change Management Policies, automatic e-mail notifications, 
and permissions for Technicians and Approvers. 
  
Track-It! Technicians 
The Technician can manage the Request for Change from either the Change Management module or 
from the Change Management tab on the Work Order. 
  
Approvers 
Approvers are the change management team members who vote to accept or reject Requests for 
Change.  They can view information and comments, communicate, and vote on a Request for Change 
using BMC Track-It! Web.   (A Request for Change is considered approved when all Approvers have 
approved, based on the number of approvals required.) 
  
Note:  It is not necessary for Approvers to have a license to use BMC Track-It! Self Service; their BMC 
Track-It! Administrator only needs to provide them with a login user name. 
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Change Management Workflow 
  
The flowchart below represents the Track-It! Technicians and Approvers' workflow for Change 
Management. 
  
  
  
  
  

 

Managing Requests for Change (Technicians) 
  
You can manage Requests for Change from the Change Management module or from the Help Desk 
module.  In the Help Desk grid, Work Orders that are associated with a Request for Change in the 
Change Management module can be identified by enabling the RFC Status column.  These Work Orders 
will display with an RFC Status such as Approved, Rejected, or Pending Approval.  You can manage the 
Request for Change by opening the Work Order and selecting the Change Management tab. 
  
To enable the RFC Status column, right click anywhere on the grid, then select Customize.  In the 
Customize Grid dialog (Columns tab), select RFC Status from the list, then click the Add button.  For 
more information, see Showing and Hiding_Columns. 
  
See also:  Change Management Overview 
To View Requests for Change from the Change Management Module: 

1. Select the Change Management module from the Navigation Pane of the BMC Track-It! 
Technician Client.  
Note:  Overdue Requests for Change are highlighted. 

2. Double click to open a Request for Change in the grid. 
To View Requests for Change from the Help Desk Module (Work Order): 

1. Open the Help Desk module.  Work Orders associated with a Request for Change are those 
displaying a status in the RFC Status column. 

2. To view details, open the Work Order, then select the Change Management tab. 
 
The following information is displayed: 
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• Policy Name (e.g., Training Requests) 
• Decision Due Date 
• Status (e.g., Pending Approval, Pending Technician Response, Approved, Rejected, or 

Canceled) 
• Approvals Required 
• Decision Completed (date) 
• Policy Type (Simultaneous or Sequential) 
• Approvers 

• Approver (name) 
• Comments - Expand (+) button 

• Status (Evaluating, Pending Technician Response, Pending Prior Approval, 
Approved, or Rejected) 

• Actions 
• Open Review History 
• Respond to Reviewer 
• E-mail Approver 
• Change Approver 

   
To View an Approver's Comments: 

1. To view the Approver’s comments, click the Expand (+) button next to the Approver's name, OR 
2. Click the Open Review History button next to the Approver's name. 
3. You can also select the Approver's name, then double click it or press the Enter key. 

  
To Respond to an Approver's Request for Information: 
You can respond to an Approver's request for information via the Change Management module or the 
Work Order in BMC Track-It! Technician Client. 
  

1. On the Request for Change dialog (or the Change Management tab of the Work Order), click 
the Respond icon in the Actions column in the Approvers section (the icon is enabled if an 
Approver has requested information). 

2. On the Response Details dialog, enter your response in the text box, then click the Send button. 
The response and request display on the Change Management tab in the Work Order as well as 
the Request for Change dialog in the Change Management module. 
  

To E-mail Approvers: 
1. To e-mail an individual Approver (who has not yet voted), click the E-mail Approver icon next to 

the Approver's name in the Actions column. 
2. To e-mail all Approvers at once (who have not yet voted), click the E-mail Approvers button at 

the bottom of the Change Management tab. 
To Change Approvers: 
Note:  You can only change Approvers if they have not yet voted on the RFC (approved or rejected). 
  

1. Click the Change Approver icon next to the Approver's name in the Actions column of the 
Approvers section. 

2. On the Find Approver dialog, enter the name of the new Approver, then click the Search 
button.        

Note:  You can also press the Search button without entering a name, and all Users except 
those already selected as Approvers for the Request for Change will display. 

3.  Select the User's name, then click the Select button. 
4. The Search Requestor dialog closes, and a Change Approver confirmation message displays. 
5. If you're sure you want to change the Approver, click the Yes button. 

 
If configured, a notification will be sent to the new Approver (see Configuring Notifications for 
Change Management Events in the Administrator's guide). 

To View the Request for Change's Review History: 
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1. The Review History dialog contains the Approver’s and the Assigned Technician's comments, 
including rejection reasons.  The report also displays details when a Technician changes an 
Approver. 

2. Click the Open Review History button next to the Approver's name. 
 
You can also view this information on the printed Request for Change. 

Manually Creating a Request for Change 
  
When Work Orders are created that match Change Management policies, they are automatically entered 
into the Change Management process.  However, BMC Track-It! Technicians can manually create a 
Request for Change, which also creates the associated Work Order.   You may want to manually create a 
Request for Change so that you can quickly enter it into the change management process without waiting 
for a Work Order to match the criteria from the Change Management Policy. 
  
Note:  In order for BMC Track-It! Technicians to manually create a Request for Change, the BMC Track-
It! Administrator must grant permission to the Help Desk module on the Technician's security policy, and 
permission to “View Requests for Change” under “Change Management” on the Technician’s security 
policy.  See Allowing Technicians Access to the Change Management Module in the Administrator’s 
Guide. 
  
See also:  Change Management Overview 
To Manually Create a Request for Change: 

1. Select the Change Management module from the Navigation pane. 
2. Select New Request for Change from the Tasks pane in the Change Management module. 
3. In the Summary field, enter a brief description of the Request for Change. 
4. Select a Change Management Policy from the Policy Name drop-down list. 

Note:  Once a Change Management Policy has been selected, it cannot be changed for the 
associated Work Order. 

5. Click the OK button. 
6. The new Work Order will only be populated with the Summary field.  Enter any other necessary 

information (Work Order Type, for example), then click the Save button. 
 
The Change Management tab displays details for the associated Request for Change. 

  

Viewing an Approver's Request for Change History 
   
The Review History dialog displays the Approver's voting history (approval or rejection), requests for 
information, and the Technician's response in descending chronological order.  The date and time for 
each item is also displayed.  You can respond to an Approver's request for information from this dialog. 
  
The Review History dialog can be accessed from the Request for Change dialog in the Change 
Management module, or from the Change Management tab on the Work Order. 
  
The Review History for all Approvers and the Technician is displayed on the printed version of the 
Request for Change (see Printing Requests for Change). 
  
See also:  Change Management Overview 
To Respond to an Approver's Request for Information: 

1. On the Review History dialog, click the Respond button, enter your comments in the Response 
text box, then click the Save button. 
 
Your response displays on the following: 

 The Review History dialog (under Technician's Response) along with your user name 
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 The Comments section on the RFC in BMC Track-It!  Web 
 The printed version of the RFC. 

  
2. Click the Close button to return to the Request for Change dialog or the Change Management 

tab. 

Viewing and Printing Change Management Reports 
  
You can view and print the following Change Management Reports: 
  

 All Open Requests for Change 
 Approved, Cancelled, and Rejected Requests for Change (RFCs are canceled if the associated 

Work Order is closed or canceled) 
 Request for Change Activity History 
 Request for Change by Week 
 Request for Change by Month 

  
To View Change Management Reports: 

1. Select the Reports module from the Navigation pane. 
2. Select Change Management from the Reports by Module drop-down list above the Reports 

grid. 
3. Double click the report you want to view. 

  
See Also:   Reports Overview 
  

Printing Requests for Change 
  
You can print a Request for Change, which displays as a detailed report, including the following 
information: 
  

 Current Date and Time 
 Summary 
 Policy Name 
 Policy Type 
 Created Date 
 Decision Due Date 
 Decision Completed Date 
 Change Request Status 
 Work Order Number 
 Requestor 
 Assigned Technician 
 Priority 
 Work Order Status 
 Approvers 
 Review History (All Approvers' and Technician's comments, including rejection reasons.  The 

report also displays details when a Technician changes an Approver). 
  
BMC Track-It! Administrators can customize the Change Request report.  See Customizing Reports in the 
Administrator's guide. 
To Print Change Requests: 

1. From the Change Request module, select the Change Request, then select Print Request for 
Change from the Tasks pane, OR 
Right click and select Print, OR 
Click the Print icon on the toolbar. 
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BMC Track-It! 11 Web 

BMC Track-It! Web Overview 
Administrators 
BMC Track-It! Web enables Technicians to access BMC Track-It! via the Web so that you can 
troubleshoot and solve IT issues while not at your desk.  When you're back at your desk, you can manage 
any of the Work Orders, Inventory, and Solutions you created or edited in BMC Track-It! Web from the 
BMC Track-It! Technician Client. 
  
The following modules are available in BMC Track-It! Web: 
  

• Help Desk 
• Solutions 
• Inventory 
• Purchasing 
• Library 
• Change Management 

  
Note:  Online help is available once you log in to BMC Track-It! Web (and is separate from the BMC 
Track-It! Technician Client online help).  The topics in the online help are also available in the BMC Track-
It! Web Technician's Guide (PDF) on the Product Documentation section of our Support Web page  
  
To Access BMC Track-It! Web: 

1. Go to the URL provided by your BMC Track-It! Administrator (typically 
http://servername/TrackItWeb/ where "servername" is the name of the server). 

2. Enter your user name and password and click the Login button. 
 
The BMC Track-It! Web home page displays. 

  

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=105&Offering=2&lang=EN
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BMC Track-It! 11 Mobile Web 

BMC Track-It! Mobile Web Overview 
  
BMC Track-It! Mobile Web enables you to access BMC Track-It! via mobile devices such as Android and 
iPhone smartphones. You can troubleshoot and solve IT issues while not at your desk. When you're back, 
you can manage any of the Work Orders you created or edited in BMC Track-It! Mobile Web from the 
BMC Track-It! Technician Client or BMC Track-It! Web.  
  
Technicians can perform the following tasks in the Help Desk and Solutions modules from their mobile 
devices: 

Home Screen 
View Announcements 

Help Desk 
• View work orders 
• Search for work orders by keyword and work order number 
• Create work orders 
• Edit work orders (including quick edits using preset fields 
• Copy work orders 
• Delete work orders 
• Manage work order assignments 
• View work order attachments 
• View change management information 
• Email conversation management (messages and responses are captured  in the Work Order)  

Solutions 
• View Solutions 

Inventory 
• Create, modify, copy, and delete assets 
• Audit assets 
• Retire assets 
• Email the requestor associated with an asset 

  
Online help is available once you log in to BMC Track-It! Mobile Web on your mobile device.  The topics 
in the mobile WebHelp are also available in the BMC Track-It! Mobile Web Technician's Guide (PDF) on 
the Product Documentation section of our Support Web page  
A video tutorial of BMC Track-It! Mobile Web is available from the mobile Webhelp, and on our Web site. 
  
To Access BMC Track-It! Mobile Web: 

1. On your mobile device, go to the URL provided by your BMC Track-It! Administrator (typically 
http://servername/TrackItWeb/ where "servername" is the name of the server). 

2. Enter your user name and password, then tap the Login button. 
 
The Work Order lists display.   

  
Note:  If you would prefer to use the BMC Track-It! Web application from your mobile device, click the 
View Full Site link on the BMC Track-It! Mobile Web login screen. 
  
See Also: Video Tutorial 

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=11&Offering=2&lang=EN
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Using BMC Track-It! Mobile Web (Video Tutorial) 
This video tutorial will show you how to use BMC Track-It! Mobile Web.   
  
iPhone/iPad (Quicktime .mov)  
  
Android (.swf) 
  

http://downloads.numarasoftware.com/Updates/174/HELP/EN/Technician/Mobile/Track-It!_Mobile_Video_(iPhone).mov
http://downloads.numarasoftware.com/Updates/174/HELP/EN/Technician/Mobile/Android_(.swf).htm
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BMC Track-It! 11 Self Service 

BMC Track-It Self Service Overview 
BMC Track-It! Self Service is a Web-based application that enables your end users to submit their own 
Work Orders and check the status of their requests. Users can attach files, such as screenshots, to Work 
Orders. 
  
Users can also search for internal BMC Track-It! Solutions.   
  
Users can audit their computers and change their passwords.   
  
Change Management approvers can also approve Requests for Change with Self Service. 
  
Note:  Online help is available once users log in to Self Service.  The topics in the online help are also 
available in the BMC Track-It! Self Service Guide (PDF) on the Product Documentation section of our 
Support Web page  
  
See Also:  BMC Track-It! Installation Guides, Configuring Self Service, and Change Management 
Overview 

http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=105&Offering=2&lang=EN
http://support.numarasoftware.com/support/updates.asp?product=2&content=Documentation&version=105&Offering=2&lang=EN
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